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Saia-Burgess Controls AG About this Manual

1 About this Manual

Saia PCD® Supervisor is a supervisor tool for Saia PCD devices. It is based on the
powerful Niagara V4.9 software framework and uses the Saia PCD® S-Bus over Ether-
net.

This manual describes how to install Saia PCD® Supervisor and configure the SaialP-
Network to allow Saia PCD devices data to be made accessible to the Niagara frame-
work.

It consists of the following main sections:

2 About Saia PCD® Supervisor
This section gives an introduction to basic system principles and the
Saia PCD® Supervisor user interface.

3 Securing Saia PCD® Supervisor
This section provides guidance on security issues to be considered when in-
stalling and using Saia PCD Supervisor.

4 Installing Saia PCD® Supervisor
This section describes how to install Saia PCD® Supervisor

5 Licensing Saia PCD® Supervisor
This section describes how to obtain and install Saia PCD® Supervisor license
files.

6 Creating/Enginering a project

This section describes the process of engineering Saia PCD® Supervisor.

6.1 Initial Setup
This section covers the procedures that must be followed to get Saia PCD®
Supervisor ready for use.

6.2 Manual creation of data points
This section covers the process to create communicated datapoints manually.

6.3 Using the “Saia PG5 Data Import Wizard”
This section covers the process to import the datapoints from the PG5 project
using the Saia PCD Data Import Wizard.

6.4 General functions
This section describes general function can be used inside of the Saia PCD
Supervisor. For example how to configure Saia PCD® Supervisor to control
schedules times in the Saia Burgess Controls system.

6.5 Connect to 3rd Party Systems
This section covers the process to import the datpoints and communicate with
third party Devices. For example BACnet devices.

6.6 Creating Schematics (Operator Views)
This section gives basic guidance on creating dynamic operator views that en-
able end users to navigate and access the system.

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22
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1-2

This section describes how to backup/restore the Saia PCD® Supervisor con-

6.7 Set Up for Saia PCD® Supervisor Users
This section describes how to configure users in Saia PCD® Supervisor to
ensure each user only has access to the appropriate information.

6.8 Backup & Restore
figuration.

7 Using Saia PCD® Supervisor

This section covers general day-to-day operating procedures aimed at end
users.

It is assumed that you understand how to use Niagara V4.9. For further
information you should refer to the Niagara documentation which is installed
during the Saia PCD® Supervisor installation. It can be accessed from the
Saia PCD® Supervisor Help menu.
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Saia-Burgess Controls AG About this Manual

1.1

Conventions Used in this Manual

Conventions Used in this Manual

There are numerous items and instructions in this manual, the conventions below are
designed to make it quick and easy to find and understand the information. n

- Menu commands are in bold type.
- Buttons, and options in dialogue box that you need to select are in bold type.
- The names of text boxes and dialogue boxes are in bold type.

- Key combinations that you should press appear in normal type. If joined with a plus
sign (+), press and hold the first key while you press the remaining one(s). For ex-
ample CTRL+S indicates holding down the control key while pressing S.
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2 About Saia PCD® Supervisor

Saia PCD® Supervisor is a supervisor tool for Saia PCD Control Systems. It is based

on the powerful Niagara V4.9 software framework. This section describes the key

features of Saia PCD® Supervisor and its user interface, and introduces some of the
terminology used. n

Using the supplied SaialPNetwork (SBC Communication Driver), Saia PCD® Supervi-
sor can connect to multiple Saia PCD devices and access device data in order to moni-
tor or adjust the operation. System data is held within a database and is accessible in
raw format or presented in specially-designed graphical pages known as schematics or
Operator Views (PX view).

Saia PCD® Supervisor connects to the Saia PCD devices network over Ethernet. This
gives access to the Saia PCD devices on the associated LAN (Local Area Network)
and through S-Bus Gateway functionality serial networked devices.

Ethernet

PCD1.M2220-C15 PCD7.D410DT5F

as Gateway PG5 programmable
MB Web-Panel

PCD1 E-Line programmable I/O modules PCD1.M2110R1 as Sub-Station

Ethernet communication to PCD’s and on PCD’s over RS-485
which are connected behind a gateway.
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21.1

21.2

Saia PCDe® Supervisor Architecture

Platform

In computing, a platform describes some sort of hardware architecture or software
framework (including application frameworks), that allows software to run. Typical
platforms include a computer’s architecture, operating system, programming languages
and related runtime libraries or graphical user interface

The Platform is the topmost level of configuration and may be compared to the control
panel on a PC. In this area of Saia PCD® Supervisor where you can set up:

- Communications

- Install Licenses

- Find fault issues

- Start / Stop stations

- Copy stations

- Backup stations

- Handling certificates

- Handling Lexicons for multilingual projects

- Checking the TCP/IP configuration of the Host computer
- Accessing Remote File system

Access to the Platform requires the user to login, using the same credentials required
to login to the Windows PC. In case of some modification Passphrase is also needed.

Station

Software running on a Niagara platform that is the main unit of server processing in
the Niagara architecture. A station runs the components of the Niagara framework and
provides the access to view and control these components via the Workbench or web
browser. Think of the station as the application built by the engineer to integrate the
data and design a user interface.

The Station manages communications with the Saia Burgess Controls system(s) and
acts as a ‘container’ for all other configuration settings and functions. These include:

Services  such as alarm listening and monitoring and the Saia PG5 Data Import

Wizard

Drivers for managing access to data in the Saia Burgess Controls system(s)
and other systems.

Files schematic/Operator Views used to present system information on

remote client devices
many other services are possible
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2.1.5

Saia PCD® Supervisor Architecture

Access to the Station settings requires the user to login (different to platform login).
Initial system configuration is achieved using a default admin/engineering user account
which is set up when the Station is created. Once configuration is complete further
accounts can be added that grant different users specific access rights according their

role (see 6.7 Set Up Saia PCD Supervisor Users).

Platform Daemon
A program that is executed as service in the background.
In an other way it is compact executable program that enables a user to access plat-

form tools through the Workbench. The Platform Daemon enables to run the stations
on the local PC.

SBCIpNetwork driver

The SBClpNetwork driver defines the communication settings to a Saia Burgess Con-
trols system and provides access to data held in its controllers and devices, including:

Points Input, Output, Register, Flag, Timer, Counter, DataBlock and text Block.
Histories  values logged in HD log modules.
Alarms for monitoring alarm messages generated within the

Saia Burgess Controls system.

Other Drivers (open points)

The Saia PCD® Supervisor is based on the Tridium Niagara V4.9 framework. Therefore
it supports a wide range of additional drivers, suitable for interfacing with other manu-
facturer’s building automation systems and products. This enables the monitoring and
control of these systems to be fully integrated with the management of a Saia Burgess
Controls system within a common supervisor.

Support for other drivers requires one or more additional open driver packs. For de-
tails of order codes and point counts refer to the Saia PCD® Supervisor Data Sheet
(34-001_DS_Saia-PCD-Supervisor).

e such an open driver can be: BACnet, Modbus etc.
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2.2

2.2.1

2.2.2

User Interface Application (Host PC)

This section introduces the main features of the Saia PCD® Supervisor user interface.

Menu Bar
Tool Bar ——e

View Changer

—g Oy . an .
Locator Bar = sbch
Nav Tree ——
L ()4
supervisor View Pane
Saia PCD®
Palette @ricce
=X 2@
e
Host ID: Win-74CD-99B2-D132-2255
Version: 3.0
'magara4
Version: 49.0.198
Copyright Tridium, Inc 1996-2020

Nav Tree (navigation panel)

The Nav tree (or navigation panel) provides navigation around the elements, folders
and files in Saia PCD® Supervisor. It is configurable under “user” by “user”. Once con-
figured, you can view devices and points in a Saia Burgess Controls system.

For help on using the Nav tree, refer to chapter 7.2.2.2 Nav Tree.

Palettes
It is a collection (or library) of components in a hierarchical view that can be copied
and pasted where needed — Wire Sheet, Property Sheet, Px View or Palette side bar.

Palettes are useful when configuring certain elements in the system. There are many
Palettes available, but the most commonly used in Saia PCD® Supervisor are:

o Alarm for configuring Alarm handling

* Schedule .......cccccceiiinniis for configuring Time Schedules

e History ....coooiiiie for configuring Histories (Plots)

* kitControl .........ccccoeeeel for creating control logic in Saia PCD® Supervisor

* bajaui.....ccccveiiiiiii for configuring Graphics and accessing default images
o KitPXeoioiiiiiiieee for configuring Graphics and accessing default images
o KitHVAC ..o for configuring Graphics and accessing default images
*  kitPxN4Svg......ccceeevineen. for configuring Graphics and accessing default images
* WebChart.........c.oooeeee. for configuring Graphics and accessing default images

+ SBCOfflineEngineering .... service to import easily resources of a Saia PCD device
from PG5 project

o SbCa for devices and points
+ sbclconGallery.................. for images to build user screens
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* honBACnetUtilities ........... for getting detailed information of BACnet points.

For help on opening and closing Palettes, refer to chapter 7.2.2.3 Palettes

Locator Bar

There is a fundamental navigation model in the Workbench which is similar to the URL
navigation used in the Web browsers.

When the URL is changed the URL referenced content is shown in the browser. A re-
membered history of the URLs is allowing back & forward navigation.

The ORD (Object Resolution Descriptor) is the universal identification system of Niaga-
ra and it is used throughout the Niagara framework. It unifies and standardizes access
to all information. And it is designed to combine different naming systems into a single

string.

The ORD can be:

absolute station:|slot:/Drivers/SBC$20Systems/SBClpNetwork_Demo/Device1/
points/Heating1/Outside/Temperature/PhysVal”

relative slot:Outside/Temperature/PhysVal”

The locator bar provides similar functionality to the Nav tree. As you navigate around
the file system the locator bar will update to show the current location and view. It
shows the ORD (Object Resolution Descriptor)

For help on using the locator bar, refer to chapter 7.2.2.4 Locator Bar

View Pane & View Changer

The view pane is the principle work space for Saia PCD® Supervisor. When you first
run Saia PCD® Supervisor it will display the home page (shown above). As you navi-
gate through the system and select different items in the Nav tree, the view pane will
change to show different information or configuration pages.

Some elements may provide more than one type of view. For help on selecting the
required view, refer to chapter 7.2.2.5 View Pane & View Changer
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2.2.5 Client Devices

Saia PCD® Supervisor can be accessed via web clients while an IP connection is pos-
sible between the client device and the PC running Saia PCD® Supervisor.

ence to the user as when it is accessed on the main PC depending on the device being

n Once accessed Saia PCD® Supervisor via Web client, it provides a similar user experi-
used to access. The Web Server - Client connection can use JAVA or HTML5.

= x
e QSearch wBe & A9Q e =
Config o ® 1} PropertySheet  [v] [X]
Ondtions topics B stot vetails
Display Name Value Commands
@ Station Name
@ Sysinfo s
@ Services Service Container
O Drivers Driver Container

@ Apps App Container
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3 Securing Saia PCD® Supervisor

3.1 Introduction
The purpose of this section is to provide the information necessary for those involved
in the installation and maintenance of a product or system to understand the require-
ments for configuring and managing the security of the product or system. n

General Security Best Practice for Saia Burgess Controls IP Based Product manuals
,26-776_Manual_TCP-IP-Ethernet* and ,26-867_ Manual_TCP-IP-Enhancements®.

Both documents are available from the Saia Burgess Controls support web site
www.sbc-support.com.

3.2 Disaster Recovery Planning

It is a documented process or set of procedures to recover and protect a business IT
infrastructure in the event of a disaster. Such a plan, specifies procedures an organiza-
tion is to follow in the event of a disaster.

When developing the disaster recovery plan ensure that it includes ALL data required
to restore system operation, including:

- Configuration files for platform(s) and station(s)
- Database objects

- License and certificate files

- Station Backup

- Station Copies

See book 27-651 chapter 6.8 Backup & Restore for details.

3.3 Physical and Environmental Considerations

The PC running Saia PCD® Supervisor should, where possible, be secured against
unauthorised physical access.

34 Security Updates and Service Packs

Ensure the PC running Saia PCD® Supervisor and any client devices have the latest
operating system updates installed, and the latest version of Saia PCD® Supervisor is
being used.

Saia Burgess Controls software is tested against the latest service packs and up-
dates applicable at the time of release. For significant operating system and Java
updates / service packs, please check the Saia Burgess Controls support web site
www.sbc-support.com for any compatibility issues.

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22 3-1


http://www.sbc-support.com
http://www.sbc-support.com

Securing Saia PCD® Supervisor Saia-Burgess Controls AG

3-2

3.5

3.6

3.7

Virus Protection

Ensure the PC running Saia PCD® Supervisor and any client devices are running virus
protection software, and the virus definitions are kept up-to-date.

Some virus protection software may have an adverse impact on the performance of
Saia PCD® Supervisor. In such cases request that the Saia PCD® Supervisor directory
be excluded from on-access scan.

Further details can be found on the Saia Burgess Controls support web site
Www.sbc-support.com.

Network Planning and Security

It is recommended that the Ethernet network used by the Building Management Sys-
tem (BMS) is separated from the normal office network using an air gap (separated wir-
ing and devices or layer 3 switches or virtual private network (VPN)). Physical access
to the Ethernet network infrastructure must be restricted. You must also ensure that the
installation complies with your company’s IT policy.

The use of a firewall and Intrusion Detection System (IDS) from a reputable provider
of security products is recommended for any Saia PCD® Supervisor installation. Fol-
low best practice for the products chosen as well as any corporate IT policy where the
installation is made. Lock down the products to the particular port you've configured for
Saia PCD® Supervisor HTTPS and HTTP.

Always follow the guidelines PDF-Documents:

Manual..........ccceeieeeeeiieeen 26-776_Manual_TCP-IP-Ethernet
manual...........ccccoeeeeiii 26-867_Manual_TCP-IP-Enhancements.
manual...........cccooeeii 26-620_Manual_Security-Rules
ManUal........ccooveeviiiieeeeiieee e Niagara®* Hardening Guide
instruction................................ 30-002_Internet-Security-Instructions_SBC

instruction for using VPN router .. 30-004_VPN-Router

You must also take steps to ensure the security of any other networks connected to
Saia PCD® Supervisor (e.g. BACnet).

Virtual Environments

Follow best practice for the products chosen as well as any corporate IT policy where
the installation is made.
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3.8

3.9

3.10

3.1

Securing Wireless Devices

If a wireless network is being used it must be secured according to your company’s IT
policy.

System Monitoring

For any Saia PCD® Supervisor installation, especially when connected to the internet,
Saia Burgess Controls recommends the use of an Intrusion Detection System (IDS)
from a reputable provider of security products. Follow best practice for the products
chosen as well as any corporate IT policy where the installation is made.

Saia PCD® Supervisor logs (Audit History) changes made to its own configuration
and adjustments to the Saia Burgess Controls control system. Many IDS and firewall
products offer a complete solution for recording all the traffic coming in and out of the
Saia PCD® Supervisor PC, providing users with the ability to record all activity at the
lowest level.

Securing Access to the Operating System

Ensure the PC running the Saia PCD® Supervisor and any PCs used for Saia PCD®
Supervisor clients are secured according to your company’s IT policy.

Access Control

All Saia PCD® Supervisor files should be protected from read and write access by
people and software not authorized. Saia Burgess Controls recommends following best
practice for securing system objects, such as files, and using access control appropri-
ately.

If Windows users are granted access to the filing system location of the Saia PCD® Su-
pervisor project then it is possible for them to inadvertently (or deliberately) open, de-
lete or edit any of the configuration and data files of independently of their Saia PCD®
Supervisor workgroup settings.
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3.12

3.12.1

3.12.2

3.12.3

Securing Saia PCD® Supervisor

The Saia PCD® Supervisor software should be configured during installation and
operation following best practice. Follow the installation procedure as described in this
manual. In addition, refer to the Niagara 4 help system and Niagara 4 security guide-
lines.

Default Admin User of a Station

Initial system configuration is achieved using a default admin/engineering user account
which is set up with a strong password when a Station is created.

Passphrase

The passphrase, specified during the Saia PCD® Supervisor installation process, pro-
tects sensitive data on any station that you create and will be required if the Saia PCD®
Supervisor station is to be moved to another PC e.g. moved to the site PC, or restored
after a PC failure.

Set up Other Users for the Station

Once configuration is complete (using the default admin user) further user accounts
must be added that grant different users specific access rights according their role.
Saia PCD® Supervisor enforces the use of strong passwords.

For further details, see book 27-651 chapter 7 Using Saia PCD® Supervisor
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3.13 Setting up Google 2 factor authentication

The Google Authentication Scheme is a two-factor authentication mechanism that re-
quires the user to enter their password as well as a single-use token when logging in to
a station. This protects a user’s account even if their password is compromised.

This authentication scheme relies on TOTP (Time-based One Time Password) and the
Google Authenticator app on the user’s mobile device to generate and verify single-use
authentication tokens. Google authentication is time based, so there is no dependency
on network communication between the user’s mobile device, the Station, or external
Servers. Since the authenticator is time based, the time in the station and time in the
phone must stay relatively in sync. The app provides a buffer of plus or minus 1.5 min-
utes to account for clock skew.

Prerequisites:

m The user’s mobile phone requires the Google Authentication app.
m  You are working in Workbench.
m The user exists in the station database.

Perform the following steps:

1. Open the GAuth palette and add the GoogleAuthenticationScheme to the Ser-
vices > Authenticationservice node in the Nav tree.

2. Right-click Userservice, and double-click the user in the table.
The Edit view for the user opens.

3. Configure the Authentication Scheme Name property to GoogleAuthenticationScheme and
click Save.

4. Click the button next to secret Key under the user’s authenticator and follow the
prompts.

5. To complete the configuration, click Save.
Depending upon the view you are using, you may have to open the user again or
refresh after saving.
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3.14 Saia PCD® Supervisor Security Check List

a
a

EI

(M

(W

Latest version of Saia PCD® Supervisor is being used.

Saia PCD® Supervisor installation files, configuration files (including station back-
up), certificates and licenses are included in disaster recovery plan.

The PC running Saia PCD® Supervisor should, where possible, be secured against
unauthorized physical access.

The Ethernet network (and any other networks) that the PC is connected to is se-
cured, e.g. by the use of firewalls and intrusion detection systems.

The PC is running the latest version of the Windows operating system, with all
updates and service packs.

The PC is running virus protection software.

Appropriate user accounts are set up on PC and access to files is restricted to only
those who are authorized.

Saia PCD® Supervisor is configured to use HTTPS using a certificate from a trust-
ed Certificate Authority.

Saia PCD® Supervisor users are configured as required.

Ensure Saia PCD® Supervisor is configured to backup data regularly to a secure
location as per your company’s backup policy.
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General Data Protection Regulation (GDPR)

General Data Protection Regulation (GDPR)

The General Data Protection Regulation (EU) 2016/679 (GDPR) is a regulation in EU
law on data protection and privacy for all individual citizens of the European Union (EU)
and the European Economic Area (EEA). It also addresses the transfer of personal
data outside the EU and EEA areas. The GDPR contains provisions and requirements
related to the processing of personal data of individuals (data subjects) inside the EEA,
and applies to any enterprise established in the EEA or (regardless of its location and
the data subjects’ citizenship) that is processing the personal information of data sub-
jects inside the EEA.

Under the terms of the GDPR personal data includes any information that may be used
to identify an individual. This includes (but is not limited to):

m user names,

passwords,

phone numbers,

email addresses,

work or residential addresses.

Any such information entered into Saia PCD® Supervisor is encrypted and stored

on the PC where the Saia PCD® Supervisor application is installed on a customer’s
premises. Neither Honeywell or Saia Burgess Controls have any involvement with the
storage and/or processing of personal data within Saia PCD® Supervisor.

Responsibility for compliance with the requirements of the GDPR lies fully with the sys-
tem integrator or system administrator and, as such, they must ensure that adequate
technical and organisational systems are in place to:

m obtain explicit consent from each data subject for personal data to be stored, used
and/or processed,

allow individuals to have access to their personal data in order to verify accuracy,

allow individuals to withdraw their consent at any time and to have their personal
data to be permanently erased,

maintain the security and integrity of data storage and access at all times,

report any breaches of data security (that may affect user privacy) to the relevant
authority within 72 hours of the breach occurring.
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Requirements, Optaining

4 Installing Saia PCD® Supervisor

This section describes how Saia PCD® Supervisor should be installed to ensure that it
operates correctly. The following steps are required to install Saia PCD® Supervisor:

4.1

Installation Requirements

4.2

4.3

Obtaining the Saia PCD® Supervisor Software n

Installing the Saia PCD® Supervisor Software

4.4

Installing the Platform Daemon

4.5

Configuring the Windows Firewall
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Installing the Software

4.1 Installation Requirements

Before installing, or upgrading, ensure that the PC meets the system requirements.
Refer to the Saia PCD® Supervisor Data Sheet (34-001_DS_Saia-PCD-Supervisor).

The PC on which Saia PCD® Supervisor is to be installed must have TCP/IP access to
the Saia Burgess Controls network.

4.2 Obtaining the Saia PCD® Supervisor Software

n Navigate to the Saia Burgess Controls Technical Support web site at
http://www.sbc-support.com --> Software / Saia PCD® Supervisor
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4.3 Installing the Saia PCD® Supervisor Software

1. Log in to the PC as someone with Administrator rights.
It is recommended that you close all other programs before installing
Saia PCD® Supervisor. However, do not close any virus protection soft-
ware.

2. Presently the installer works from the local hard drive only. Therefore the installer
must be copied to a local folder first (e.g. C:\Temp)

3. Run ‘Installer_x86.exe’ (for 32-bit operating systems) or n
‘Installer_x64.exe’ (for 64-bit operating systems), and
wait for the first installation screen to appear.

o . | .+ Computer » Local Disk (C) » SBCSupervisor » SBC Supervisor »

Organize » Open New folder
I Favorites MName ’ Date medified Type Size
B Desktop J dev 4/18/2017 4:20 PM File folder
& Downloads J dist 4/18/2017 4:20 PM File folder
2| Recent Places J docs 4/18/2017 4:20 PM File folder
J install-data 4/18/2017 4:20 PM File folder
7 Libraries J javadoc 4/18/2017 4:20 PM  File folder
3 Documents . modules 4/18/2017 4:20 PM File folder
;J‘r Music . overlay 4/18/2017 4:21 PM File folder
[E] Pictures |§_.!< Installer_x64 4/13/2017 11:15 AM  Application 518 KBl
#8 videos ?_s!' Installer_x86 4/13/2017 11:15 AM  Application 480 KB
%@ Uninstaller_x64 4/18/2017 2:17 PM Application 395 KB
18 Computer &f Uninstaller_x86 4/13/2017 11:15 AM  Application 366 KB
&, Local Disk (C3)

4. Follow the on-screen instructions

@ User Account Control @

Do you want to allow the following program to make

changes to this computer?

@ Program name:  Installer_x54.exe
= Verified publisher: Niagara (Tridium, Inc.)

File arigin: Hard drive on this computer

\:f Show details Yes ] [ Mo ]

Change when these notifications appear
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‘Saia PCD Supenvisor Installat on Program 8 } =)
®) an
supervisor socss
Saia PCD* SAIA BURGESS COMTROLS

Welcome to the Saia PCD Supervisor Installl

This program will install the Saia PCD Supervisor software
onto your computer.

n Build 4.9.0.198

niagaratt

framework

Read and accept the license agreement.

<" IS
supervisor soCc:

Saia PCD" S04 BURGESS CONTROLS

Flease read the following license agreement:

End User License Agreement July 28. 2015 =

TRIDIUM, INC. (" TRIDIUM") HAS DEVELOPED A STANDARDIZED
ARCHITECTURE AND RELATED SOFTWARE FOR INTERCONMECTING
DEVICES AND CONMTROLLERS THAT INCLUDES ELEMENTS SOLD
UMNDER THE MNAME "MIAGARA FRAMEWORK(R)" THESE ELEMENTS
TOGETHERWWITH THE PRINTED OR ONLINE DOCURMENTATION
FURMNISHED BY TRIDIUM IN CONJUNCTION WITH THEM, WHETHER
ACQUIRED BYYOU AS A SOFTWARE ITEM OR EMBEDDED IN
HARDWARE ARE REFERRED TO BELOWY AS THE "LICENSED
SOFTWARE" AND ARE LICENSED UNDER THIS END USERLICENSE | -

Do you accept this agreement? DYes @ No

< Back Next >

5. Change the destination folder (if required). The default path is
"C:\SBC\SaiaPCDSupervisor".

n If you enter a new path it must not contain spaces
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") iv
supervisor soCc:

sala PCO” S0 BURGESS CONTROLS

Installing the Software

Destination Falder
[CASBC\SaiaPCDSupervisor |

Default ][ Browse... ]
Space Renuired 1437690 K
Space Available 91997262 kK

This instance of Workbench will be used as an
installation tool
(1226293 K)

Install Documentation
(146 k)

< Back Next >

6. Add shortcuts to the Start Menu and Desktop.

S‘ai?PCDSu
®) ik
supervisor —tw [yl

Saia PCD" SR DURGESS CONTROLS

Install Start Menu Shorcuts
Install Deskiop Shortcuts

< Back Next >

7. Once the installation is complete the following screen is displayed.

“—
Saia PCD Su

(")
supervisor —tw [wal

Sala PCO" AU BURGESS CONTROLS

Saia PCD Supervisor installation is completel

Would you like to?
Launch Saia PCD Supervsar
Install and Start Platform Dasmaon
[¥] Copy Daermon Data From Prior Version

niagara?

framework
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44

ensures sensitive data on any station that you create is protected. En-
sure that you remember it and keep it safe as it will be required to move
the configured Saia PCD® Supervisor to another PC.

n During the installation you will be prompted to create a passphrase which

Leave all three check-box checked and click the

Finish button. Then the software is installed and two éﬁ) %;
icons are placed to the Desktop Sl piels) ;
€ A il

Installing the Platform Daemon

If there are other instances of Saia PCD® Supervisor (or Niagara) on the same PC then
the Platform Daemon must be installed. This will typically be set up during the installa-
tion process. It can also be installed and run manually.

1. Click Start and choose All Programs.
2. Navigate to the Saia PCD Supervisor folder.
3. Click Install Platform Daemon.

After a few seconds a command window should briefly appear with the following mes-
sage:

installdaemon: Niagara service successfully installed.

To check if the Platform Daemon is already running go to
Windows Control Panel - Administrative Tools = Services -
Niagara Services running

The running Niagara service can block communication ports depending on what type
of communication is configured.
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4.5 Configuring the Windows Firewall

You may need to configure the Windows Firewall to allow Saia PCD® Supervisor to
communicate correctly.

To configure the Windows Firewall

1. Open the Windows Firewall.
- In Windows 10 or 8, type ‘Windows Firewall’ in the Search box

- In Windows 7, click the Windows Start button, type ‘Windows Firewall’ in the
Search box.

- Click Windows Firewall from the list of search results.

2. Click Allow a program or feature through Windows Firewall. The Allowed pro-
grams and features list is displayed.

Allow programs to communicate through Windows Firewall

To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing a program to communicate? %) Change seftings

{0 For your security, some settings are managed by your system administrator.

Allowed programs and features:

Mame Domain Home/Work (Pri... Public ~ Group Policy *
Networking - Router Solicitation (ICMP...
Networking - Timestamp Request (ICM

) Networking - Timestamp Request (CM...

Niagara Runtime Launcher
Niagara Station Launcher
Nizgara Workbench

Ves

Ves

Ves
|Cagsjapineie e

No

No

No

[ Performance Logs and Alerts
[ Portl

Miagara Runtime Launcher O No ::
Niagara Station Launcher O No No -
Miagara Workbench O Mo Hemets

3. Scroll down the list and check that entries exist for Niagara Runtime Launcher,
Niagara Station Launcher, and Niagara Workbench for your Saia PCD® Supervisor
installation folder. If these programs do not appear in the list you will need to add
them (see procedure below).

HOQEE®EORO

EEEOOFOOOKRORM
ORREOOFOO0OROR

KX &
—|jgono

n Each installed instance of Niagara requires its own entries in the Firewall
settings.

4. If you need to change any settings click Change settings and edit the checkboxes
as required.
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To add programs to the firewall:

1. Open the Allowed programs and features list as described above.

2.

Click Change settings.

3. Click Allow another program. The Add a Program dialogue box is displayed.

© ® N o o

10.

Add a Program =

Select the program you want to add, or dick Browse to find one thatis not
listed, and then didk OK.

Brograms:
floes |
[ Access 2013
|88 7dobe Bridge C55
|| Adobe Device Central €55
% Adobe ExtendScript Toolkit CC
B Adobe Extendscript Tookit €55
|8 Adobe Extension Manager CS5
[l Adobe Help
[l Adobe Hlustrator €55
I dobe InDesign €55
-L?L-Adube LiveCyde Designer ES 8.2 .

Path: C:\Program Files\Trend Control Systems\863}

What are the risks of unblocking & program?

You can choase which netwark location types to add this program to.

[ Networklocatan types.. [ add ][ canael |

Click Browse and navigate to the Saia Burgess Controls Control Systems |

Saia PCD Supervisor | bin folder.

Double click the program to be added.

To add Niagara Runtime Launcher select nre.exe
To add Niagara Station Launcher select station.exe

To add Niagara Workbench select wb_w.exe

The program will appear highlighted in the Add a Program dialogue box. Click
Add to add the program to the firewall list. The dialogue box will close.

Repeat steps 3 through 6 to add the other programs.
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5.1

5.2

Licensing Saia PCD® Supervisor

Before Saia PCD® Supervisor can be used, it must be licensed. The license will allow
you to run the application on a single PC.

Obtain a Saia PCD® Supervisor License and Certificate

When an unlicensed installation of Saia PCD® Supervisor is run you will be prompted to
email certain details to Saia Burgess Controls in order for them to provide the relevant
license and certificate files.

To obtain a license:

1. Launch the Saia PCD® Supervisor ap-
plication, e.g. from the Start menu point

ca

; hiagara
to All Programs > Saia Burgess Con- gara

trols Systems > Saia PCD® Supervisor
and then click Saia PCD® Supervisor. e
The Request License dialogue box is o
displayed. The pop up pictures shows —

mmmmmm

you the so called Host ID of the com-
puter. The Host ID is strictly connected
to that hardware of the PC. If the hard- —
ware is changed a new license must be
obtained.

2. Email the requested information (list what is required....) to your local sales office
including the email address you would like the license files sent to.

3. Click Exit to close the dialogue box.

The Order Management Team will process your request, and email the license and
certificate files to the specified email address.

Install the Saia PCD® Supervisor License

Your Saia PCD® Supervisor license is mailed to you as a ZIP file containing a num-
ber of license and certificate files which need to be installed on the PC containing
Saia PCD® Supervisor, this can be done in two ways:

5.2.1 Automatic Licensing
5.2.2 Manual Licensing
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5.2.1 Automatic Licensing
Saia PCD® Supervisor can be licensed automatically via the [. e - v,
global license server providing the PC has internet access. |
If this is the case when Saia PCD® Supervisor is run after License Installed
your license request has been processed it will automati- :
cally be licensed and the files copied to the required folder. 1 | This machine is now licensed.

Manual Licensing

To install the license and certificate files:

1.
2.

Copy the ‘Licenses.zip’ file to the PC hard disc.

Extract all the files from ‘Licenses.zip’ to an empty folder. The folder should now
contain six files.

Copy the three ‘license’ files to the
“C:\SBC\SaiaPCDSupervisor\security\licenses” folder.

. Copy the three ‘“.certificate’ files to the

“C:\SBC\SaiaPCDSupervisor\security\certificates” folder.

You will now be able to launch the Saia PCD® Supervisor (Workbench) application.

5.3 Updating a License

If you purchase a license upgrade, e.g. for additional points, you will be emailed the
updated license files as a ZIP file containing a number of license and certificate files
and it will be necessary to upgrade the Saia PCD® Supervisor license. If the Saia PCD®
Supervisor PC PC is connected to the internet this should happen automatically - see
chapter 5.2.1 Automatic Licensing, alternatively the files can be copied manually -

see chapter 5.2.2 Manual Licensing.
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Creating/Engineering a project (application, site, ..)

Building a site within Saia PCD® Supervisor involves creating a database that reflects
the structure, devices and points within the associated Saia Burgess Controls system.
In the Saia Burgess Control System mainly the S-Bus communication protocol is used.
However it is possible to use third party communication protocols depending on the
used license. A Point in the Saia PCD® Supervisor represents a value or state of an
item in the Control System (e.g. a point represents a value or state of a symbol from
the PCD controller).

For example:
“Outside_Air_Temperature_Sensor_Value” is the point name in the Saia PCD® Supervi-
sor, but it is actually communicated as “Register 100” from the proper PCD device.

The communication connection is based on Media type and Media address
("Register 100") not on the symbol name.

There are two methods to build up the point database within Saia PCD® Supervisor:

* Manual creation of data points
* Using Saia PG5 data import wizard

You can use either one or both methods to build up your point database, according to
your requirements.

It is the best practice to only add the points required for use in the Saia PCD® Supervi-
sor. Adding unwanted points will increase the memory usage and affect the remaining
license count. Keep in mind that the points for HDLogs are imported to get it working

properly.

Goto ..

6.1 Initial Setup

6.2 Manual creation of data points

6.3 Using the “Saia PG5 Data Import Wizard”
6.4 General functions

6.5 Connect to 3rd Party Systems

6.6 Creating Schematics (Operator Views)
6.7 Set Up Saia PCD® Supervisor Users

6.8 Backup & Restore
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6.1 Initial Setup

When Saia PCD® Supervisor is run for the first time you will need to work through an
initial setup procedure which involves the following steps:

6.1.1 Launch the Saia PCD® Supervisor Application
1. Click Windows Start button and choose All Programs.
2. Navigate to the Saia PCD Supervisor and open it.

3. Click Saia PCD Supervisor. The Saia PCD® Supervisor application window will be
opened. This program is called as Workbench in relation of Niagara N4 environment. (It
n can happen that the start of the program takes a bit more time, please be patient.)

Saia PCD”
- Palette 2]
m ® D § ocoinengneens
) s res et mpn
Host ID: Win-BCEF-FASD-6162-2CA6
Version: 2.0
Help Contents 4
Thisd Pacy Licsasss niagara
End User Licence Agrscment Version: 4.7.U1

Copyright Tridium, Inc 19962017
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6.1.2

Initial Setup

Open the Platform
1.

In the Nav tree of the Saia PCD® Supervisor tree right-click on MyHost and choose
Open Platform. The Connect dialogue box is displayed.

[« Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

My Host : SZ43L TJOGGWF2.global.ds.honeywellcom  © SBChomehtml

) My Network

O

(@ My Host: S243L TJ06GWF2.global.ds.honeywell,
@ Wy File System

@ vy modules Open Platform
Open Station

My Spy

Refresh Tree Node

Go Into

o Connect

Q

Session

Open Platform with TLS

Open Platform with TLS
Connect to the host's secure platform daemon

Connect to the host's zecure platform daemon

Q

Session

Type gv Platform TLS Connection

EPW| . Flatform TLS Connection =

7rr Platform Connection

OK Cancel

Type gv Platform TLS Connection

Host |IP SZ43LTJ06GHFZ.gl i

Port 5011 Port

OK Cancel

2. In the Type box select Platform TLS Connection. Leave other settings at their

default values.

3. Click OK. The Authentication dialogue box is displayed.

@ Authenticatio

% Authentication
¢ Logon required for access

Realm

Mame
Scheme

Credentials
Username

Password

[# Rememberthese credentials

GLOBAL
HTTP-Basic

EBl

0K | Cancel|

If a ‘Cannot display page’ error appears, ensure that the Platform Dae-

mon has been installed.
See chapter “4.4 Installing the Platform Daemon”

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENG08 | 2021-02-22 6-3



Creating/Engineering a project Saia-Burgess Controls AG

Initial Setup

6-4

4. Enter the Username and Password that you would normally use to login to the

Windows PC.

For security it is recommended that the Remember these credentials box
is left unchecked.

. Click OK.

A “Platform” item will now appear in the Nav tree and various platform objects will
appear in the view pane.

@ Saia PCD® Supervisor

Window

Bookmarks ~ Tools

Edit  Search Help

File

My Host: SZ43LTJ06GWF2.global.ds.honeywell.com : Platform / Nav ContainerView -

- Nav Platform § objects

= o () My Network Name Description [
@ Application Director Controlapplications and access console output

- (@ MyHost: SZ43LTJ0SGWF2 global.dshoneywell.com

€D Certificate Management  Manage X.502 Certificates and Host Exemptions.

> @ MyFilesystem

b O vy Modules @ Lexicon Installer Install lexicans to support additional languages

» & Platform O Lic i d certificates
Q) Platform Administration  Update the platform daemon's portor credentials, or setits date and time
@ station Copier Transferstationsto and from the remote hast
 TCPAP Configuration Manage the host's TCP/IP settings
&) RemoteFile System The remote host's file system

- Palette

W [X] B | @ sbeofflineEngineering

» 3 seia PGS Data Import Wizard
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6.1.3 Create a New Station

1. From the Tools menu select New Station. The New Station Wizard is displayed.

<#> Saia PCD® Supervisor

@ New Station Wizard x
File Edit Search Bookmarks “ Window  Help
Options ﬁ New Station Wizard
: L
06GWF2.global.ds.honeywell.con Station Name

Demo_Station
Station Directory
C:\Users\E814662\Miagara4. T\SBC\stations\Demo_Station

- Nav
L C & My Network

@ My Host: 5243LTJ06GWF2.global.ds.ho

&Y My File System Station Templates
O MyModules Name Wendor Version Desi
BT Platform

NewControllerStation.ntpl Tridium 1.0

rsion Tool MNewSu pervisorStationLinuentpl Tridium 11
MNewsSu pervisorStationWindows.ntpl Tridium 1.1
SaiaPCDSupervisor.ntpl SBC 1.0

SBC_SUP_TrainingCenter_SBUS template Vintpl Tridium 1.0

Workbench J

Workbench ager
4 Back P Next I ' Finish xCﬂncﬂl

2. Under Station Templates click SaiaPCDSupervisor.ntpl to highlight it.

3. Type a suitable name in the Station Name box.

the existing station or you can go back and specify an other name for
your new Station. You must select Yes to proceed.

n If a station already exists with that name you will be prompted to delete

<™ Mew Station Wizard e

ﬁ New Station Wizard
il

Station Name

Demo_Station

Station Directory

C:\Users\E814662\Niagarad. T\SBC\stations\Demo_Station

Station Templates

Name Vendor Version Des
NewControllerStation.ntpl Tridium 1.0
NewSupervisorStationLinwentpl Tridium 1.1
NewSupervisorStationWindows.ntpl Tridium 1.1
SaiaPCDSupervisor.ntpl SBC 1.0

SBC_SUP_TrainingCenter_SBUS_template_Vintpl Tridium L0

4 Back } Next I « Finish Xt:anml
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4. Click Next.

)

ﬁ New Station Wizard
S

Username Role(s) Modified? ®

admin admin

Set Password

<™ Set Password X

Reset Password for admin

Password:

eeessses
Confirm:

‘When 'Finish' is pressed, save the station and oK cancel

4 openitinuserhome

<> copy itto secure platform for "localhost" with Station Copier
> closethe wizard

4 Back Next

 Finish | ¥ cancel |

5. Type a password in the Password for admin User box.

The password must have a minimum of 10 characters and include at
least one capital letter, one lowercase letter and one numeral (digit).

As example:

username: admin

password: Manager123 (it can be later changed)
Retype the password in the Confirm Password for admin User box.

This password is for the ‘admin’ and should be reserved for engineers. It
grants access to everywhere and to everything inside of a Station.

6. Select the copy it to secure platform for “localhost” with Station Copier option.
7. Click Finish.

8. If you have not already logged in to the Platform the Authentication dialogue box is
displayed, go to step 10

4 Ajthentication X
q\ Authentication

Logon required for access
Realm

Mame GLOBAL
Scheme  HTTP-Basic

Credentials

Username 3G

Password LTI

¥ Rememberthese credentials

OK | Cancel |

If you have already logged into the Platform, go to step 11.
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9. Enter your Username and Password (login credentials of the PC) and click OK.

10. If a station with the same name already exists, you will first be prompted how to
proceed.

<@ Station Transfer Wizard X

£ Transferring station "Demo_Station"
How do you want to deal with any existing files?

< Delete the existing "Demo_Station" directory before copying

& Overwrite existing station files with new files, while leaving otherfilesintact

S —

Finish ¥ cancel

11. Specify the required option.

12. Click Next. A dialogue box enabling you to specify the start-up options is displayed. n

“®» Station Transfer Wizard X

(\ Transferring station "Demo_Station™
Station Startup Options

[#] START AFTER INSTALL: Start the station immediately after it is copied
[#] AUTO-START: Start the station every time the platform daemon starts

Back

Finish ¥ cancel

13. Select the required start-up options.

START AFTER  Select this option if you want to start the station as soon as
INSTALL it has copied (recommended).

AUTO-START Select this option if you want the station to be started when
the PC is restarted (recommended).

When developing several Supervisors other stations will need to be
stopped.

14. Click Next.

“®» Station Transfer Wizard X

('\ Transferring station "Demo_Station™
Please review your changes

Allstation files will be copied from the local computerto "localhost”

Please select the "Finish" button to start the transfer.

4 Back Next | o/ Finish | 3 Cancel
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15. Click Finish. A progress update is displayed.

«® Transferring station

‘u Transferring station

Completingtransfer:

@ Transferfiles  Success
@ Startstation(s)  Success
Transfer complete.

Transferring files...

Sending ~stations/Demo_Station/config.bog
FileStore::commit

Wrote ,,C:\

iagarad. Tiridi :
FileStore::commitInstance commit complete
Station "Demo_Station" starting.
ITranst‘e: complete.

Demo._ ig.bog*.

16. When the process is complete, click Close. The Open Application Director dialogue

box is displayed.

< Open Application Director?

Open the Application Director now?

X

17. Click Yes. The Application Director is displayed. Check that a ‘Station Started’ mes-

sage is shown.

[«@ saia PcD® Supervisor

File Edit Search Bookmarks Tools Window

Help

java:1142)

€.
5% mva nnillsonenrrent ThreadPon] ExecnrareRnrke . run (ThresdPenl Exacror.qavs: 4171

My Host: SZ43LTJ06GWF2.global.ds.honeywell.com  Platform
- Nav Application Director
e o & iy Network Connected tolocalhost
Name Type Status Details Auto-Start Restart on Failure
@ My Host: SZ43LTI06GNF2 globalds.honeywellcom
[ certlab_os station Idle  foxen/afosn/ahtipon/ahtosnis  false true
& uy e system
JacEos station idle  fox-n/aforsn/ahtipon/ahtpsns  false true
© vy wodules = ¥t
ity S saceos._final station Idle  foxen/afosn/ahtpon/ahtpsnis  false true
S sec_seus_Test1 station Idle  foxen/afors—4SiLhttpon/ahttpssas  false true
B sec_TM2016_workshop  station  Idle fox=n/a foxs=n/s http=n/shttps=nfa false true
B stationsupoa station  Idle fox=n/a,foxs=n/a http=n/ahttps=nfa false true
[ training_Center.vi station Idle  foxen/a,foxs—4sitttpon/ahitpstd3  false true
S asits_test2 station Idle  foxen/afoxs—4SiLhttpon/ahttpta3  false true
= Demo_sttion station Running fox-1811foxs—é91L httpmn/s hitps—sd3 false true
3 Javazen)
«Javaigd)
g £ > e 3avas1z62)
B B e Javasies)
= B Fous (= Javail04)
B B 160 (F Sava:zs)
Zox.session Java:3se)
d-run (Thresd. java:74s)
1 Apr-17 CEST] [fox] Unable to start foxs, emabling fox commectivity!
& 11-Apz-17 CEST] [fox] FOXS server failed to start on port. [411]
=T te socket: Address already in uae: OV Bind
8 11-Apr-17 CEST] [sys} Niagara Runtime T.2.36.34
= : ~Apr-17
~ Palette INFO [03:09:28 11-Apr-17 CEST] [fox] FOK server started om\port [1911]
Java.net.BindException: Address alresdy in use: SV Bind
sbcOfflineEngineering ar Dual KE. bind0 (Native Method)
B X B |8 sbofincingneeing - eslavacket o Tmp1.3ava:106)
s < nSocketInpl.bina insocketImpL, Java:387)
3 512 PGS Dats Import wizard = o1 ketTmpl.bind (51 ket rpl.java:190)
o Java:sr
o Javazan)
ot JavelseriSemvessocker inin (T NImgELE NUNGIIMT CHVICUMNCIG. ¥+ 2w JUs s
2t Javax.net.ssl.SSLServerSocket -
at sun.security.ssl.SSiServersoc) **% Statipn Started (1031ms) [6698m3 total] =*=**
at sun.security.sal.SSLserverSoc -
iy a T [Fmar] moesri o A
= atum. £ e > ce.yavai1265)
= tum, = B = Javasies)
e famt B Foxs (FoxServer.1avai10d)
at Seva.usil h

[ Auto-Start
M Restarton Failure
Start.
stop
Restart
Reboot
Kill
Dump Threads
Save Bog
Verify Software

Clear Output
Pause Output
Output Dialog
Stream To File

Output Settings
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6.1.4 Open the Station
1. In the Nav tree right-click on MyHost and select Open Station. The Connect dia-

logue box is displayed.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

S
{
[AYORIY Open Platform

&T Platfor Open Station

2. In the Type box select Station TLS Connection. Leave other settings unchanged.

3. Click OK.
The Authentication dialogue box is displayed with the default ‘admin’ user

selected.

® Authentication x
% Authentication

¢ Logon required for access
Realm

Name local:|foxs:
Scheme  Fox(n4digest)

Credentials . admin

Username

Change User
Password YTTTTYYTYS Manager‘123
[] Rememberthese credentials

oK Cancel

4. Type the appropriate password in the Password box (i.e. the password specified
when the Station was created).

For security it is recommended that the Remember these credentials box
is left unchecked.

5. Click OK
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6. After a short delay, the chosen station name will appear in the Nav tree and the
view pane will show a summary of Station parameters (Station Summary view):

«®» Saia PCD® Supervisor = X

File  Edit

Window  Help

My Host: SZ43LTJ06GWF2.zlobal.ds honeywell.com (Demo_Station) ~ © Station (Demo_Station) /' Station Summary ~

Station (Demo_Station) Gobjects

E’ 0 @ My Network Name Description B

A Horm Alarm Database

v @ My Host: SZ43LTJ06GWF2.global.ds.honeywell.com (Demo_Station) —
» Q My File System @ Config The station configuration database
» 0 My Modules e Files File System accessed over Foxsession
b FT Platform o spy Diagnostics information for remate VM
~ & station (Demo_Station) [&]) Hierarchy  Hierarchyviews of remote station

‘ Alarm @ History  History database
» 9 Config
b 0 Files
» E Hierarchy
b @ History

* Palette Summary Properties 10 abjects

- [g] @ ischfﬂmeEngineermg Property Value =

3 n Saia PG5 Data Import Wizard StationName  Demo_Station
Host SZ43LTJO6GWF2.global.ds.honeywell.com/165.195.181.42

Host Model Workstation

Product Workstation

Hostld Win-BCEF-FABD-6162-2CA6

MiagaraVersion 4.2.36.34

Java Version Java HotSpot{TM) 64-Bit Server VM 25.92-b14
0SVersion amd64 Windows 10 10.0

Locale en_GB

Current Time 11-Apr-179:25 AM CEST
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Increase the memory space assigned to Workbench and station

In order to obtain enhanced performance and handle multiple devices, user need to
increase the reserved memory space assigned to the Workbench and station.

1. Go to the installer location.
2. Open the SaiaPCDSupervisor folder and then open the etc folder.

OSDisk [C:) » SBC » SaiaPCDSupervisor etc »

gradie &

Sources

& brand.properhies

iJ extensions properties 1 AN PROPERTIES F K
="3.1ch|(0 1 265 K
H lpading-splash.gif 2 2 A IF File KE

_'J moduledey. properties

o re properties } PROF
CETERE

M sboSplashlogo.png

3. Open nre.properties file.

& CASBO\SsiaPCDSupervisoriete\nre properties - Notepad--+

File Edt Search View Epcoding Language Settings Tools Macro Run Plugins Window 2

cHEERG& LMK deag x| BE T ERERe=2 N ER BDEEE v 2B
e 57 | Wl wirout BugBefom Bindg.cd <3| IRl BeforeSemavrgBinding b | Wl ew 56 13| I meciinces | | proverties (23| e 58 13| e 59 21 | Wl new 50 3 | Bew 61 3| Wlles
Lidd i siaatttata iRk AR R AR A SRR AR AR AR AR AR SRR A RSB R diE

2

3 # File: nre.properties

¢ #

S This file contains properties which used

# the NRE launch executable

i

3 # Revision History

e g 17 Feb 04 Brian original
LE
11 #etdddbrdsdfanetsindattdadt i aaa oo nendfatadtandas

1 # The list of options separated by spaces to pass thru to the WM
l4 station.java.options=-Dfile.encoding=UTF-8 -Xs5s512K -Xmx1024M
15 wb.java.options=-Dfile.encoding=UTF-8 -Xs55512K —xmx1024M1|
16

4. Update the memory space reserved for the Station in the second last line to

station.java.options=-Dfile.encoding=UTF-8 -Xss1024K -Xmx2048M.

5. Update the memory space reserved for the Workbench in last line to

wb.java.options=-Dfile.encoding=UTF-8 -Xss1024K -Xmx2048M.
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6.2

6.2.1

Manual creation of data points

This chapter describes the manual creation of the point database.
The following steps are needed to create the data point:

1. Add a Saia Burgess Controls Driver (it is named as “sbc” in the Palette)

2. Configure the driver

3. Add device(s) manually (mainly PCD or other S-Bus communicating devices)
4

. Add the required points to the database. Take care of the conversion. Building au-
tomation mainly using integer numbers multiplied with factor 10 in the PCD control-
ler. While Saia PCD® Supervisor is using normalized floating point.

5. Check (or modify if necessary) the speed of the communication of the point

This is a tedious process with the possibility to make mistakes easily. However it is
advantageous for every System Integrator to understand the process.

It makes sense to arrange a PCD controller - connected to Saia PCD® Supervisor - with
a simple user program to follow up the explanation.

The user program can be for example a simple PCD device with media mapped
PCD3.S100 Workshop Simulator Unit. (Who does not understand this sentence please
go through the SBC PG5 User Manual or better to take part of a Basic SBC PG5 work-
shop.)

Important: The communication connection is based on “Media type” + “Media Address”
(e.g. Register 100). Best practice is to use explicit addressing (so called “hard address-
ing”) in the PCD controller. Dynamic addressing can be also used (makes no so much
sense) but the System Integrator must understand, that the dynamically allocated ad-
dresses in the PG5 can be any time overwritten by the PG5 programming tool.

From SBC V3.0 onwards, the default Data Point View changes from
Hon BACnet View (Web application View) to Hon Data Point View (UX/
HTMLS5). Different views still can be selected by choice.

Add a Saia Burgess Controls driver (SBClpNetwork)

We need to define at least one SBCIpNetwork for S-Bus over Ethernet communicated
devices. Under the SBCIpNetwork driver many PCD devices can be configured to com-
municate with. It is possible to define other SBClpNetwork networks in order to distrib-
ute the PCD devices better and decrease the load of each SBClpNetwork.

The Saia Burgess Controls Driver controls the communications and flow of data to and
from the PCD devices.

It is possible to communicate with serial S-Bus networked devices using the SBC
S-Bus gateway function in the PCD controllers.
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On larger sites it may speed up data transfer to utilise two or more separate SBC
S-Bus drivers (SBCIpNetwork)

6.2.1.2 Create a folder for Saia Burgess Controls Driver
1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Right-click on Drivers and select New > Folder. The Name dialogue box is dis-
played.

o Mame > n
® =

oK Cancel

4. Type SBC and click OK. The new folder will appear in the Nav tree.

5. Right-click the SBC folder and select Rename. The Rename dialogue box is

displayed.
4% Rename >
® SBC Syatems
OK Cancel

6. Type SBC Systems and click OK.
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6.2.1.3

1.
2.

Add the Saia Burgess Controls Driver

In the Nav tree open the Station folder.

Open the Config folder.

Double click on Drivers. The view pane will show a list of installed Drivers

(Driver Manager).

Click on the New button. The New dialogue box is displayed.

In the Type to Add box select ‘SBCIpNetwork’.

Click OK. The following dialogue box is displayed

File Edit Search Bookmarks Tools Window Manager Help
- Nav Driver Manager Lobjects
¥ o @ MyNetwork Name Type Ststus Enabled FaultCause  ®

@ My Host: SZ43LTI06GWF2.global ds.hone: o okl twe
@ Wy File System
@ vy Modules
& Platform p—— X
& station (Demo_Station)
B aGr TypetoAdd | Aa Php StarNetwork
© confi Numberto Add | €9 Modbu:
@ services
O orvers
O niagaranetwork
A\ car St
~ Palette
w XA #e
O sscipnetwork
Qrco 6 Rapid Eye Network
© reosubstation @ RabmeNetwork
Q AlarmList SBCIpNetwork
7T T

o Mew

Mame

ri Mame
ﬁ Type

Type

SBCIpNetwork Demn
SBCIpNetwork

ﬁ Enabled . true

Enabled

€ sBCIpNetwork_[ SBCIpNetwork  true

OK | Cancel |

x

Change the default network Name to be a meaningful name for the site.

This can be renamed later by right-clicking the driver in the Nav tree
and selecting Rename.
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8. Click OK. The Driver Manager will now show the Saia Burgess Controls driver.

< Saia PCD® Supervisor

Edit

File

4 n O-

My Host : SZ43L TJOBGWF2.global.ds.honeywell.com {Demo_Station)
- Nav
L C

v (@ My Host : 57431 TJ06GWF2.global.ds.honeywell.com (Demo_Station)
» & uyFilesystem
» @) mymodules
& Platform

() My Network

v & station (Demo_Station)
A Alam
» @ Config
b @ services
v eDrivers
» 6 NiagaraNetwork
» O seCsystems
» @ seCipNetwork_Demo
GADDS
4 gFilEs
J EH\erarchy

@ History

- Palette
wE D #

» 3 seCipNetwork

» @rco

» @ PcDsubstation
© alarmList

b <% HDLog

» Al PCDDeviceFalder

» [ SECPointFolder

» O roints

9. Right-click the driver and select Cut.

: Station (Demo_Station)

- Nav

¥ O

v (@ MyHost: 5743LTI06GWF2.globaldshoneywell.com (Demo_Station)
) uy File system

© vy Modules
b & Platform

() My Network

~ & station (Demo_station)
A Alarm
v © config
@ services
v ) Drivers
> NisgaraNetwark
» O sBCsystems
3 sBCipNetwork,
» @ Apps
b @ Files
» [ Hierarchy

@ History

Views
Actions

New

Edit Tags

Make Template

Cut

- Palette

&% @ O

: Config @ Drivers

Driver Manager

Name Type

) niagaraNetwork Niagara Network

) seCipNetwork_Demo  SBCIpNetwork

[5) New

B X

Driver Manager ~

2 objects
Status Enabled FaultCause B
Jok}  true

{ok} true

£ Edit | B Tapt
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10. In the Nav tree, right-click the SBC Systems folder and select Paste.

- Nav &
P o & My Network

@ My Host: SZ43LTJ06GWF2.global.ds.honeywell.com [Dema_Station)
@ iy File system
O My Modules
& Platform
& ststion (Demo_Station)
A 2lam

SBCIpNet]
@ sops
@ Files

(&) Hierarchy Edit Tags

@ rstory Make Template
c
Copy

- Palette

New

Paste

W X B |# sbe

ﬁ

It is possible to create folder to the points to make nicer structure.
However when the Saia PG5 Data Import Wizard is used the default
SBCIpNetwork folder is generated. This folder can be renamed. The
next import then will be done to the renamed folder. The target folder
of the import can not be freely chosen.

11. In the Nav tree, right-click to the SBClpNetwork_Demo in the SBC Systems
folder.

12. You now need to configure the communications of (each - if you have many)
Saia Burgess Controls Driver.

6.21.4 Duplicated physical device

During import of a PG 5 project for each physical Saia PCD controller device one de-
vice note will be added in the Saia PCD Supervisor below the SBClpNetwork Network
driver.

It is possible to have the same physical Saia PCD controller device duplicated below
the imported SBCIpNetwork driver network or to have the same physical device used in
different SBClpNetwork drivers on the Saia PCD Supervisor station.

For constellations to have one physical Saia PCD controller device present several
times below SBCIpNetwork drivers in the Saia PCD Supervisor you should not exceed
5 instances on the Saia PCD Supervisor per physical PCD controller device.
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Configure the Saia Burgess Controls Driver(s)

Saia PCD® Supervisor connects to the Saia Burgess Controller network (Ethernet
networked PCD devices) using S-Bus over Ethernet communication. It is necessary

to configure Saia PCD® Supervisor with the IP Address (or hostname) and the S-Bus
station address of the device to communicate with. Inside of the PCD device the Media
can be addressed by specifying the type and memory slot.

At this point it is recommended to have a Saia PCD device (a controller with the cor-
rect application running inside, with the correct Ethernet parameters set in the PCD and
also in the PC) connected to the Saia PCD® Supervisor.

In the Nav tree right-click on the Saia Burgess Controls driver (e.g. SBClpNetwork_
Demo) and choose Views > AX Property Sheet. The view pane will show a list of driver
properties:

@ Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

My Host: SZ43LTI06GWF2.globalds.honeywell.com (Demo_Station)  © Station (Demo_Station) ~ : Config  : Drivers  : SBCSystems @ SECIpNetwork_Demo
- Nav Property Sheet
Eo Is) @MyNEtwurk ﬂ SBCIpNetwork_Demo (SBCIpNetwork)
[ status 1ok}
(@ My Host: SZ43LTI08GIF2. global.ds.honeywell.com (Demao_Station) T Enabled [ I
Oy Flesystem [ Fault Cause
O rywodules L Health Ok [11-Apr-17 1:52 PM CEST]
Y Platform [l Down @ fase
& station (Demo_station) - ®
L Alarm false
A slem .
(W LastOkTime  [11-Apr—2017 01:52 PM CEST
© confie b
[ LastFail Time  [ull
@ services =
Ul Last Fail Cause
6 orivers
© Alarm Source Info  Alarm Source Info
6 NisgaraNetwork =
(@ Alarm Class Default Alarm Class
© sBesystems
B tparent. displaylamet
) sacipNetwork_Demo |l Source Name (6]
X TuningPolicies [ To Fault Text ®
@ apps -
@ e [l To Offnormal Text | LeXicon (driver:pingFail)s ®
(&) Hierarchy I8 To Normal Text tlexicon (driver:pingSuccess)s ®
@ History
- null W - (Defaultview) - P
[ Hyperlink Ord
o > o
- Palette
L Sound File null m- )
X A |l =
[ Alarm 1con null .- )
) secipetwork -
o [ Alarm Instructions ~ Olnstructions 3
© pcosubstation [ Meta Data » -
Q AlarmList L3 Monitor Ping Monitor
A Holog [ Ping Enabled @ e
1A PCDDeviceFolder [l Ping Frequency +000008 O5m 002 3
I sBcPointFolder [ Alarm On Failure @ tre
O pans [l Startup Alarm Delay [+00000h 05m 0033

X Tuning Policies Tuning Policy Map
Y Default Policy Tuning Policy

[ Min Write Time 00000k 00m 0082} [oms-+inf]
(W MaxWrite Time ~ [00000R 00m 00s|3] [oms-+inf]
[l Write On Start @ e
[ write On Up [ E
(W Write On Enabled | @ true
(W Stale Time 00000 00m Q03] [oms-+inf]

Basically the default parameters are good for starting.

The driver must be enabled. Status must be OK. It can happen that the status at the
beginning is “down” it will be “ok” right after the communication is established with the
SBC Device.
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6.2.3 Adding Device to the Saia Burgess Controls Driver(s)

Each physical networked SBC controller needs at least one PCD (device) added to the
Saia Burgess Controls Driver (SBCIpNetwork_Demo) with unique name.

1. Open the Palette sidebar if it not yet opened.
Menu bar — Window menu — Sidebars — Palette

2. Open the “sbc” palette.

- Palette ¥

[ IZ‘ E i she
n  sBCipNetwork
@ rco

© rcosubstation

OAlarmList

<% HDLog

I PCDDeviceFolder
A secrointFolder

O Paoints

3. Copy PCD from palette. Right click to PCD and select copy.
4. Right mouse click to the driver “SBClpNetwork_Demo” and paste it.

5. Name it as Device1 (- or CPU1 - or respectively to the app running in the device
e.g. AHU1 as Air Handling Unit 1).
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Double click to the Device 1 will bring up the following screen.

@ Ssia PCD® Supenvisor

File Edit Search Bookmarks Tools  Window

Help

My Host: 5743LTJ06GWF2.global.ds.honey

com {Demo_Station)

© Station (Dema_Station) . Config . Drivers I SBCSystems . SBClpNetwork_Demo * Devicel

~ Nav Property Sheet
¥ O ) My Network @ Devicel (SBCHeadstation)
li Status {down, alarm,unackeda.
v @ MyHost: SZ43L TI06GWFZglobal.ds.honeyweLl.com (Demo_Station) [ Enabled @ e
b @ wyFiesystem [ Fault Cause
b @ uyodutes v [ Health Fail [11-Apr-17 2:31 PM CEST] Timed out 1.
b @ Platform 0 Down Ot
v 4§ station (Demo_station)
Alarm @ true
A tarm li
= Clerty [ LastOkTime  [mull
@ li Last Fail Time 11-Apr-2017 02:31 PM CEST
» Services
BD_ li Last Fail Cause  Timed out waiting for response.
v rivers

w @ Alarm Source Info Alarm Source Info

b Nisgaratetwork [ Alarm cL
arm Class

v Q sacsystems
w6 saCipNetwork_Demo

Default Alarm Class

T Source Name tparent.parent. displaylianet Sparent.disp| ()

[l To Fault Text @

tlexicon(driver:pingFail)t ®

» X TuningPolicies
@ Devicer
b @ aps
] @F\Les

» EH\erarchy
® null W - (Defaultview) + P
’ History [ Hyperlink Ord

(W To Offnormal Text

T To Normal Text tlexicon(driver:pingSuccess) ®

» o
- Palette
[ Sound File null -

D [ Alarm Icon null -
: gzi;wem[k [l Alarm Instructions  Olnstructions )
» @ Peosubstation [l Meta Data » O~
» Q Alamlist » B¢ Poll Scheduler N Poll Scheduler
» A rdlog (@i Poll Frequency Normal
» A PCODeviceFolder » [l Ip Address 127.0.0.15050
b [ sBCPointFolder (W Station Id 0
b Qroints b 4 Points SBCPoIntDeviceExt

b @ Alarms Alarms

L @ Histories Histories

] li Device Information  SBCDevicelnformation
li Ftp Username

(W Ftp Password

[ Http Password

» ‘Qll DataPoll Frequency  30secs {Sun Mon Tue Wed Thu FriSat}

O Refresh | [7] save
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7. Setup the IP address and the S-Bus Station ID of the Device 1
The Device1 must be enabled.
Keep the default parameters in.

Property Sheet
© Devicel (SBCHeadStation)
. Status {down, alarm, unacked?]
[l Enabled @ true
[ Fault Cause
L Health Fail [11-Apr-17 2:36 PM CEST] Timed out \...
[l Down @ tue
[ Alarm ® tnue
[l Last Ok Time null

[l Last Fail Time 11-Apr-2017 02:36 PM CEST

. Last Fail Cause Timed out waiting for response.
© Alarm Source Info Alarm Source Info

(@ Alarm Class Default Alarm Class

. Source Mame tparent.parent.displayName: %parentc.displ @

[ To Fault Text 0]

. To Offnormal Text %lexicon({driver:pingFail) % @

. To Normal Text %lexicon{driver:pingSuccess) @

. nall B - (DefaultView) - P
Ll Hyperlink Ord

R » -

(W Sound File mll -- o)

[l Alarm Icon mll -- o)

(@ Alarm Instructions  Olnstructions 3

. Meta Data >> o -
B+ Poll scheduler N Poll Scheduler
@ Poll Frequency Narmal
@ Ip Address 127.0.0.1:5050
M IpAddress  [172.23.13.19
(W Port [ unspecified |5050 [-1-65536]
[ Station Id 14
& Points SBCPointDeviceExt
@ Alarms Alarms

Histories Histories

[ Device Information SBCDevicelnformation

[ Ftp Username

[l Ftp Password

[ Http Password

Gl Data Poll Frequency  30secs {Sun Mon Tue Wed Thu Fri Sat }

7 Refresh | [ save |

The FTP credentials and HTTP password need to be manually config-
ured here. If these credentials are missing, then the HDLog and Alarm
data retrieval are not working.

The status can be OK or Down. When it is OK the communication is well estab-
lished. When it is down it can happen that he initial telegrams were not correct
answered (wrong IP or S-Bus station number). Check and correct - if needed - the
settings. Save the settings. Press the Refresh button at the bottom of the page.

Disable the Device and save the settings. Enable the Device and save the settings.
These actions are initiating telegrams which must be answered by the Device.
Navigate to the Device Information. This will surely initiate telegrams to be sent
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in order to get back the basic information of the connected Device. After that the
“Status” of the Device must be OK. If not the parameter settings is not correct, or
the Device is not correctly connected to the network. Try to ping the Device (keep
in mind that the Windows firewall can block the ping). Step by step check of the
settings in the SBC Device and also in the Saia PCD® Supervisor is needed.

Last step is to restart the Platform Daemon,
See chapter 4.4 Installing the Platform Daemon

% Saia PCD® Supervisor

File Edit Search Bookmarks Teols Window  Help

My Host : 5243LTJO6GWF2.global.ds.honeywell.com (Demo_Station) © Station (Demo_Station) . Config ¢ Drivers © SBC Systems . SBClpNetwork_Demo
- Nav Property Sheet
h@ s} @ My Network [l Device Information (SBCDevicelnformation)
) Services [_i PCD Status Run
© Drivers @ PCD Type PCD3.M6860
b 6 nisgaraNetwork (W PCD Clock 17-04-11T14:47:17
Q) sBCsystems @ Firmware Version  [1.26.15
) saCipNetwork_Demo (@ Time Zone uTC (<0}
:l,' Tuning Policies
° Devicel

o Alarm Source Info
B¢ Pollscheduler
e Points

@ Alarms

@ Histories

ﬁ Device Information

g Data Poll Frequency

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENG08 | 2021-02-22 6-21



Creating/Engineering a project Saia-Burgess Controls AG

Manual creation of data points

6.2.4 Add Points to the Device to get the data from the PCD

First of all it is not possible to “Discover” the points from the PCD device.
The points must be added manually.

Let us create a “SBCRegister” and some “SBCFlag” type of points.

1. Navigate to the Points folder of the Device1. It is empty.

2. Navigate to the Palette — sbc — Points. In this folder there are templates for
every each possible type of points. This means these type of variables can be
found inside of the SBC Device depending on the user program. The template
points are nicely colored so it is easy to distinguish the different types.

n 3. Drag the “SBCRegister” type from the Plaette “sbc” and drop it to the Device1/
Points folder. In the pop-up window name it “Analoglnput_1”

i® Mame >

OK Cancel

Name it in such a way that it will connect here the physical analogue input 1 of
the PCD3.S100 workshop module. Of course there is a corresponding program
downloaded to the PCD device.
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4. The address has to be set for that point. In this case, the first analogue input of
the selected Device is mapped to the Register 100. (In this application this is a
potentiometer of the PCD3.5100 simulator unit)

OO~

Double click to the Analoglnput_1.

Open the Proxy extension.

Setup the Memory Address to 100.

Data Format can be as it was “Signed Integer”.
Save it.

File Edit Search Bookmarks Tools Window Help

4 o O- o n O [ R [ wa

» D sBCTextRam

units=null precision=1,min=-infmax==inf 3 D ~

module://sbc/resources/images/register.png

My Host : SZ43LTJ0BGWF2 global.ds.honeywell.com (Demo_Station) ~ : Station (Demo_Station) ~ : Config @ Drivers @ SBCSystems
— Property Sheet
¥ o © My Network © Analoginput_1 (Numeric Writable)
é (W Facets
. Drivers
3 Proxy Ext SBCProxyExt
) nisgaraletwork W
Status {ok}
© seCsystems
ﬁ Fault Cause
@ sacipNetwork_Demo B Enabled ®
Enable true
X TuningPolicies u
© Devicer [l Device Facets » O
» @ alarm Source Info M Conversion 12 efautt
f® Pollscheduler [ Tuning Policy Name  [Default Policy
~,
& Foints == Read Value 957.00 {ok}
) Analoginput 1 w—Write Value - {null} @ def
» (@ Alarms [l Memory Address 100
© Histories [l Data Format Signed Int
v [l Device Infarmation out 957.0 {ok] @ def
- QU .0 [0 3
Q Data Poll Frequency - Ini {null}
- {nu
» @ Apps
i @ 4pp -2 ~ {mull}
Files
- In3 — {null}
[E) Hierarchy J——— - [null}
Histo
@ History - In5 - {null}
- Palette — e
= In7 — {null}
b
w X B | # e - g - {null}
©) PCDSubstation - Ing {null}
- {nu
AlarmList
Q Al = In10 - {null}
& HDLe
og == In1l - {mull}
I FcDDeviceFolder - In12 {null}
A sBCPointFolder - n13 - {null}
Paint:
Q roints - Inid — {null}
[ SBCFl;
@ secrizg - In15 - {null}
@ sacrlsgvolatile In16 [null}
- - {nu
SBCRegist
(0 seCRegister == Fallback - {null}
» %SBEReg\sterHuat (Ml Override Expiration (21l
SBCInput
b npu [l Media Type Register
SBCOutput
fi Comments
b @ ssCTimer
© sEcCounter W eon
» (D sacoBERam
© sacoe
) ssctet

7 Refresh [ save

: SBCIpNetwork Demo -

SECIpNetwork_Demo

HOoH W W W W

WO WM MW

5. The Status must be {ok}. It can be seen that the “Read Value” and the “Out” are
following the content of the “Device1/Register 100”.
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6. The Conversion is set automatically to 0.1. The Conversion is set to Linear
and the Scale is set to 0.1. This will remove the 10 multiplication factor we use
conventionally in the Building Automation. This scaling can be seen on the
“‘Read Value” and the “Out”.

Property Sheet

@ Analoginput_1 {Numeric Writable)

.-. Facets units:null,pr&cision=1:min=-inf_.maF—i@ L -
3 Proxy Ext SBCProxyExt

[l Status {ok}
(@ Fault Cause

(@ Enabled @ true
n (Ml Device Facets » O-

(M conversion 7 Linear Scale 0.1

Ul Tuning Policy Name  |Default Policy

Read Value §57.00 [ok}
Write Value - [null} @ def
(@l Memory Address 100
(@l Data Format Signed Int
out 35.7 {ok} B def

It is possible to set the Engineering Unit, precision, and the limits of the value, in

the Facets.

@ (g
Key Type Value e
units Unit null l:l
precision Integer 1
min Double -inf
max Double +inf

@ X| O -

0K Cancel
Lo X
temperature (K) celsius (°C) 19 -
0K Cancel

7. For the SBCFlag types. Copy the “SBCFlag” type of point from the Palette.
Right click to the Device1/Points folder. Select “Paste Special’.

6-24 Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG

Creating/Engineering a project

8.
touched.

ot

> Paste Special

D Paste Special

Mumberof copies |

[] Keepalllinks

[] Keep allrelations

OK ‘ Cancel

9. 8 points are generated with the name “SBCFlagx”

Manual creation of data points

In the pop-up set the “Number of copies” to 8. Other settings must be un-

10. | want to change the names of the generated points. Select the points. Right
click to the selection. Select rename from the context menu. Fill up the “Search
for” and the “Replace with” fields. Press ok.

My Host : S743L TJD6GWF2.global.ds.honeywell.com (Demo_station)

: Station (Demo_Station)

: Config

© Drivers

: SBCSystems

: SBCIpMetwork_Demo  : Devicel

© Points

() My Network

X TuningPolicies
© pevicel
© Alsrm Source Info
¢ Pollscheduler
& Points
© ancloginput_1
0 secrlee
0 secrigt
0 secrioz
0 secriazs
0 secrlags
B secrlaes
@ secrlees
0 sacrlagr
@ alarms
© Histories
[ Device Information

Gl Dats Poll Frequency
~

- Palette
w X B |# b

& PCDSubStation
© alarmuist

& HDLog

A PCDDeviceFolder
A sBCPointFolder
) paint

Database

Name

© analoginput_1
© secrlag

© secrlagt

Q secrlag

© secrlags

© secrlags

© secrlags

© secrlags

Q secrlag?

Type
Numeric Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable

Boolean Writable

Out

957.0{ok] @ def

false [ok} @ def
false [ok} @ def
false [ok} @ def

false [ok} @ def

Tuning Policy Name
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy

defaultPolicy

false[ok} @
false[ok} @
false[ok} @

falsefok} @

“® Rename

Old New

SBCFlag? Digitalinput_7

SBCFlagl Digitallnput_1
SBCFlag2 Digitalinput_2
SBCFlag3 Digitalinput_3
SBCFlagd  Digitalinput 4
SBCFlag5 Digitallnput_5
SBCFlagé Digitalinput_6

SBCFlag  Digitalinput_

Search for:
SBCFlag
Replace with:
Digitallnput_
[ Match Case

[ Match Word

oK Cancel

11.

12. Setup the address of each “Digitallnput_” points.

Right click to the “Points” folder of the Device1 = Views = AX Property Sheet

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22

6-25



Creating/Engineering a project

Saia-Burgess Controls AG

Manual creation of data points

13.

The Status must be {ok}. The “Read Value” and the “Out” of the generated
points are following the content of the Flag 100 to 107 of the Devcie1.

L sziapcDe

File  Edit Search Bookmarks  Tools  Window

Help

My Host: SZ43LTJ06GWF2 global.ds.honeywell.com (Demo_Station)

(&) My Network

X TuningPalicies
@ Devicel
© lsrm source Info
¢ poll scheduler
& Points
© ansloginput_1
B oigitalinput_
0@ vigitalinput_1
@ Digitslinput 2
© oigitalinput_3
© oisitalinput 2
© oigitalinput 5
© oisitalinput_6
@ oigitalinput 7
@ Alarms
O Histories

[l Device Information

© Station (Demo_Station)

: Config @ Drivers

Property Sheet
%% Points [SBCPointDeviceExt)

o Analoginput_1  957.0 {ok} @ def
true {ok} @ def

© Digitalinput_

[ Facets

E} Proxy Ext
[ status
. Fault Cause
[ Enabled
[ Device Facets
(W conversion
[ Tuning Policy Name
== Read Value
= Write Value
. Memory Address
[l Data Format

= Qut

= Inl

: SBCSystems

: SBClpNetwork_Demo : Devicel I Points

trueText=true,falseText=false 3 @ ~

SBCProxyExt
{ok}

@ true

> O

1= Default

Default Policy

true {ok}

- {null} @ def

100

Boolean
true {ok} @ def
- [null}

6-26

- n2 - {null} ]
@l Data Poll Frequengy I e z

The same way it is possible to create every needed points and connect it to the corre-
sponding media element of the Saia PCD device.

Remember that Saia PCD® Supervisor is licensed for use up to a specific number of
points. It is good practice to only add points that are actually required. Adding points
that won't be used by Saia PCD® Supervisor will not only waste resources but also
generate unnecessary extra network traffic.

6.2.5 Add Alarming to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is an Alarm Service which can be used to set Alarms
for individual datapoints, regardless if the datapoint is considered alarm or not at the
start of the engineering.

For example the Outside Air Temperature can generate an alarm when it goes under
—20°C. For that we need to set the monitoring in the Saia PCD® Supervisor. So the
Alarm is generated in the Saia PCD® Supervisor not in the PCD controller.

There is an other way of alarming, which is described in details later in this manual.
The Alarms are generated in the PCD Device and the Saia PCD Supervisor takes
these alarms over.
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6.2.5.1 Steps to set alarming to a datapoint

1. In the Nav tree open the 127.0.0.1/Station(Demo_Station)/Config/Services folder.
And double click to the AlarmService.

@ Saia PCD'® Supervisor

Search  Bookmarks Tools Window  Wire Sheet

File  Edit Help

4 o O- o A O 0] - [ n
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config H o AlarmService
* Nav Wire Sheet
L O () My Network
— - Alarm Db Config ™ l
File Alarm Db Canfig
@ services [ J
© alarmservice Default Alarm Class | o ConsoleRecipient B
5 Alarm Clazs Console Recipient
@ BackupService Alarm Route Alarm
@ CategoryService e
@ JobService
@ RoleService
- O UserService

The default view (Wire Sheet) will be displayed with the default settings. (Alarm Db
Config, Default Alarm Class and the Console Recipient).

The Default Alarm Class is already used for system alarms (for those alarms which
is generated in the Saia PCD® Supervisor). Most of the cases we do not want to
see the Supervisory system generated alarms together with the alarms which is
coming from the controlled process. So we need a new alarm class to be placed.
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2. Place a new alarm class to the Wire Sheet from the palette. It can be named as
you it is proper. (here it is named Critical Alarms)

<% Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet

127.0.0.1 (Demo_Station) . Station (Demo_Station) 2 I Services . AlarmService
- Nav Wire Sheet
E@ O @ My Network
Alarm Db Config &
File Alarm Db Confi
b (@ My Host: 5243LTJ06GWF2.global.ds.honeywell.com
v (@ 127.0.0.1 (Demo_Station) e -
s Alam Class A
v ’ Station (Demo_Station) |A.Iam!

! Alarm
- e Config Critical Alarms [ ‘q]
v @ Services i
Alarm |
1

v ° AlarmService

A Default Alarm Class
p.: | . Critical Alarms
b @ BackupService

b @ CategoryService

b @ JobService @ Name x
@ RoleService @ Critical Alarms
. o UserService

» 0 AuthenticationService 0K Cancel

2 Q’ DebugService

g @ BoxService

8 FoxService
b @ HierarchyService
b 0 HistaryService

O auditHistoryService
P —

- Palette
3 E] E ialarm

» o AlarmService
p | ‘ AlarmClass
b o AlarmClassFolder
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3. There Console Recipient is already placed. It is possible to use this recipient (re-
name it to proper name) or place a new one.

This Console Recipient is coming form the SaiaPCDSupervisor.ntpl tem-
plate file.

The alarm console is one way to inform the User about alarm occurred in the sys-
tem. There can be other way like sending E-mail or SMS.

File Edit Search Bookmarks Tools Window  WireSheet Help

127.0.0.1(Demo_Station) . Station (Demo_station) I Config I Services o AlarmService
- Nav Wire Sheet
¥ C ) My Network
= = Alarm Db Config )
File Alarm Db Config
@ services . ]
O slormsenice Default Alarm Class
Alsm Class a

A DefaultAlarm Class
| —————————|

A Critical Alarms
EAlarmConsulesbus

@ sackupSenvice

B 4
[Blarm |
L ]

@ CategoryService
@ Jobservice
€D Roleservice

AlarmConsoleSbus E
© usersenvice Console Recipient

© Authenticationservice Status i

LT pebugservice
@® soxservice

¥ Foxservice

® vierarchyservice @ Name X

) HistoryService @ 2larmConsnleSbus

© nuditHistoryService

© LogHistoryService oK Cancel

@ rrogramservice

© searchservice

©Q Taepictionaryservice
N = SE——

- Palette
w X B #etam

©Q alarmservice
& AlsrmClass

&) alarmClassFolder

O Recipients
b consoleRecipient
@& StationRecipient

Q) exdensions

O rrinterRecipients

4. Wire the Alarm console and the Alarm Classes together as the next image shows.
The system has to know what to do with the alarms so that the Alarm Classes
(container of alarms) and the Alarm Console (a way to display them) has to be con-
nected.

Wire Sheet

Alarm Db Config & ]
File Alarm Db Config
L J
Default Alarm Class
Alarm Class A
[Alarm F
L |
Critical Alarms - ] AlarmConsoleShus =
Alarm Class ‘Consale Recipient
[Alarm T Route Alarm
I J Status {ek}]

5. Copy the BooleanChangeOfStateAlarmExt from the Palette / Alarm / Extensions
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to the data point where alarm has to be added. (Boolean datapoint called: Points/
Heating1/Supply/Pump/Alarm)

In the pop-up Name field give a proper name (or just leave it default)

Edit Search  Bookmarks Tools Window  Help

€D ip:127.0.0.1foxs:|station:|slot:/Drivers/SBC520Systems/SBCIpNetwork_Demo/Devicel/points/Heating/Sup
= Nav
h@ O @ My Netwark
Il- Poll Scheduler
v @ Points
- H Heatingl
v ° Ack
b [F ProxyExt
H opMode
» [ outside
H Return

O :: | Temperature
v B valve
b @ pi_signal
o signal
b o ThreePoint_close
G ThreePoint_open

6-30

H supply
[:: ] Pump
v o Alarm
» Q Proxy Ext
) ° Feedback
e MotorProtection
L ° Output
w BEl Tarnnerstire
- Palette
] [z] @ i alarm
o Alarmservice
A AlarmClass > Name
4 o AlarmClassFolder @ Rlarm
o Recipients
© extensions L M

Q OutOfRangeAlarmExt

3 gStrmgchangeof\falueAlﬂrmExt
Q BooleanChangeOfStateAlarmExt

) gBaoleancammandFailurr:AlarmExt
Q EnumChangeOfStateAlarmExt

b gEnumcammandFailureAlarmExt

) g StatusAlarmExt

0 PrinterRecipients
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6. Set up the properties of the Alarm Extension

Alarm inhibit
Alarm Enable

false

x toOffnormal ; o toFault

Manual creation of data points

[<®> Saia PCD'® Supervisor

Edit Window

0 m-

I Config

File Search  Bookmarks Tools Help

4 O O-ona O

127.0.0.1(Demo_Station) ~ : Station (Demo_Station) : Drivers

- Nav

O

) My Network

» [ pollscheduler
v ePumts
w [ Heatingt
v GAck
» GmeyExt
» [ opMode
b [E outside
w [ Return
b B Temperature
+ Evalve
] OPI_S\gnaL
] aSignal
» @ ThreePaint_close
] GThr&ePnint_ann
I supply
+ [ Pump
« @ alam
[ gProxyBct
] gAlarm
b GFeedba:k

] G MotarProtection
n M

- Palette
] [Z] 2 ialarm

» Q) Alamservice

» -. AlarmClass

b DAlarmClﬂssFﬁlder

b O Recipients

- 0 Extensions
3 guuthRangeALarmB(t
» gStrlng[hangeUﬂ'alueAlarcht
I &7 BooleanChangeDfstateAlarmExt
» gBDULeanCummandFa\lureALarmExt
» QEnumChangEOfStateAlarmExt
b+ &7 EnumCommandFailureAlarmext
b QStatusAlarmExt

b OPnntErREcip\Ents

. SBC Systems : SBClpNetwork_Demo . Devicel . Points . Heatingl © Supply

Property Sheet

@ 2larm (Boolean Writable)
[ Facets trueText=true falseText=false ) @®) ~

] Q Proxy Ext SBCProxyExt
= Qut true [alarm,unackedAlarm} @ def
== |nl - {null}
- |n2 - {null} 4
= |n3 - [null} 4
- |nd - {null} 4
- |n5 - [null} 4
- NG - [null}
= |n7 - [null} ¥
= |ng - [null}
= |ng - [null} ¥
= n10 - [mull} ¥
= nil ~ [null} 3
- |12 - [null} 4
- |nl13 - [null} 4
= |ni4 - [null} 4
= |n15 - [null} ¥
- |nl6 - [null} ¥
== Fallback - {null} ¥
[ Override Expiration null

[ Min Active Time
(@ Min Inactive Time

li Set Min Inactive Time On Start

li Icon

[ Media Type
W comments
- &7 Alarm
== Alarm Inhibit
W Inhibit Time
[l Alarm State
[l Time Delay
(W Time Delay To Normal
(W Alarm Enable
(W To Offnormal Times
(W To Fault Times
(@ Time In Current State

@ Source Name

+00000h 00m 00s|3
+00000h 00m 00s j

® false
module://sbc/resources/images/flag.png
Flag

Error message pump

Alarm Source Ext

false {ok} ¥

00000h 00m 00s|% [Oms-+inf]
Offnormal

00000h 00m 0032 [Oms-+inf]
00000h 00m 0032 [Oms-+inf]
[ toofinormal [#] toFault
Alarm Timestamps

Alarm Timestamps
+00000h 00m 17s

$parent.displayName$

g Refresh

A

E Save

@
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Property Value Meaning
Alarm inhibit True/false Alarm is activated / deactivated
Inhibit Time hours / minutes / Stages of the alarms

seconds
Alarm state - Fault - Fault: value is invalid e.g hardware fault

- offNormal - offNormal: value is valid but out of the its

- Normal borders

- Normal: value is valid and inside of the border.

Time Delay hours / minutes / Delay before alarm is generated

seconds
Time Delay To hours / minutes / Delay before alarm state goes away (if the alarm
Normal seconds in the corresponding device is already cleared)

Alarm Enable

ToOffNormal / To Fault

Enables the Alarm stages to be monitored

To Offnormal Times

Alarm Timestamp

The details of the last occurred offNormal alarm

To Fault Times

Alarm Timestamp

The details of the last occurred Fault alarm

Time in the Current

hours / minutes /

The elapsed time since the state was changed

state seconds
Source name Y%parent.display- It takes the name from the parent object name.
Name%

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG

Creating/Engineering a project

7. Set up additional parameters

Manual creation of data points

To Fault Text — Pump fault (it is unchecked, we do not have info if the value is reli-
able or not. If there is communication error between the Saia PCD® Supervisor and
the PCD device then the state will be different)

To Offnormal Text

To Normal Text

Offnormal Algorithm / Alarm value

Alarm Class

= Pump Error (this will be the alarm)

= Pump OK (text when the alarm leaves)
= true

= Critical Alarm class (created earlier)

Property Sheet

&7 Alarm (Alarm Source Ext)
== Alarm Inhibit
M Inhibit Time
W Alarm State
(Wl Time Delay
@ Time Delay To Normal
@ Alarm Enable
Ml To Offnormal Times
Ml To Fault Times
Wl Time In Current State

l Source Name

Ml To Fault Text

[l To Offnormal Text

@ To Normal Text

W Hyperlink Ord

@ sound File
W Alarm Icon

Ml Alarm Instructions

[l Fault Algorithm

Ml Offnormal Algorithm
[ Alarm Value

Ml Alarm Class

8 Meta Data

- {null}

00000h 00m 005 < [0ms-+inf]
Offnormal

00000h 00m 005 = [0ms-+inf]
00000k 00m 0032l [Oms-<inf]
[ toOffnormal [] toFault
Alarm Timestamps

Alarm Timestamps
+00000h 02m 10s

iparent.displayNames

Pump Fault
Pump Error
Pump Ok
null

» O-
null
null

O Instructions ))

Fault Algorithm
Boolean Change Of State Algorithm

. true

Critical Alarms

» O-

’ n

@ - (DefaultView) = P

.- )
-- )

D Save

G Refresh
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Property Value Meaning

To Fault Text Any text which refers to the state | User defined / can be seen in the Alarm Console

To Offnormal Text Any text which refers to the state | User defined / can be seen in the Alarm Console

To Normal Text Any text which refers to the state | User defined / can be seen in the Alarm Console

Hyperlink ORD ORD, BQL Query or path When an alarm is reported in the console, the Hy-
perlink button activates. Clicking this button links to
the location you specify here.

Sound File Path text Path of the sound file for audible alarm.

Alarm Icon Path text Path of the picture which is displayed in the "times-
tamp" column in the Console Recipient view.

Alarm Instructions | Instruction text It is possible to define instructions what tod when
alarm occurs.

Fault Algorithm Fault Algorithm Algorithm to generate alarm on Reliability of the
associated point. This property when available,
displays fault parameters. Different options are
available here, depending on the alarm extension
being used.

Offnormal Algo- Boolean Change Of State Algorithm of generating the alarm. Inside it is possi-

rithm Algorithm ble to set parameters to define the way of the alarm
generation

Alarm Class Any proper Alarm Class Which Alarm Class is used to collect the alarm

Meta Data Text Allows you to enter new facets for the extension.
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8. Open the Alarm console (double click on it).

It is possible to check the behavior of the Alarming of the
Points/Heating1/Supply/Pump point.

% Saia PCD® Supervisor

File Edit Search Bookmarks

Tools

Window

Alarm

Help

127.0.0.1 (Demo_Station) ¢ Station(Demo_Station)  © Config  © Services  : AlarmService  : AlarmConsoleSbus
- Nav 1 SBCAlarm Console
¥ O ) My Network Time Range o7 (D
Sy o sonst U2 gobalihoneyulL Timestamp Source State  Ack State Source Alarm Class Briority  Message Text

@ 127.0.0.1{Dema_station)
& station (Demo_station)

M 13-Apr-17 3:38:00 PM CEST

A 13-Apr-17 3:38:00 PM CEST

Offnarmal

Offnormal

1Acked/1Unacked 172.23.13.19:19/ myAlarmList/1

0Acked /1 Unacked

DefaultAlarm Class 255

DefaultAlarm Class 255

Errorin Pump Heating

A 172.23.13.19: 19/ myAlarmList /& Windowopen
© confie A 130017 3:36:27PMCEST  Normal 1Acked/1Unacked  172.23.13.19:19/myAlarmlist/2 DefoultAlarmClass 255 Shortairauit
@ services A 13-Apr173:36:20PMCEST  Normal OAcked/1Unacked |172.23.13.19:19/myAlarmList/3 DefaultalsrmClass 255 Powerbreskdown
O Aarmsenvice M 13-Apr172:3759PMCEST  Offnormal  OAcked /4 Unacked  Alarm CiiticalAlarms 255 Pump Ermor
A DefaultAlarm Class M 124pr172:43:20AMCEST  Offnormal  1Acked /0Unacked  172.23.13.19: 19/ myAlarmList /6 Default Alarm Class 255 Eroré
Critical Al
L B 12-4pr172:43:29AMCEST  Offnormal  1Acked/0Unacked  172.23.13.19:19/ myAlarmList/5 DefaultAlarm Class 255 General error
| Alarmcansolesbus

® BackupSenvice

@ categoryService
b @ sobservice

€D Roleservice

O userservice

® authenticationservice

LT Debugservice

® Boxservice

¥ FoxService

® HierarchyService

@ HistoryService

- Palette %]
W X 3 #odm

© alarmservice
A AlarmClass

£ AlarmClassFolder

© redipients
| consoleRecipient
£ StationRecipient

© extensions

© printerrecipients

Notes ‘ @ silence ‘ Y Filter ‘

a Acknowledge

B Hyperlink

When new alarm comes there is an audible sound to indicate it. This feature can
be deactivated with the Silence button.

The Alarm can be Acknowlwedged, the list is updated accordingly.
It is possible to add notes to the alarm stored in the Saia PCD® Supervisor.

Possible to define filter the Alarms, for example filter only the Alarms which is rele-
vant to the operator sitting front of the screen.
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6.2.6

6.2.6.1

Add History to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is a History Service which can be used to set history
log for individual datapoints.

For example the values of the Outside Air Temperature can be logged (history) then
later the logged values can be displayed as trend curve or just a plain text table with
the values in time order. It is also possible to export the values (in a defined time span)
to external file.

There is an other way of logging the history, which is described in details later in this
manual. The histories (called HD Logs) are generated in the PCD Device and the
Saia PCD Supervisor appends the content to history files located in the Saia PCD
Supervisor.

Steps to setup History for a datapoint in the Saia PCD® Supervisor

1. Check the History Service in the Services folder of the Station

<®» Saia PCD @ Supervisor

File Edit Search Bookmarks Tools Window  History Ext Manager Help

127.0.0.1 (Demao_Station) . Station (Demo_Station) ! Config I Services . HistoryService

- Nav History Ext Manager
E O @ My Network Point Extension History N
e Config
@ Services
o AlarmSenvice

@ BackupService

@ CategoryService

@ JobService

GJ RoleService

o UserService

ﬂ AuthenticationService
D DebugService

@ BoxService

v FoxService

@ HierarchyService

@ HistoryService

O suditHistoryService
o LogHistoryService

@ ProgramService

G SearchService

° TagDictionaryService
TemplateService

@ WebService

n Saia PG5 Data Import Wizard
T PlatformServices

6 Drivers
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2. Open the history Palette and copy the Numericlnterval extension to the datapoint
called Points/Heating1/Outside/Temperature/PhysVal.

In the pop-up window it is possible to rename the extension to a suitable name.
It is also possible to choose other type of history, for example Numeric COV or

Boolean Interval etc. Please check the different type of History Extensions in the
Niagara documentation.

File Edit Search Bookmarks Tools Window  History Ext Manager Help

127.0.0.1 (Demo_Station) ~ : Station (Demo_Station)  © Config @ Services  : HistoryService

- Nav [ Zal History Ext Manager

¥ O (&) My Network Point Extension History Name Statul
X TuningPolicies
@ Devicel

© Alarm Sourcz Info
[+ Datapoints Poll scheduler
& points
A Heatingy
Qs
A opMode
H outside
Al Temperature
© Physval
& ot
A Return
A supply
E Pump T
Q@ alarm
I oK | _caneet |
b7 alarm
@ Feedback
@ MotorProtection

- Palette
W X T | sy

B Historyservice

© AuditHistaryService

© LogHistoryService

© HistoryPointList

CJ HistoryPointListitem

© extensions
[ numericinterval
[F numericcov
[F Bocleaninterval
[F Bacleancov
[F Enuminterval
[F Enumcov
[F stringinterval
[F stringtov

@ History Group

N History Nav Shortcuts

@ Name X
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3. setup the parameters of the Numericlnterval extension.

Enabled = True

History name =
%parent.name%

Interval =1 min

Y%parent.parent.parent.name%_%parent.parent.name%__

<# Saia PCD'® Supervisor

File Edit Search  Bookmarks

127.0.0.1 (Demo_Station)

@ My Network

: Station [Demo_Station)

Tools  Window

Help

I Drivers

: Config

1=y Alarms
@ Histories

E Device Information
Q Alarms Poll Frequency

Q) Pseudo_Points

) sacnethietwork
ADDS
Q) schematics
B Files
@ Hierarchy
) History
; Demo_Station
A nuditHistory
A LogHistory

A\ Outside_Temperature_Physval

- Palette
w X B #§ history

@ Historyservice
° AuditHistoryService
o LogHistoryService
Q HistoryPointList
[ HistoryPaintListitem
Q) Bxdensions
[ numericinterval
[3 numericcov

[2 Booleaninterval

: SBCSystems @ SBCIpNetwork_Demo : Devicel  : Points  : Heatingl  : Outside
Property Sheet
[Z Numericinterval (Numeric Interval History Ext)
[ status {ok}
M Fault Cause
(M Enabled @ true

Daysof week [#] Sun [# Mon [# Tue [ Wed [ Thu [# Fri [ sat

TimeRange |12:00:00 M CEST 2 to |12:00:00 M CEST |2

@ true

$parent.parent.parent.nane_tparent.parer (3)

(@ Active Period
[ Active
l—‘. History Name

(W History Config Interval: 15mins, Record Type: numerict...

[ 1d /Demo_Station/Qutside_Temperature_PhysVal
I—i Source station:|slot:/Drivers/SBC¢20Systems,/SBCIpNetwork |
[ Time Zone Europe/Berlin (+1/+2)

(@ Record Type history NumericTrendRecord

(W Capacity Record Count 500 [0- max] recards
(@l Full Policy Roll

[ Interval regular +00000h 15m 00s

m System Tags

[l minRollovervalue null |0.00

[l maxRollovervalue null 0.00

[ precision 32bit

units="C,precision=3 *C,min=-inf *C,max=+inf *C >) ’7_-) #*

[ Hidden

[ valueFacets
12-Jun-2017 03:15 PM CEST
00000h 15m 00s5|% [Lms-+inf]

(M Last Record 0.00
(@ Interval
32bit
 null
& null 0.00

(@ Precision
(@ Min Rollover value 0.00

@ Max Rollover Value

Property

Value

Meaning

Status

Enabled/Disabled

Show if the history is enable or not. It is always dis-
abled after configuration. The user has to enable it.

Fault Cause

Any kind of system
generated fault

Error occurred during History creation. For example
the name of the history is too long (more than 67
chars)

Enabled true / false Switch to Enable / Disable the history of that point
Active period Days of Week / Possible to schedule when the historization of that
Time range datapoint should be switched on

History name

Defined name of
the history

It is possible to give name to the history or generate
the name from the datatpoint name.

For example:
%parent.parent.parent.name%_%parent.parent.
name%_%parent.name%

will generate the following name
Outside_Temperature_PhysVal

History Config ..

Summarized set-
tings of the History

It is possible to navigate one step down and modify the
settings in detail.

.. 1D

ID of the History

Generated by the system, should be unique.

.. Source

Source of the
History

The full ORD of the history.
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.. Time Zone Time zone The configured time zone of the PC where the
Saia PCD® Supervisor is running

.. Record type Record type It is preconfigured in the Palette / Extensions

.. Capacity Record count / The number of the records allowed to create / unlim-

Unlimited ited. It depends where the History is created. Limit-
ed size of memory device can be used to store the
History.

.. Fill policy Roll/Stop Roll — the oldest history will be overwritten with the
newest log
Stop — when the record count is reached the logging is
stopped

.. Interval Interval of the It is possible to setup the interval between two logs

logging creation.

.. System Tags e.g.: NorthAmerica; | This property allows you to assign additional metadata

Region1; Cities. (the System Tag) to a history extension. n

.. minRolloverValue | number It takes over the settings from the same property
below.

.. maxRolloverValue | number It takes over the settings from the same property
below.

.. precision 32 bit / 64 bit It takes over the settings from the same property
below.

.. valueFacets e.g.: units, pre- Facets contain additional data applied to input and

cision, min, and output values.
max.

Last Record Date and time The date and time of the last value is stored.

Interval Interval of the Same as above: It is possible to setup the interval

logging between two logs creation.

Precision 32 bit / 64 bit The same as above: Precision of the floating point
value which is used for that history.

Min Rollover Value | number Related parameter for "Delta" logging for e.g. electric
consumption for displaying the difference not the abso-
lute value. It is valid for NumericChangeOf Value and
for Numeric Interval. See Niagara documentation.

Max Rollover Value | number Related parameter for "Delta" logging for e.g. electric
consumption for displaying the difference not the abso-
lute value. It is valid for NumericChangeOf Value and
for Numeric Interval. See Niagara documentation.

4. Save the settings
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5. The following History is created

> Saia PCD® Supervisor

File  Edit Search Bookmarks Tools Window

Help

4 O- o O i & -

127.0.0.1 (Demo_Station) . Station (Demo_Station) 2 . Demo_Station
- Nav
O | ) My Network

b @ My Host: SZ43LTI0EGWF2.global.ds.honeywell.com
v (@ 127.0.0.1 {Demo_Station)
v ” Station (Demo_Station)

! Alarm
b e Config

] e Files
b E Hierarchy
v D History
-
* g Demo_Station
A ruditHistory
.‘ LogHistory
A\ outside_Temperature_Physval

6. Double click to the name of the History
The Chart of the logged values will be opened.

Additional features can be checked in the Niagara documentation.

ou vl
B ® B Today @QaABOOo Lo
Outside_Temperature_PhysVal @ Outside_Temperature_PhysVal

4.000

3.000

2.000

A outside_Temperature._Physval

1.000

000 &

-1.000

2000

-3.000

3:34
61122017 pin

5
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Using the “Saia PG5 Data Import Wizard”

The import wizard an offline add-on tool to import the symbols from one or more Saia
PCD device(s) to the Saia PCD® Supervisor point database. The Import Wizard is in-
tegrated into the Saia PCD® Supervisor (it is not a standalone tool). The Import Wizard
gives the possibility to import the “symbols” from one or more SBC PG5 project, which
can content of course many PCD devices per each.

The symbols, to be imported, can be filtered by type, by name.

The symbols can be re-imported any time or after modification has been done in the
PG5 project. User can decide if the imported symbols are overwriting the points in the
Saia PCD® Supervisor, or not.

The import procedure can be cancelled and new-started any time.

During import an error check is done, which ensures that only the good formed sym-
bols are imported. The absolute necessity of using unique point names are ensured
through the PG5 symbol table. The PG5 project can be buildable if the symbol table is
correct. The downloaded PG5 program and the Saia PCD® Supervisor imported points-
must be all the time consistent.

When symbols from multi project are imported the System Integrator must make him-
self sure, that there no the very same named symbols (points) are getting imported.
For example there are two PG5 project created, one is called Building_A and the other
Building_B. Inside of both projects there are PCD devices called CPU1, CPU2, CPU3.
This happens because the Building_B project is just a copy of Building_A project. Let
us assume that the Building_A project has been already done. During import of the
Building_B project e.g. the CPU1 symbols from Building_A are getting overwritten while
the symbol name structure are the same in both projects. To avoid such a situation it is
recommended to have a unique ID for each PCD device in the projects to be imported.
Or use dedicated “Saia Burgess Controls Driver” for each PG5 project.

The points in the Saia PCD® Supervisor point database are structured hierarchically ac-
cording to the symbol groups in the symbol table of PG5 project.

The following different type of symbols and other information/data can be imported from
a PG5 project to the Saia PCD® Supervisor point database.

1. PG5 symbols or datapoints
2. Alarm list generated in the PG5 project

3. Historically logged data so called HD Logs.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC Suite based
alarms are not supported. Before importing the Alarm list and the HD Logs the web
project in the Web-Editor 8 must be compiled. Take care to select the language for the
Alarm list before compile in the Web-Editor 8. The up to date configuration files (csv
files) must be available for import.
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6.3.1 Important information about import wizard process
in Saia PCD Supervisor 2.1

Prior to version 2.1, projects were imported in Saia PCD Supervisor by using CPU
device name as slot in the ORD path from the PG5 project. This could cause an issue
when importing device with the same CPU device name from different PG5 project into
the same SBC supervisor station where unique name are required.

Slot Sheet Szzgggis’_’&

= splav : Project Tree - -
Slot Name Display Name ; Proj — : 6 Device Propertles e
Project 'DDC Suite 27 ML - 1

O Property 16 S$398520AllS20FBoxes 98 All FBoxes 2 Properties
88 TCP/IP Settings Table Device Name:

#0 Common Files
8 Library Manager 98 All FBoxes

38 98 All FBoxes - PCD3.M6860 -
B DE_G01_RO1 - PCD3MSS60 - 192.168.10.71, 5-Bus Stn 72

With the current newer version Saia PCD Supervisor 2.1 the PG5 import wizard pro-
cess apply a rule to compare the CPU device name and IP-Address as configured in
PG5 device configuration. During the import process the device will be now mapped
within the SbclpNetwork applying a unique name conversion through SbcHeadstation
or SbcSupstation appending to that a suffix number.

Slot Sheet 4 TCP/IP
Channel Number 9
Slot # Name Display Name TCP/IP Enabled Yes
O Property 13 SbcHeadStation FR_BO1_LO1 Ethernet RIO Network None
IP Address 192.168.10.71
O Property 14 SbcHeadStation1 DE_BO01_LO1
O Property 15 SbcHeadStation2 98 All FBoxes

In case customers require to still use the old naming convention, we recommend
performing that via Rename feature. The system as it is designed now will resolve the
unique address by suing, as explained above, the combined reference of IP address
and device name, independently from the name.

6 SBCIpNetwork > Rename @ > Rename @ v
I Tuning Policies @ @ oe_so1_toil
@ FrR_B01_LO1 ok | cancel ok | concel

@ DE_Bo1_L01
@ 938 AllFBoxes

Views

Actions

Rename

For further detailed information please refer to the Saia PCD Supervisor manual or
contact SBC technical support to get additional support.
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6.3.2 Preparation

For importing the Symbols from PG5 project we need to use the Saia PG5 Data Import
Wizard tool.

The “Saia PG5 Data Import Wizard” is installed together with Saia PCD® Supervisor.

- Nav %]
¥ C ) My Network

@ My Host: SZA3LTJ0EGWF2.global.ds.honeywell.com
(@ 127.0.0.1 (Demo_Station)
# Station (Demo_Station)
‘ Alarm

e Config
@ Services
° AlarmService

@ BackupService
@ CategoryService
@ JobService
m RoleService
o UserService
O AuthenticationService
D-’ DebugService
@ BoxService
v FoxService
@ HierarchyService
@ HistoryService
° AuditHistoryService
O LogHistoryService
@ Programservice
Q SearchService
o TagDictionaryService
TemplateService
WebService
T PlatformServices
n Saia PG5 Data Import Wizard
6 Drivers
6 NiagaraMetwork
© sBCsystems
Apps
Q Files
- Palette
] E E i sbcofflineEngineering

n Saia PGS Data Import Wizard

It is a fact that the PG5 project (the program of the PCD controller) — from where the
symbols, to be imported - is developed in a completely different tool, and this tool is not
integrated presently in any way into the Saia PCD® Supervisor. Due to this fact at the
beginning the Saia PCD® Supervisor has no information about the PG5 project and its
symbols.

It is needed to copy the actual up to date and compiled PG5 project under to the Sta-
tion where it will be used.
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Typical shared folder of a station would be like this:

C:\ProgramData\Niagara4.7\SBC\stations\Demo_ Station\shared

So the complete PG5 project has to be copied there.

ERE - * [ 119 = | shared i - o x
Home  Share  View (] Home  Share  View (2]

=1 cut LN Open ~ Selectall Ccut R T New item ~ Open Selectall
B0z « B X = Sl o= B E| X = v -
2 Copy path - E Select none Copy path £ basyaccess - £ Select none
PintoQuick Copy Paste Move Copy Delete Rename  New Properties Pinto Quick Copy Paste ove Copy  Delete Rename  New Properties
SR, [£] Pastesnortee (R ol RO o PErties 12 History | B invert selection o [ Paste shorteut 4 i el Perties g tistory | @ invert selection
« « 4 [ > ThisPC » OSDISK(C) > 00.SBC > 10_PG5 Projects » PGSV2.22x > Projects vl serchpiecs o | € v 4[]« OSDISK(C) > ProgramData > Niagarad3 > SBC > stations > Searchshared P
b Music A Neme Dat Type Size A A Name Size
Projects ke File Folder
(=] Pictures . u - o ) DDC Suite 27 EN Template Master
B videos rojec e older o
Project? 1 File Folder d
L. 0SDISK(C) . NAY
Projects T File Folder o 5
= EB14666 (\SZA3WO0D 1\Users) (P:) Projects 17 File folder onne >
| = ryTransfer (WSZ43W0OOT) ( Projecti0 17 File older B Pictures P g
= s (WSZAWODOT) (5) Saia_PCD_Supenvisor_Shus_Demo R File fold v resources
- [ Videos Saia_PCD_Supervisor_Sbus_Demo_HC
= PROJECTS (\SZ4W0001) (¥) i PCD._ i Filefolder T GRS
Samples r File Folder = Customize this folder
= Departments (\\SZ43W0001) (Z)) e
Test PR_registers i File Folder B ERIASEE ONZ AW () o
| & Network W, Statont2 4 e | = TemporaryTranster szaswooon ¢ T
v > = Applications (\SZ4WOOOT) (5) v
| = ep) o M5} Undo Copy Ctiz
| 2sitems 1 item selected [Ze] 7ems

The copy procedure has to be repeated at each time when modification was made.
(When compile of the PG5 project was happened, so the content of the symbol table
could have been changed).

Naturally when the symbol table is changed, it is necessary to re-import the symbols
from the PG5 project to the Saia PCD® Supervisor point database.

During new import the Saia PG5 Data Import Wizard will retain all user defined con-
figuration of a datapoint, except memory address and comment. User can choose to
overwrite comment or address&comment during the process.
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6.3.3 Importing symbols from PG5 projects

For importing symbols from the PG5 project the “Saia PG5 Data Import Wizard” has to
be started. This tool will do an offline symbol import. When the symbols are imported to
Saia PCD® Supervisor then we can call them "Points". Discovery of the symbols in the
Saia PCD device and do online symbol import is not possible.

1. Double click to the Saia PG5 Data Import Wizard under the currently used Sta-
tion. The Wizard opens.

At the beginning nothing is selected.

127,001 (Demo Station) : Station (Demo_Station] Contie jes « 7 SoiaPGs Datalmport Wizard +
- Nav @ ,
) syvenii Saia PG5® Data Import Wizard
e Leom

Scan Datapoints Alorm List HD Logs Import Finish

Choose the project to import data

null File

FEnable all
Datapoints
Alarm List
HD Logs

Li0oD0000006«@OL00O006G0

stems
© ops
©ries
~ Palette 2]
® (X O |@§ beofincingnesnng

So12 G5 ata mportwizard 3
a = Cancel

2. Chose the right PG5 project. Click to the “File” button and select the PG5 pro-
ject file of the project copied to the shared folder of the Station. Press OK.

D Saia PCD Supervisor Sbus Demo HC.saia5pj

file:"Sata PCD_Supervisor_Sbus Demo HC/Saia PCD_Supervisor_Sbus Dem

[l Station
© Config
@ Files
Q px
D resources
Q Saia_PCD_Supervisor_Sbus_Demo_HC
Q© CPUOOL
Q Libs
O _lastopen
» [0 Saia_PCD_Supervisor_Shus_Demo_HC.saia5pj

OK Cancel
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3. Check the datapoints and press Scan

Saia PG5® Data Import Wizard

Scan Datapoints Alarmlists HD Logs Tmport Finish

Choose the project file (.saiaSpi) to import data

file:"Saia_PCD_Supervisor_Sbus_Demo_HC/Saia_PCD_Supervisor_Sbt File

Enable all
¥ Datapoints
Alarmlists
HD Logs

n At this window press Proceed

Verify Code Page

Code Page

1252 : Western European (Windows) Revert to Auto Detected

Data Point Sample Text

Code page detected from PG5 project

PROCEED CANCEL

n It is possible but please try to avoid accented or special characters.
Not supported characters $,# and %.

For others proper code page has to be selected then they are cor-
rectly visible.

4. The amount of the possible symbols are calculated. Press Next.

Saia PG5® Data Tmport Wizard

atapoints Alarmlists HD Logs Tmport Finish

Scanning complete

0 0

Datapoints Alarmlists HD Logs
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5. The symbol list is populated.

Saia PG5® Data Import Wizard
4 5 6 7
Data Points Alarm HD Logs Import Finish
|
Choose datapoints to import
Device count: 1 Y Datapoints count: 219 Selected Poimts: 15
Device Point Name Media ~ Point Name Device
~ CPUODL
A A Alatm myAlarmList Flags F Hetig AT cPU0OL
armiing A Alarm myAlarmList Handl R
larm myAlarmList Handle
EDL"E 1 Heating] OpMode Day CcPU0NL
IOE"““E A Alarm myAlarmList MyName TEX
s AHDLog DateTime Day R Heating] OpMode HeatPeriod €PU0N1
3
Web AHDLog DateTime HMSM B Heating Outside. Temperature PhysVal CPU0O1
A HDLog DateTime Millisecond R
Heating] Return Temperature PhysVal cPU0O1
A HDLog DateTime Month R
AHDLog DateTime. YMD R Heating] Return Valve ThreePoint_close €PU0N1
Back Next Reset Selection

The top of the Wizard window can be seen that the procedure is at the stage of
datapoints.

Alarm Tist HD Logs Tmport Finish

The left side of the Wizard window the found Devices with the symbol groups
of the selected device. There is also a filter icon which pops up the possible
filter settings.

Device count: 1 Y

Device

A
Alarming
HDLog
Heating1
10

S

s
Web
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In the middle of the Wizard window the symbols are shown with full names and
details. It is possible to zoom the window by clicking the icon at the right top-
most corner.

Datapoints count: 219 =

Point Name Media Type Memory Address Data Format Comment

A Alarm myAlarmList Flags F 6166 Boolean = Alammflags
A Alarm myAlarmList Handle R 2175 Signed Int M Handle-ID
A Alarm myAlarmList MyName TEXT 3000 String = Name of list
A HDLog DateTime Day R 2334 Signed Int - Day
A HDLog DateTime HMSM R 2335 Signed Int = Hours/Minutes/S. ..
A HDLog DateTime Millisecond R 2336 Signed Int = Milliseconds
A HDLog DateTime Month R 2337 Signed Int = Month
A HDLog DateTime Sec1970 R 2338 Signed Int = Seconds since 1970
A HDLog DateTime. Week R 2339 Signed Int M Week of year
A HDLog DateTime.Year R 2340 Signed Int = Year
A HDLog DateTime YMD R 2341 Signed Int = Year/MonthDay

The symbols can be selected one by one by checking the checkbox beside the
symbol. Or at the top beside the Point Name by checking the checkbox all the
symbols are getting selected in the actual group.

The Data Format can be changed per Points. For example, when Register is
the data type from the PG5 project the format of the data in the register can be
Signed / Unsigned Integer or Motorola / IEEE float.

6. The right side of the Wizard window shows those symbols which are selected
therefore are getting imported. This window can also be zoomed. Beside the
symbol the big X icon is used to remove the symbol from the selection.

Selected Points: 3

Point Name Device

Heatingl Ack CPUO01
Heatingl OpMode Day CPUO01
Heatingl OpMode HeatPeriod CPU001
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7. Because in the middle window of the wizard shows all the symbols the System
integrator has to be able to select the symbols which are needed to be import-
ed. Filter can be defined, so only the interesting symbols will be shown.

Filter Data Points by X

Select All
v Registers
¥ Flags

Counters
I/'Os
Timers
DB

Text

Hide Data Points Starting with

A S 10 s

RESTORE DEFAULTS APPLY n

It is possible to select the type of the symbols to be filtered.

Or it is possible to define symbol groups not to be displayed. For that user must
click to the + icon at the right side of the list and define the Group name (e.g.
Web). There are some default symbol groups predefined.

Filter Data Points by x

Select All
M Registers
M Flags

Counters
10s
Timers
DB
Text

Hide Data Points Starting with
A S o] s

Web|

RESTORE DEFAULTS APPLY

Click to Apply to make the filter settings effective.

Device count: 1 Y Datapoints count: 2 E Selected Points: 17 E
Device v Point Name Media Type Point Name Device
CPU00L
A v Web HMS R
Alarming Heating1 Supply Pump Alarm CPU001
HDILog v Web YMD R
Heatingl Heating] Supply Pump Feedback CPU001
10
s Heating] Supply Pump MotorProtection CPU0O01
s
:
= Heating] Supply Pump Output CPU001
Heating1.Supply. Temperature PhysVal CPU001
Heatingl.Supply. Temperature. SetPt CPU001
Web HMS CPU00L
Web. YMD CPU00L
Back Next Reset Selection

Or you can Restore Defaults settings when it is needed.

8. We need the symbols from the Heating1 group and also from the Web group.
Select them and press the Next.
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9. Pop-up window is displayed to warn you to overwrite or not the datapoint (the
first one in the list).

It is possible to select the action for the remaining conflicts of the point data-
base.

Check the “Do this for all conflicts” and press Overwrite.

Presently it works this way

- Overwrite = it overwrites the addresses and also the comments

- Skip = it overwrites the addresses only

n Cnnf]rm

Do you want to overwrite datapoint (EnTrend) for the device (CPU001) duning import 1f exists?
OVERWRITE - Overwrite Memory Address & Comments
SKIP - Skip Comments only

Do this for all conflicts

Overwrite Skip

user defined configuration of a datapoint, except memory address and
comment.

n During new import the Saia PG5 Data Import Wizard will retain all
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10. The SBCIpNetwork driver folder is automatically generated under the Drivers
folder of the Station. The datapoints were imported to the Points folder of the
SBClpNetwork driver. The datapoints are hierarchically structured as they are
in the PG5 symbol table. The main folder of the Points are named according to
the Device name in the PG5 project.

PCD device name can be the same in different PG5 Projects. Take
care of it and make it sure that the imported Device names are unique

in the Saia PCD®Supervisor.

The Import Wizard always put the points in the SBCIpNetwork folder.
This folder can be renamed. The next import then will be done to the
renamed folder. The target folder of the import can not be freely cho-

sen.

- Mav

@ Apps
e Files

E@ O @ My Network

@ HierarchyService

@ HistoryService

o AuditHistoryService

o LogHistoryService

@ ProgramService

0 SearchService

° TagDictionaryService

TemplateService

@ WebService

T PlatformServices

n Saia PG5 Data Import Wizard
e Drivers

e NiagaraMetwork

Q) sBC systems

6 SBClpNetwork_Demo

x Tuning Policies

 sBCIpNetwork

:‘ TuningPolicies

@ cruont

o}ﬂarm Source Info
i!— Poll Scheduler
e Points
=] Heatingl
o Ack
A opMode
H cutside
3 Retumn
A supply
H web
@ Alarms
@ Histories
. Device Information

“ Data Poll Frequency
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6-52

11.

It can happen that the generated structure is not fitting to the predefined struc-
ture of the Saia PCD® Supervisor.

Then it is possible to move the points to an other “SBClpNetwork” with simple

cut and paste action.

© AuditHistoryService
© Loghistoryservice

Relation Mark

PEE Rename

The not used “SBCIpNetwork” then can be deleted.

TemplateService
® Webservice

T Platiormservices

Y soiapGs ataimportWizsrd

O saesystems
© sscipNetwork_Demd

Paste

§ Paste Special

8 Duplicate

u
Delete

Link Mark

Relation Mark

Rename

It is also possible to rename the element of the folder structure. It makes
mainly sense to rename the PCD Device (the top folder). The folders under are
having the right names since the PG5 project is also built up with structured
symbol names. Let us rename it to “Device1”

Duplicate
Delete

@ aops
@ Files
(&) Hierarchy
@ History Rename

Set Display Name

Presently the Saia PG5 Data Import Wizard is not capable to follow up
the Folder structure changes. So at the next import it will again import

the symbols under the SBCIpNetwork under Drivers.
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12. During the import a Conversion with factor 0.1 is applied automatically to
every Registers which has data type Signed or Unsigned Integer. This con-
version is used because the numbers in the Registers of the PCD device are
usually multiplied with 10. This multiplication is a kind of standard conven-
tion in case of Building Automation Projects. Of course the conversion can be
removed or modified by hand. For example, we need to modify the conversion
when we are working with time values. Then the division between minutes and
seconds would be 60.

figuration of a datapoint, except memory address and comment. User can choose to

n During new import the Saia PG5 Data Import Wizard will retain all user defined con-
overwrite comment or skip during the process.
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6.3.3.1 Properties of an imported datapoint

It can be seen in the AX Property Sheet of the datapoint that, there are many properties
available.

We already touched the “Conversion”.
In this chapter the others will shortly be described.
Let us double click to symbol which is “Numeric Variable” type.

For example:Device1/Points/Heating1/.Outside/Temperature/PhysVal.

n The AX property Sheet will come up because this is the associated page (default by the
system, but changeable) to the datapoints.

- Nav Property Sheet
|=o o @M\,'Network © Physval (Numeric Writable)
é . Faceis units=null,precision=1,min=-inf,max==inf )) ’9 -
WebService
Proxy Ext SBCProxyExt
T PlatformServices f:—f . o =y
UMl Status {ok}
n Saia PG5 Data Import Wizard .
e Ll Fault Cause
Drivers
[l Enabled true
e NiagaraNetwork u .
© sBC systems [Ml Device Facets » o -
6 seCipetwork_Demo T8 Conversion [ Linear Scale 0.1 Offset 0.0
X TuningPolicies Ml Tuning Policy Name  |Default Policy
© pevicer Read Value -133.00 {ok}
© alarm sourceinfo Write Value - {null} @ def
E¢ Pollscheduler Ml Memory Address 102
[~ —
& Foints [l Data Format Signed Int
A Heatingl
° & out -13.3 {ok} @ def
Ack
m| In1 - {null}
OpMode
a In2 — oo ¥
Day
e i In3 - {null} ¥
HeatPeriod
. In4 - {null} ¥
Outside
In5 — [null} F
[ =] Temperature
o Ing - {null} ¥
Physval
M| L In7 - {null} ¥
Return
In8 — {null}
(=] Temperature
6 In9 - {null} ¥
Physval
! In10 - (nu11 s
[2: ]
Valve
o In11 — {null} ¥
PI_Signal
° - In12 — o T
signal
: In13 - (nu11 ¥
G ThreePoint_clo:
In14 — [null} ¥
° ThreePoint_op
- In15 - {null} ¥
Suppl;
PRy In16 - (nu11y ¥
[2: ]
Web
Fallback - {null} ¥
@Alarms e =
[ Override Expiration  |mull
® P
Histories =
= \l Media Type Register
Ll Device Information —
ll Comments Actual physical value outside air temperi
Q Data Poll Frequency
- U 1con module://sbc/resources/images/register.png
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Short description of the properties (top to down, row by row):

1. Name of without group structure and the type in bracket. The type of the
the data- datapoint is determined by the Saia PG5 Data Import Wizard dur-
point ing import. (changeable)

2. Facets This property allows you to configure how the value of the compo-

nent is displayed. For example, on a Numeric Writable component
you can set the units, precision, minimum and maximum value for
the Out property value.

In case of the example we can use the following settings. We use

three decimal precision. The “-inf and +inf” are the +/- infinity. As

it is a measurement which comes from the PCD controller we do

not need to set min and max. But for a writable parameter for a n
setpoint or for an output it makes sense to define the min / max

parameter in order to ensure the operator typed value never goes

out of its borders (e.g. by misstyping). The engineering unit can

also be selected.

Property Sheet
© Physval (Numeric Writable)
(gl Facets units="C,precision=3 *C,min=-inf *C,max==inf*c | ¥ | D -
[ Proxy Ext SBCProxyExt
[ status {ok} -
@ Fault Cause
[ v vp B
(W Enabled @ e e Type ik
- units Unit G
! Device Facets 9 -
- o » 9 precision Integer 3
[ " %
(@l conversion A Linear Scale 0.1 Offset 0.0 = ST T
Ul Tuning Policy Name  Default Policy o Double Int
Read Value -133.00 {ok}
Write Value - {mull} @ def
[l Memory Address 102 ﬂﬁg
[l Data Format signed Int oK e
out -13.300 °C [ok] B def
In1 - {null} . x
In2 ~ [nal1} ¥
= = p temperature (K) celsius () o -
in4 - {null} ¥ 0K Cancel
In5 ~ (nm1} ¥

Unfortunately the Facets settings are not set automati-

ﬂ cally for the imported points. This means that the Facets
parameters must be set for every each imported points
manually.
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3. ProxyExt We use in the Saia PCD® Supervisor so called Proxy Points (this is
a feature of the Niagara framework). The function of the Proxy Point
is to show the values of the symbols from different controllers in a
uniformed way. The Proxy Points then are behaving in the same
way inside of the Saia PCD® Supervisor regardless if they come
from a Saia PCD controller or from a third party device.

1. Status {ok} communicating and ok
{fault} communicating but the value is
not correct
{down} no communication
{disabled} pointis disabled
{stale} the value of the point is not

n trustworthy

2. Fault cause Possible cause of the fault

3. Enabled Enable / Disable the communication of this
datapoint (Save it if modified)

4. Device In cases for drivers that support a “Dis-
Facets covery” mechanism, a proxy point may be
created with its facets (units) already de-
fined—these reflect its “Device Facets” (in
its ProxyExt). Not applicable for Saia PCD
Devices due to no discovery.

5. Conversion (Type, Scale and Offset): the raw value
comes from the PCD controller can be con-
verted using different mathematical transfor-

mation.
6. Tuning If other tuning policy has been defined it can
Policy be selected here. The Tuning Policy is used

to define how frequently the datapoint is
communicated.

7. Read Value Value from the controller as it is.

8. Write Value The type of the datapoint is Numeric Writ-
able. So it possible to write back value to
the PCD Controller. Because the connected
variable in the PCD controller is a freely
readable and writable Register. Other hand
it can happen the user program in the PCD
controller s just cyclically overwriting this
Register.

9. Memory The address of the memory slot in the PCD
Address controller to communicate with.

10. Data Format How the value is represented in the memory
slot in the PCD controller.
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4. Out

5. In1toIn16

6. Fallback

7. Override
Expiration

8. Media Type

9. Comments

10. lcon

Using the “Saia PG5 Data Import Wizard”

This is the value which can be visible in the Saia PCD® Supervisor
and be used/connected to other place (e.g. creating logic in the
Wire Sheet’

These are inputs of this Proxy Point, if we see it as a Function
box. The inputs can be connected to somewhere to get values or
it is possible to define the value directly. There is a defined prior-
ity between the inputs (lowest In16). The values of the inputs can
be enabled / disabled with checking the checkbox “null”. Then the
values which is the highest priority will be downloaded to the PCD
controller.

. Property Sheet
Wire Sheet =
fassisssntn ) Physval (NumericWritable]
[ Facets Units="C,precision=3 “C,min=-inf ‘Cmax==inf'cC » D -
ey [F Proxy Ext SBCProxyExt

Eumeri::'i’ritah [ Status tox]
Qut -13.300 °C {ok @ (@l Fault Cause
Ini - {rull] [ Enabled @ true
Im2 32,000 °C {ok K
= 2 I_{u“} [l Device Facets » O-
Ina - [rull}] (@ Conversion [ Linear Scale 0.1 Offset|0.0
In5 - {null} [l Tuning Policy Name  Default Policy
Ing - [l Read Value -133.00 {ok}
:g '{:::} Write Value 320.00 {ok} @ 2
In2 —{rull} :. Memory Address 102
Inid {1} [ Data Format signed Int
Inii - [rull] out -13.300 °C {ok} @ 2
Ini2 = {mull} In1 - fnull}
et null 2 32.000 °C {ok} ES
Inig - {mull} e [ null |32.000 e
In15 {rull}]

- {mil} ¥
Inig = [mull}} 8 P
Fallback —{rull} na E14- D0CEECHlok )

O null [274.000 €

- {mil} ¥

When any of the Input are not applied the Fallback value is ap-
plied.

It is possible to command Permanent or Time-duration bound
override. When Time bound override is applied, then the Override
Expiration shows the time and date when the override goes back
to Auto automatically.

The type of the memory slot in the PCD controller. Needed for the
correct communication.

Imported comment from the PG5 project.

Internal picture associated to this type of variable.

Certainly the other type of datapoints have a bit different looking Property Sheets. | do
not describe every each of them. To get familiar with them needs self-study and read-

ing the manuals.
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6.3.4 Alarming
Importing Alarm list generated in the PG5 project
There are at least two possible ways to handle the Alarms in the Saia PCD® Supervisor.

1. The Alarms are generated in the PCD controller. They are organized to a memory
territory, with Alarm text, time stamp, status (Acknowledged, Deleted, New, etc.)
and comment. This information can be then imported to Saia PCD® Supervisor.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC
n Suite based alarms are not supported. Before importing the Alarm list and
the HD Logs the web project in the Web-Editor 8 must be compiled. Take
care to select the language for the Alarm list before compile in the Web-
n Editor 8. The up to date configuration files (csv files) must be available for
import.

2. In the Saia PCD® Supervisor there is alarm service which can be used to set
Alarms for individual datapoints, regardless if the datapoint is considered alarm or
not at the start of the engineering. For example the Outside air temperature can
generate an alarm when it is crossing the -20°C. For that we need to set monitoring
of this temperature in the Saia PCD® Supervisor. So the Alarm is generated in the
Saia PCD® Supervisor not in the PCD controller. Therefore this alarm can not be
seen for example in the SWeb application.

Here in this chapter we will see how to import the Alarm list form the PCD controller.
1. The Saia PG5 Data Import Wizard must be started.
2. The right PG5 project file must be selected in the File edit field.
3. Check the Alarm List checkbox

Saia PG5® Data Import Wizard

Choose the projeet filc (saia5pi) to import data

file:"Saia_PCD_Supervisor_Sbus_Demo_HC/Saia_PCD_Supervisor_Sbt File

Enable all

Datapoints

v Alarmlists
HD Logs
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4. Press Scan. The Alarm list of the selected PG5 project is being scanned.

Saia PG5® Data Import Wizard
3 4 - 6 7
Data Points Alarm HD Logs Import Finish
Scanning complete
0 0
Datapoints Alarm List HD Logs
Back Next

5. Select the Alarm list to be imported. n

Choose Alarmlist to import

Device count: 1 Alarmlist count: 1 Selected Alarmlists: 1
Device % Alarm List Alarm Type  DE EN PR Alarm List Device Language
v A Alarm myAlarmList MyName 1 ”
=T y y A Alarm myAlarmList . CPU001

Vizualisation

Back Next Reset Selection

6. If the Alarm list is generated with more languages then select the required languge.

Choose Alarmlist to import

Device couat: 1 Alarmlist count: 1 Selected Alarmlists: 1
Device v Alarm List Alarm Type  DE EN R Alarm List Device Language
V) AAlarmmyAlarmList MyName 1 O A Alarm myAlarmList... CPUO0L EN

~ CPU00L

Vizualisation

Back Next Reset Selecti

7. Press Next. And confirm to overwrite the Alarmlist.

Overwrite Alarmlist (A Alarm myAlarmList MyName) for the device (CPU001) during import if exists?

¥ Do this for all conflicts

OVERWRITE SKIP
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8. The Import is running

Data import s in progress, this wil take a while

00of0 1of1 0o0f0
0% 100% 0%
Datapoints Alam List HD Logs

n Import is ready. The details can be checked under the Device/Alarms folder.

More details are not available.

™ Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

127.0.0.1 (Demo_Station) . Station (Demo_Station) I Config . Drivers . SBClpNetwork : CPUOD1 o Alarms o Aualarm.myAlarmList.MyName
* Nav Property Sheet
K O () My Network © Aalarm.myAlarmList.MyName (SBCAlarmlList)
ﬁ Alarm List Name myAlarmList
g @ My Host : SZ43LTJ06GWF2.global.dz.haneywell.com E Alarm List Number 0
» (@ 127.0.0.1{Demo,_station) (@ Memory Address 3000
# Station (Demo_Station) m Language EN
‘. Alarm
a Config
@ Services
v e Drivers
6 NiagaraMetwork
» () sBCsystems

 seciphetwork
I Tuning Policies
© cruon
o Alarm Source Info
P IO- Paoll Scheduler
< @ Points
. @ Alarms
¥ OAALann.myAlarrnL\st.MyName
) @ Histories
B m Device Information
) Q Data Poll Frequency
B @ Apps
e Files
E Hierarchy
3 @ History

9. Check the Alarming behaviour by generating test alarms in the corresponding Saia
PCD controller.
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6.3.5 Importing Historically logged data so called HD Logs

There are at least two possible ways to handle the Historically logged data in the
Saia PCD® Supervisor.

1. The HD Logs are generated in the PCD controller. The HD Log data can be saved
in different format and into different memory territory in the PCD device. The
Saia PCD® Supervisor supports only "csv" file based log data which are saved to
the Flash File System of the PCD device. (This means that, the HDLog 3.0 Fbox
generated logs, which are saved to INTFLASH, M1_2FLASH and SLOTO_3FLASH
can be imported.)

2. In the Saia PCD® Supervisor there is History Service which can be used to log the
interesting values to the hard drive of the PC. So the logged data then any time can
be retrieved and can be displayed e.g. as a trend curve. So the Historical Log is
generated in the Saia PCD® Supervisor not in the PCD controller.

Here in this chapter we will see how to import the HD Logs form the PCD controller.
1. The Saia PG5 Data Import Wizard must be started.

2. The right PG5 project file must be selected in the File edit field.

3. Check the HD Logs check box, and press Scan

Saia PG5® Data Import Wizard

Choose the project file (.saiaSpj) to import data

file:*Saia_PCD_Supervisor_Sbus Demo_HC/Saia_PCD_Supervisor_Sby |  File

Enable all
Datapoints
Alarmlists

¥ HD Logs

4. Press Proceed or select the right codepage manually and press Proceed.

Verify Code Page

Code Page

1252 - Western European (Windows)

Data Point Sample Text

Code page detected from PGS project

PROCEED CANCEL
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5. Summary of the found HD Logs is displayed, press Next

Data Points

Saia PG5® Data Import Wizard

Alarm

HD Logs

Import

Finish

Scanning complete

6. The detail view of the HD Logs is displayed. Select the needed HD Log files. Inside
of one HD log file can be many different data points logged (symbols). Then press

Next.

Choose HDLogs to import

Device count: 1

Device v

b CPUO0L

v

HDLogs count: 1

HDLog Name

Logfile

Points: 5

I8 Selected HDLog:

HDLog Name

Logfile

Back

s: 1

Next

Device

CPU001

Reset Selection

7. Check the check box and press Overwrite to proceed.

will be overwritten.

v| Do this for all conflicts

OVERWRITE

SKIP

8. The Import Wizard reports the successful import.

Overwrite hdlog (Logfile) for the device (CPU00L) dunng import if exists?

Import complete

Alarm List

< [

HD Logs

The existing configuration

Import is ready. The details can be checked under the Device/Alarms folder.
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9. Check the result in the NAV tree / Device / Histories.

10. The default settings is to get the data from the PCD device (controller) once per
day. This can be changed to get the data faster for example every 10 minutes.

127.0.0.1 (Demo_Station)

i Station (Demo_Station)

: Config : Drivers

 SBClpNetwork

1 €PUGNL

- Nav
P O & My network
@ My Host : SZ43LTI06GWF2.global.ds.honeywell.com
@ 127.0.0.1 (Demo_Station)
& station (Demo_station)
A alarm

© config
@ services

) niagaranetwork
© sBC systems

Property Sheet
<k Logfile (SBCHDLog)
(@l Hd Log Name

Gl Hd Log Poll Frequency  2:00 AM {Sun Mon Tue Wed

(g Trigger Mode

[ Last Trigger
Cll Next Trigger

Logfile

Time Of Day a2
Daily Randomization |+0 00|
DaysOfWeek [ Sur [ Mon [ Tue [ Wed ] Thu [ Fri [ sat

null

14-Apr—2017 02:00 AM CEST

6.3.6

® secipretwork
X TuningPolicies
@ crPuooy
© Alarm Source Info
E+ Pollscheduler
&5 Paints
(@ Alarms
©® nistories
<k |ogfile
[l Device Information
‘Gl Data Poll Frequency
© apes
& Files
=) Hierarchy
@ nistory

Starting the communication after the import

Drivers can be seen effectively as language packs. After the execution of the

Saia PG5 Data Import Wizard we have got a new driver called the SBCIpNetwork.
Once a driver is in place and configured the Saia PCD Supervisor can speak to that
protocol.

The PG import wizard works offline. It does not require a network connection to the
PCD.

If the IP address and S-Bus station number of the Saia PCD was correctly configured
in the Device configurator and the PCD with the Saia PCD® Supervisor software is con-
nected to the same network and if the network setup is correct, then the communica-
tion should work directly after the execution of the “Import wizard” without problems.
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6.3.6.1

Enabling the Saia PCD S-Bus IP-Driver

1. In the Nav tree open the Station/Drivers/SBClpNetwork. Double click on the

Device1.

2. In the property sheet check the settings (red colour marked lines) and enable the

driver.

3. Save the modification.

®» Saia PCDE Superviso

File Edit Search Bookmarks

127.0.0.1(SBC_SBus_Project)

= Nav
¥ C

v @ My Host : WIN-IFE3J6TEIUL
b @ uayFile System
) 0 My Modules
& Platform
v (@ 127.0.0.1(SBC_SBus_Project]
v BT Platform
@ Application Director
0 Certificate Management
o Lexicon Installer

@ My Network

@ License Manager
o Platform Administration
e Station Copier
e TCP/IP Configuration
b @ Remote File System
- ’ Station (SBC_SBus_Project)
.‘ Alarm
e Config
] @ Services
v e Drivers
« ¥ sBCIpNetwork
X Tuning Policies
» ° Devicel - Copy
» ° Devicel
b e NiagaraMetwork
» e Apps
v a Files
[ 0 offline

- Palette

. Station (SBC_SBus_Project)

Window

Help

Config . Drivers . SBClpNetwork
Property Sheet
 sBCIpNetwork (SBCIpNetwork)
[ status [ok]
. Enabled .true
m Fault Cause
» [ Health

Ok [26-Apr-17 9:52 AM CEST]

b Q Alarm Source Info  Alarm Source Info

» [ monitor
X Tuning Policies
(@ channel Type
b ° Devicel - Copy
r @ Devicel
m Status
[ Enabled
@ Fault Cause
» 3 Health
b @ Alarm Source Info

» B# Datapoints Poll Scheduler
m Datapoints Poll Frequency

Ping Monitor
Tuning Policy Map
S5-Bus TCE/IP
SBCHeadStation
SBCHeadStation

{down, alarm, unackedh!

. true

Fail [26-Apr-17 9:52 AM CEST] Timed out ...
Alarm Seurce Info
N Poll Scheduler

Mormal

[ Ip Address 172.23.13.3:5050
M IpAddress  [172.23.13.6
@ Port [ unspecified | 5050 [-1-55538]
[ Station Id &
» /& Points SBCPointDevicebxt
b @ Alarms Alarms
» (D Histories Histories

) m Device Information
(@ Ftp Username
[ Ftp Password
m Http Password

» Ql Alarms Poll Frequency

SBCDevicelnformation

30secs {Sun Mon Tue Wed Thu Fri Sat }
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Checking different settings to get the communication working

The following picture shows that the communication is not working the devices are

orange colored

Saia PCD® Supenvisor

File Edit Search Bookmarks Tools Window Manager Help

: Station [SBC_SBus_Project)  : Config @ Drivers
.7
Nav Database
¥ O @ My Network Wi T

) My Host: WIN-IFE3JETEIUL
& 1y File System @ Devicel
O vy Modules
& Platform

@ 127.0.0.1(SEC_SBus_Project)

& Platform
® application Director
€ certificate Management
@ Lexicon Installer
© License Manager
© Platform Administration
@ ststion Copler
6 TCcP/IP Configuration
) Remote File System
& station (5BC_SBus_Project)
A Alsrm
© config
@ Services
 orivers
) secipetwork
X TuningPolicies
@ Devicet - Copy

@ Devicer

: SBClpNetwark

Exts Status Health

@ Devicel-Copy SBCHeadStation #%  {down} Fail [26-Apr-17 :27 AM CEST] Timed outwaiting for response.ShcPacketTraceMessage

SBCHeadStation /%  {down} Fail [26-Apr-17 9:27 AM CEST] Timed out waiting for response.ShcPacketTraceMessage

The following steps are needed to do debugging communication problems.

1. Check the communication between PG5 and the Device
This only works if the PG5 is installed onto the same PC

It should be possible to go online to the PCD with the online configurator of PG5

over a “Socket connection”

I File Edit View Project Device Online Tools Help
= = A= e = == =
HPR s APz -3 4

i Project Tree

HE] Project 'Project_for_Miagara': 2 Devices
~[*f  Properties
2 TCP/IP Settings Table
[Z3 Common Files
(gl Library Manager
-IZ Devicel - PCD3.M6860 - 172.23.13.6, 0.0.0.0, S-Bus Stn 6
L0 Properties
i gy Online Settings - 5-Bus USB: PG
EZ Device Configurator
F Build Options
4123 Program Files
-{23 Listing Files
‘([ Documentation Files
[ Devicel - Copy - PCD3.M6860 - 172.2313.5, 0.0.0.0, 5-Bus 5tn 5

Select the channel

[sooEr

E SOCKET
5-Bus Station Number
Auto Station

IP Address or Host Name

Mumber of retries

IP Address or Host Name

Mo
17223136
3

Enter the IP Address or the domain name (without the http: part) of the

PCD.

The Host Mame must resclve to an [P Address by the DMNS server.
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... [Devicel] - Saia PGS Online Configurato

File Online Tools Options Help

Online Settings
SOCKET: TCP/IP, 172.23.136. Stnb

Go Offline

| Online Setings... |

Information
PCD Type: PCD3MEEED Py 12615 |m|
Prograrm: Devicel -
Dte: oB42017 Day: 3 | Hodwarelnfo.. |
Time: 3:41:15 Week: 17 Cas T SR
| History: |
Status: Fun —————
| Clock... |
Help | | Fun | | Stop | | Festart | | Cloge |

the PCD.

BN Chwindows\system32\cmd.exe

Microsoft Windows [Ue

out.
out.
out .

Request timed out.

Packets:

Ping statistics for 172.
Sent = 4. Received

on 6.1.766811

Copyright <c> 208? Microsoft Corporation.
C:wUsers~EB14666>ping 172.23.13.6
Pinging 1?2.23.13.6 with 32 hytes of data:

23.13.6:

C:Users~EB14666>ping 172_.23.13.6
Pinging 172.23.13.6 with 32 bhytes of data:

2. Ifit's not possible to go online over Socket to the PCD, try to ping the IP-address of

All rights reserved.

=4 (188» lossd>.

Reply from 172.23.13.6: bytes=32 time=17ms TIL=64
Reply from 172. H 32 time=14ms TTL=64
Reply from 172.23.13.6: 32 time=14ms TTL=64
Reply from 172.23.13.6: bytes=32 time=5ms TTL=64

Ping statistics for 172.
4, Received = 4, Lost = B (Bx loss>,.

Packets: Sent =

23.13.6:

Approximate round trip times in milli-seconds:

Minimum = Sms.

C:wUserssEB14666>_

Maximum

= 17ms,

Average =

12ms

If it’s not possible to PING the PCD, there must be a problem with the
network setup (e.g. IP address or Subnet mask)

or there is a problem with cabling or switches

or there is problem with Windows Firewall Settings:

- File and Printer sharing must be enabled
- ICMP Echo Requests must be enabled
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3. If there is connection to the controller but PCD Supervisor reports communication
error, check the settings in the network driver.

File Edit Search

Window  Help

: Station (SBC_SBus_Project)  © Config @ Drivers  © SBCIpNetwork

127.0.0.1 (SBC_SBus_Project)
- Nav
P o (D) My Network

v a My Host : WIN-IFE3J6TEIU1
3 e My File System
[ 3 B My Modules
b T Platform
w (@ 127.0.0.1(SBC_SBus_Project)
¥ FT Platform
@ Application Director
o Certificate Management
o Lexicon Installer
@ License Manager
o Platform Administration
9 Station Copier
e TCP/IP Configuration
» @ Remote File System
w & station (SBC_SBus_Project)
._. Alarm
v e Config
3 @ Services
v e Drivers

+ ) sBCipNetwork

3 :l: TuningPolicies

[ ] °Dev|ce1-[upy
4 °Dev|cel
b ) NisgaraMetwork
[ ] aApps
v aFiles
b Q offline
~ Palette

Property Sheet
) sBClpNetwork (SBCIpNetwork)

[ Status {ok}
[l Enabled @ true
(W Fault Cause
» L[ Health Ok [26-Apr-17 9:52 AM CEST]
» Q) Alarm Sourceinfo  Alarm Source Info
» L1 Monitor Ping Monitor
» X TuningPolicies Tuning Policy Map

@ Channel Type S-Bus TCE/IP

» @ Devicel-Copy SBCHeadStation
v @ Devicel SBCHeadStation
m Status {down, alarm, unackeda’
[Wl Enabled @ e
(@il Fault Cause
» [ Health Fail [26-Apr-17 9:52 AM CEST] Timed out \...

b @ Alarm Source Info Alarm Source Info
b B+ Datapoints Poll Scheduler N Poll Scheduler
[Jl Datapoints Poll Frequency ~ Normal

v gl Ip Address 172.23.13.3:3050
(M IpAddress  [172.23.13.6

(@i Port [ unspecified 5050 [-1-65536]
(@i Station1d 5
» & Points SBCPointDevicebxt
b (@ alarms Alarms
» () Histories Histories

» (@ Device Information SBCDevicelnformation
ﬁ Fip Username

(@i Ftp Password

(@l Http Password

» Gl Alarms Poll Frequency 30secs {Sun Mon Tue Wed Thu Fri Sat }
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4. Restart the Platform Demon at last.
It is possible that restarting the Platform Daemon will help because the used net-

work adapter and ports settings are getting updated after restart.

Ej Windows Update
M Wireshark Legacy
M Wireshark

<4 XPS Viewer
. 1-Zip Documents

b
|. Accessories

. FileZilla FTP Client
l. Games

. LenMark

. Maintenance

Pictures
Music

Ji Notepads+ Computer

. PG5 Suite V2.2.221
.. SaiaPCD5upervisor

Al Portal

b Devices and Printers
E Console
=] Demo Station Default Programs
[ Install Platform Daemon

“A? Saia PCD Supervisor Beta (Console) Help and Support
“®> Saia PCD Supervisor Beta

G2 Uninstall

1  Back

Control Panel

| Search programs and files yel |

The communciation is ok when the Devices are not colored and their status is
{OKJ}. In addition, it is possible to see valid information of the PCD in the Nav tree
Device Information subdirectory.

indow  Help

: SBCIpNetwork  © Deviel  : Devicelnformation /' AxXProperty Sheet ~
Property Sheet
(@i Device Information (SBCDevicelnformation)

(@i PCD Status Ran

(@i PCD Type PCD3.M6860

(@ PcD Clock 17-04-26T10:13:01

@ Firmware Version  |1.26.15

Ol Time Zone Europe/Berlin (+1/+2)

- Palette
W X 3§ schedule

» BB Bocleanschedule
N P

6-68 Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG

Creating/Engineering a project

6.3.6.3

Using the “Saia PG5 Data Import Wizard”

Tuning the Saia PCD S-Bus IP-Driver

There are not so many possibilities given to fine tune the communication. It is possi-
ble to set three different kind of speeds (Fast Rate, Normal Rate, Slow Rate) as base.
Then it is possible to set up the rates for a complete device.

B+ Datapoints Poll Scheduler N Poll Scheduler
(@ Poll Enabled @ e
[ Fast Rate 00000h 00m 01.0003|2! [1ms-=+inf]
[ Mormal Rate 00000h 00m 05.0003|2] [1ms-+inf]
@l Slow Rate 00000h 00m 30.0003|2 [1ms-+inf]
[ Statistics Start 31-Rug-2017 10:31 BM CEST
(@ Average Poll 0.0ms
(@ Busy Time -
(@ Total Polls 3109 over Oms
@ Dibs Polls 0% (1/3109)
(@l Fast Polls 0% (0/3109)
@l Mormal Polls 99% (3103/3103)
(@ Slow Polls 0% (0/3109)
(@l Dibs Count current=0 average=0
. Fast Count current=0 average=0
@ Mormal Count current=1 average=0
(@ Slow Count current=0 average=0
(@l Fast Cycle Time average = 1000ms
(@ Mormal Cycle Time |average = 5001ms
@ Slow Cycle Time average = 1000ms
[l Datapoints Poll Frequency  Normal

The polling rate is the same for all datapoints within a Device.

For the Alarm list it is possible to set a polling rate. As default 30 seconds is set. Which
means, that the alarms located in the Saia PCD device are polled in 30 seconds. Then
the new alarms and/or acknowledgment are transferred. The polling rate can be ad-
justed or scheduled. The details of the different settings can be found in the Niagara
documentation.

@l Alarms Poll Frequency 30secs {Sun Mon Tue Wed Thu Fri Sat}
Interval 00000k 00m 3032 [1ms-+inf]
(@i Trigger Mode  |Interval TimeOfDay [] StartTime|12:00:00 AM CEST |EndTime 11:59:53 FM CEST
Days Of Week [ Sun [ Mon [ Tue [ Wed [# Thu [ Fri [ sat
[l Last Trigger 31-Aug-2017 02:18 BM CEST
[ Next Trigger 31-Aug-2017 02:18 PM CEST

G Refresh __J‘ Save
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For the Histories (HD Logs) it is also possible to set a polling rate. The default set-
tings is Daily at 2 o'clock in the morning to retrieve the HD logs from the Saia PCD
Device. This setting can be changed to e.g.: Interval, 30 seconds. Which means, that
every 30 seconds the HD Log data is polled, then the new values are uploaded to the
History files of the Saia PCD Supervisor. The details of the different settings can be
found in the Niagara documentation.

(® Histories Histories
2% Fuehlerl SBCHDLog
[ HD Log Name Fuchlerl

@l HD Log Poll Frequency  2:00 AM {Sun Mon Tue Wed Thu Fri Sat}
Time Of Day 02:00:00 AM CEST |4
M Trigger Mode  |Daily Randomization |+00000h 00m 003

Days Of Week  [@] Sun [#] Mon [@] Tue [@] wed [# Thu [#] Fri [#] sat
OB Last Trigger  |31-Aug-2017 09:27 EM CEST

H [l Next Trigger 01-5ep-2017 02:00 BM CEST

Starting with version 2.1 the Alarms Poll Frequency property is not visible below the

Ax Property Sheet of the SBus Device.

To make it visible and therefore adjustable, switch to the Ax Slot Sheet of the device
fo be adjusted...

\_J CIEENSCNATT &b ProjectName FTOJECT Mame LINEETroren  m Dajaintrng
O Eigenschaft 27 deviceName Device Name Eingefroren h baja:String
O Eigenschaft 28 isProgramCRCRead Iz Program C R C Read Eingefroren rh baja:Boolean
O Eigenschaft 29 programCRCMismatcherror Program CR CMismatcherror  Eingefroren baja:String
O Eigenschaft 30 statusErrorMessage Status Error Message Eingefroren baja:String
O Eigenschaft 31 uuid Vuid Eingefroren rhd baja:Juid Slot hinzufugen Ctrl+A
O Eigenschaft 32 statusUuid Status Uuid Eingefroren rhd baja:Uuid Kopieren Ctri+C
O Ausfihren 33 readAlarms Read Alarms Eingefroren hal void (void)
OAusthrc—n 34 readMultiPoints Read Multi Points Eingefroren ha wvoid (void)
| O Eigenschaft 35 dataPollFrequency Alarms Poll Frequency Eingefroren h control:TimeTrigger Flag bearbeiten
O Eigenschaft 36 Home Home Dynamisch o baja:Pxview
O Eigenschaft 37 AlarmTextAssigner AlarmTextAssigner Dynamisch alarmTextAssigner:Ald Neuanordnen
O Eigenschaft 38 Link Link Dynamisch t baja:Link

...and remove the "Hidden" flag with the function "Edit Flag" at the property:

> Flag bearbeiten x
[] operatar ] Mo Audit
[] Readanly [] composite

[ | GanfirmReguired | | RemoveOn Clone

[[] Execute On Change [] Metadata

[ ] Transient [ ] Linkareet
] summary ] Mon-Critical
[ WeRun [ ] UserDefinedd

[] Fanin [] userDefined 2
. [ ] Userbefineda
[] DefaultOn Clone [] UserDefined 4

[ JAsyne

T

ok | Abbruch
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6.3.7 SbcLinear Conversion

6.3.7.1 Introduction
With the Patch 3127_1 for Supervisor Version 2.1, a new conversion type named
“SbcLinearConversion” will be introduced. This conversion is only valid for SBC specific
media types.

6.3.7.1.1 Before the Patch:

When for example a Register is created below the Points section the point gets the
conversion type linear set per default:

Property Sheet
@ sBCRegister (Numeric Writable)

. Facets units=null precision=1,min=-inf,max=+inf )} m - n
[ Proxy Ext SBCProxyExt

(M Status {down, stale)

[ Fault Cause

[l Enabled @ true

[l Device Facets » O -

[ conversion P Linear Scale 0,1 Offset 0.0

[ Tuning Policy Name
Read Value
Write Value
[l Memory Address
[ Data Format

6.3.7.1.2 With Patch:

Default Policy
0,00 {ok}

- {null} @ def
=1

Signed Int

With the Patch all newly generated media gets automatically set the
SbcLinearConversion as conversion type:

Property Sheet
Q SBCRegisterl (Numeric Writable)

. Facets units=null precision=1,min=-inf, max=<inf )) "9 -
(3 Proxy Ext SBCProxyExt

] Status {down, stale}

(@l Fault Cause

[}- Enabled @ tre

(Ml Device Facets > ©-

(U Conversion
(M Tuning Policy Name
== Read Value
" Write Value
. Memory Address

(Ml Data Format

UM SbeLinear Conversion Secale 0.1 Offset 0.0

Default Policy
0,00 {ok}

= [null} B def
-1

Signed Int
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6.3.7.2 Installing the Patch
Download the Patch from SBC Support page and extract the files:

» Downloads » Saia-PCD+5Supervisor+2_1+Patch1.4.3127.1

Name Anderungsdatum
| sbc-rt.jar 14.04.2020 09:41
] sbe-rtjar.sig 14.04.2020 10:07

| sbc-ux.jar
| | sbec-uxjar.sig
| £ sbe-wh.jar

[ ] sbe-wb.jar.sig

Copy all files to the modules folder of your Supervisor Install Path:

|GSDI5K(C:J » SBC » SoiPCDSupervisorsd® > modules I v &
* h MNarme : Bnderungedstum Gral
. i e o T8 . .
[£] sbelconGallery-whjar 5 KB
" | sbelconGallery-wh jarsig 1K8
|| sbeOfflineEngineering-rt.jar KB
| sbeOfflineEngineering-rtjar.sig ]
| £ sbcOfflineEngineering-uxjar 15 KB
| sbeOtlineEngineering-uxjar.sig 1KB
|z sbe-rtjar 184 KB
| sbe-rtjar.sig 1KB
Ite Lix) sbe-uxjar 11KB
| sbe-uxjar.sig 1KB
|| sbc=whb jar Executable Jar File 20 KB
| she-whjar.sig SIG-Datei KB

L) schedule-rtjar
| sehedule-unjar

| schedule-wbjar

| semrch-rt.jar

After that uninstall/install Plattform Daemon and restart Workbench.

6.3.7.3 Import in newly generated stations (after installing the Patch)

After the Patch is installed, all newly generated DataPoints will get add the new SbcLin-
earConversion automatically during import. No special work is needed here:

Database

Hame Type Out Tuning Policy Name  Conversion

) output  Numericwritsble  0.0{d ale] @ def she n "0.10
@ vaive  Numercwritsble 0.0[downstale] @del  defl By e Lis nwenison “0.10

_Ro1
© 35 40 FBomes (98 Al FBaues]
© alser source info

[+ tutapoints Poll Scheduler

A Binary_BI
B Binary_Bv
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6.3.7.4 Updating existing stations

This section describes two ways how to update existing Station.

6.3.7.4.1 Change conversion type manually

Go to a subsequent folder where you want to change the conversion type and open
there the SBC Point Manager view by right clicking on the folder:

G iValue

0 walue_al

E senso

E PHe

! SBClpNetwork

Ansichten

Neu

Tags bearbeiten

0 ConvType  MumericWrital

e Correction Numeric Writal

Point View Widget XISl
SBC Point Manag cWrital
Wire Sheet cWrital
AX Property Sheet ¢ Writal

Property Sheet ¢ Writa|

Make Template Category Sheet cWrital

Ausschneiden

Kopieren

Einfligen

AX Slot Sheet cWrital
Relation Sheet cWrital
Delete Points View [ Writal

cWrital

Einfligen Spezial Neue Grafik

Duplizieren

Léschen

Suchen

Link markieren

: EN_BO1_RO1

¢ Writal
Hilfe Leitfaden Writsl
Bajadoc Hilfe

Spy lokal

Spy remote
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Open the table settings via click on the button in the upper right corner and set the
Conversion Column to be displayed:

/ SBC Point Manager

16 Objekte

Spaltenbreite zuriicksetzen

Exportieren

Pfad

v Name

Enabled

Facets

» Tuning Policy Name

Device Facets

» Conversion
Fault Cause
Read value

Write Value

Choose and select the desired data points and click on the Edit button:

Database

Hame Type Out Tuning Policy Mame  Conwversion

° AlaLimHigh Boolean Writable false {ok] @ def defaultPolicy Default

o AlaLimLow BooleanWritable false{ok] @ def defaultPolicy Default

©) convType  MumericWritable 2.0{ok} @ def defaultPolicy Default

() Comection  MumericWritable 0.0K{ok]@def  defaultPolicy Linear"0.10

O GwHyst NumericWritable 2.0 K{ok] @ def defaultPolicy Linear"0.10
© owver NumericWritable 10.0s{ck} @def  defaultPolicy Default

I} LimHigh NumericWritable 50.0°C{ok}@def defaultPolicy Linear "0.10
[} LimLow NumericWritable -30.0°C [ok} @ def defaultPolicy Linear *0.10
[} Physval NumericWritable 15.0°C{ok}@def defaultPolicy Linear *0.10
[) PhysvalYl  MumericWritable -30.0°C{ok} @def defaultPolicy Linear *0.10
I} Physvaly2  MumericWritable 50.0°C{ok} @def defaultPolicy Linear *0.10
©) Rawval¥i  MumericWritable 0.0{ok} @ def defaultPolicy Default

o RawVala MumericWritable &0 defaultPolicy Default

@ ScanFact  NumericWritable defaultPolicy Default

© 5canTime  NumericWritable  1.0s{ok} @def defaultPolicy Linear "0.10
© voltcrp MNumericWritable 1.0 {ok} @ def defaultPolicy Default

B New Folder

A vew | & Edit | B, Tagit
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In the upcoming window the changement to the conversion type SbcLinearConversion
can be done:

o Edt x
Name Type Enabled Facets Tuning Policy Mame  Device Facets  Conversion L]
10 comection  NumericWritable true units=K precsions1,min=-10.00,mae=10.00  defaultPolicy Linear "0.10
0 owtyst  NumericWritable true unitz=H precsions1,min=0.00,ma=1000  defaultPolicy Uinear *0.00
©) UimHigh  HumericWritable true unitse'C precisional mine-50.00 mam150.00  defaultPolicy Linesr"0.10
0D Uimlow  NumericWritable true unitss"C precisions] minm-50.00 Maxm150.00  defaultPolicy Linear *0.10
O physal  Numencwitable true RIS, precision=1 mine-ind, muxesinf defaultpolicy Linear *0.10
D) Physvalvl  NumericWritable  true units=*C, precision=1,min=-infmae100.00  defaultPolicy min=0.00 Linear *0.20
10 Physhaly2  NumericWritable true unitse'C, precisionsl mine-inf,mee100.00  defaultPolicy mineg.00 Linesr"0.10

Name Correction
Type Cannotedit
[ Enabled @
[ Facets unitssK precisions] K mine- 100 Kmae1 00K D =

Tuning Policy Name Default Folicy

Scale 0. 1 Offset 0.0

]

Ohen Shunt NS el defaultPolicy Delault

RERE RS @def  defaultPolicy Linear 0.0
emistor Type INS

sdet defaultPolicy Default
meric Tabular
ermistor Type 3
bulss Thermistor
00 Ghen Shunt
00 Ohm Shunt (nria)

@ New Folder  [3] New edit | B, Tapn
E , Tag!

After clicking on OK button, the changement will be applied to all selected items:

Database

MName Type Out Tuning Policy Name  Conversion

o AlaLimHigh Boolean Writable falee {ok} @ def defaultPolicy Default
onlaleLow Boolean Writable false {ok} @ def defaultPolicy Default

0 ConvType  Numeric Writable 2.0{ok} @ def defaultPolicy Default

o Correction  NumericWritable 0.0 K{ok} @ def defaultPolicy SbelinearConversion
0 GwHyst Numeric Writable 20.0K{ok}@def defaultPolicy SbeLinear Conversion
o Gwerz NumericWritable 10.0s{ok} @def  defaultPolicy Default

o LimHigh NumericWritable 500.0*C {ok} @def defaultPolicy sSbeLinearConversion
© LimLow Numeric Writable -300.0°C{ok} @ def defaultPolicy SbeLinearConversion
© Physval NumericWritable 150.0°C{ok} @def defaultPolicy SheLinear Conversion
@ Physvalrl  NumericWritable -300.0°C{ok] @def defaultPolicy SbeLinearConversion
0 PhysvalY2  NumericWritable 500.0°C{ok]} @def defaultPolicy Sbelinear Conversion
@ Rewvalit  NumericWritable 0.0{ok} @ def defaultPolicy Default

©) Rawval2  NumericWritable 4095.0{ok}@def defaultPolicy Default

0 ScanFact NumericWritable 10.0{ok} @ def defaultPolicy Default

0 ScanTime  NumericWritable 1.0s{ok] @ def defaultPolicy Linear"0.10

0 VoltGrp Numeric Writable 1.0 {ok} @ def defaultPolicy Default

6.3.7.4.2 Change conversion type automatically (PG5 projects without PointDefinition.csv)

To make the changement automatically done you need to reimport your project with
Saia PG5 Import wizard.

During import process select Overwrite:

Confirm

Do you want to overwrite datapoint (A01.Alarm Groups CmdAlmAck) for the device (EN_B01_R01) during import if exists?
OVERWRITE - Overwrite Memory Address & Comments
SKIP - Skip Comments only

¥ Do this for all conflicts

Skip
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6.3.7.4.3 Change conversion type automatically (PG5 projects with PointDefinition.csv)

If a PointDefinition.csv is part of the PG5 project you need to take care, if the right con-
version type is set for each the data point.

Example on macro [ DDC_SPINT2270] from DDC Suite 2.7

Before the patch:

The conversion was assigned during import like this:

ProxyExt:Conversion='Linear+Scale=0.01+0Offset=0.0'

[_poC_seiNT2)
Value Walue

Output Output
Prinden PriogEn
Prinaval Priogval
PriolBEn Priol6En

The result was:

Value

Output
PrioSen
Priodval

PriolSEn .Fa(e'h.;'F.lls('Tut:Ir'ad--m'

Farete="Units=relsius’
Farets="Units=celsius’

Fatets=FaleText=inactive’

Farets="Unitsapelsius’

ProayExt:Conversion="Linear+Soale=0001+0 M ret=0.0"
ProayExt:Conversion="Linear+5cale=0.01+0ffset=0.0°
Facets=TrueText=Active’
ProayExt:Conversion="Linear+5cale=0.01+0ffset=0.0°
Faceis="TrueText=Active’

After patch was installed:

The conversion must be set like this:

Database

Name Type out Tuning Policy Name _ Conversion
O o
10 Fricten def oy Default

) Prictval  NumericWiritable  0.0°Cldown stale} @del  defaultPoliay Defalt

O PricisEn @ del ey Defalt

O value  Numericiritable  0.0°Cidown stale} @def  defaultPolicy

ProxyExt:Conversion='SbcLinear+Scale=0.01+0Offset=0.0'

[_DDC_SPINT2270]
Value Value

outpat outpiat
Prig8En PrigBEn
PricgVal Priogval
PriglBEn Priol&En
After import:
Database

Hamme Type

walug
utput
PricdEn
Pricaval
Pricl&En

Faoatss
Facetis
Fagetss

Facetss
Facatss

O Cutput  NumencWritable 0.0°Cidownsule] @del  defaultPoliey
O Friclin  Boolesa writable  Inactiwe [down stalel § def  defaultPoley
) Priowral  umercwiable 04°Cidownsalel @def  defauitPoley
O Prioibtn  Boolessveriable insctive [Sown stale] @ el defaultPoley
©) voiue Wumericwritable 0.0°C{downstale) $del  defaultPolcy

UnitssealEiug
Unsitiscalsiug
FalseTestsinactive’
Unidtsecelsius’
FalseTectsinactive’

ProayExtCorertionsSBoLineareSeales0 08 «Oftgat=0.0"
PRy ERTC ARSI o S oL b areScale 0.0 +Orsa1=0.0°
FacatssTroaTextshotivg”
ProayExt-Cormeersions"Sbolingars Scale=0 08 +Dftgats0.0"
Facatss TroaTextsicti”
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6.3.8 Enhanced PG5 Import Wizard

m The datapoint filter can now also be applied to tags
m Alarms can be configured with the alarm class specified in the AlarmService

All data points are displayed in the list

When importing very large projects, the data points no longer go to the status
"stale"

Imported alarms now have the correct timestamp

Array import working

Filter Datapoints by X n
J

Select All
¥| Registers
¢l Flags
Counters
10
Timers
DB
Text

Hide Datapoints Starting with

S.

Show Datapoints with tags

alarm areal

Restore Defaults Apply

T T OO LTI O e A= o o s o a s sy =
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6.3.9 Addition to the standard import

ﬂ Starting with Saia PCD Supervisor V2.1

In addition to the standard import, the extended import wizard from version 2.1 and
higher allows to add properties like facets, conversions, alarm, history extensions and
more to the points during the import process.

6.3.9.1 The additional properties are required to work with
the easy templating library DDC27

m To support the new import features PG5 2.3.175 and higher is required as well as
the start of projects is recommended to use the new multilingual DDC-Suite 2.7
starting project ending with ML.

m In additional project not based on the new start project can get extend by the
necessary additional information’s using a helper application which allow to
generate the list of used macro names in the project.

6.3.9.2 The predefined graphical templates for DDC 2.7 are created
to support the DDC Suite 2.7 environment

m The easy Templating process itself can support various constellations of templates.

Important to know:
- Since Saia PCD Supervisor 2.1 the CPU name from PG5 is no longer the import location in
the NAV tree.

- The import location is now based on the IP-Address of the device and the CPU name is given
from PG5 on top as the display name.

- During import the engineering point names are translated from different languages to English.

- This makes it possible to use one set of templates for all different existing languages for DDC
Suite 2.7 projects.

- On top of the engineering data point name a display name will be added which represents the
imported language in the NAV tree so the engineering and display name can differ.
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System consequences for duplicated CPU names
Starting with V2.1!

During Import the IP-Address of the imported devices configured in the PG5 device
configuration is used to identify the station below the S-Bus IP driver Network.

During import a unique naming convention is created for the device ORDs like
SbcHeadStationX(x=INT) or SbcSubStationX(x=INT). The display name of the ORD
from the imported note is set to the device name from the PG5 project.

G DOC Suite 27 ML - Dec 2019 (FR_B01.L01} - Sala PG Lo o o) fmeied
[ file Gt View Project Device Online Tools Help

D@ & &Eaxs BMy

N OO 58NS

| Project Tree 2 x

& Project 'DOC Suite 27 ML - Dec 2019 : 15 Devices

A Properties

3 TCP/P Settings Table =
$E) Common Files Sled ¢ MKome Arzegerame Defrstion  Flags Typ

i Ubrary Manager Qogmacoht ¢ wenr Latun Ongelrores 3 bajacitany
131 1) REe—— Supervisor Template «-eeeememe - PCOLG3600-C15 - S-Bur O tgemddoit 1 enabled tradied Tngrtreres DayxBooleas
¢ 8 93 Al FBoxes - PCOIMS360 - 192.16810.80, S-Bus Stn 80 Qtgnacran 1 faitoume Tovk Covre Grgefieres 7 baaiineg
+ M BACnet Aliasing - PCO3MSSE0 - 192.168.10.1 52, S-Bus Stn 151 O Gammachah 3 hasts Mook Bneroren PRGRUIIRS
+ B DE_-eremeneen VOrlaQe ««oeeeeeee = PCDLG3600-C1S - S-Bus Sin 0 . .
i M DE_GOY_RO1 - PCOIMSSEO - 192168072, 5-Buss Stn 72 O Suisdeh 13 oo e R et
i MR OE_Vorlage - PCOIMSSED - 192168071, $-8us Stn 71 Otemnacan 5. moon s Dogfese —
5 I EN e~ Templote ----s---- - PCOLG3600-C15 - S-Bus Stn 0 Qaustitmn & pig P Gngriooes 3 g
+ IR EN_BO1_RO1 - PCOIMSSED - 192.168.072, §-Bus Stn 72 QArufidonn 1 sdhlam Ak Alaom Dngelroces h
& M EN_Template - PCO3MSS60 - 192.1680.71. §-Bus Stn 71 O ot 18 opiegrbous:, oang oot
3 PR _-eeeeeee Modele «+-eeeeees - PCOLG3600-C1S - S-Bus Sn 0

O tgenscha ¥ % Anyn Ongetroows &
+ 4 FR_BO1_LO1 - PCO3.MSS60 - 192.168.0.72, S-Bus Stn 72
i M FR Mocele « PCOIMSSE0 - 192.1680154, S-8us Stn 156 Q Banachah /19 wépcoary v syl
o N eeeeeee S;ADIOON ~<vveeeee - PCDLGIE00-C1S - S-Bus Stn 0 O tpmosrsh 11 Ouseltys Oranaei Type Dagefroces ¢ baaciineg
+ M8 NL_GO1_RO1 - PCO3MSS60 - 192.168.0.72, $-Bus Stn 72 O tgrnscran 12 oslofiones Oysosn N bysNemelp
+ M NL_Sjabloon - PCOIMSSEQ - 192.168.178.5, $-Bus Stn § O tomidhaht 1) Botasciaton R_BOILOL  Oynamisch RERONsELION
O gensraft 14 RowssRatosl DE_BI1_LOY Oynamach RCROWIIRITON

This allows to import from different PG5 Projects having same device names applied
without changes to the project.

If a station with the same IP-Address is imported and already existing below the S-Bus
driver network, you will get asked to enter prefix before the import.
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6.4
6.4.1

General functions

Configure Scheduled tasks

This chapter describes how to configure Schedulers to control the automations system
during occupied and non-occupied time.

Scheduler

The Scheduler provides control of values and changes setpoints based on time and
date. Lights, Fans, and HVAC equipment are turned on and off based on the time, day
of week and date. The Scheduler is also used in process control and manufacturing
applications.

Presently there is no Saia PCD Supervisor compatible Schedulers in the Saia PCD
Device. It means that, if the automation system needs high level scheduling functions,
this must be done “upstairs” in the Saia PCD Supervisor not in "downstairs” in the
PCD Device. Which has the drawback that if the Supervisory computer fails to work
the Scheduling function fails too.

There is an exception. It is possible to use the Saia PCD Device as BACnet Control-
ler, in this way the BACnet standard scheduling functions can be used. This is com-
patible with the Saia PCD Supervisor. However it needs to license and use the 3rd
party (BACnet) driver in the Saia PCD Supervisor.

Schedules are created using schedule components found in the schedule palette.
Place these components in a station, configure, and link as needed to provide schedul-
ing control of other components.

Scheduling functionality is the same whether using Workbench or an HTMLS web
browser with one exception. Currently, in a web browser connection, you do not have
the options to copy or paste components.
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Schedule component categories

Component category

Description

Weekly

Boolean
Numeric
Enumerated
String

Weekly schedules define regular, repeating, events

by “time-of-day” and “day-of-week.” Also, you can
configure any number of “special events” on a weekly
schedule. Weekly schedules are the most used sched-
ule components. Four different types vary by data
category (Boolean, Numeric, Enum, and String). Each
is identical except for input/output.

Calendar

Calendar schedules define specific days. Use a cal-
endar schedule to define days with scheduling excep-
tions (e.g. holidays), and reference them in the “spe-
cial events” setup of weekly schedules.

Trigger

Trigger schedules fire actions or topics. With a set
of pre-configured schedules and a ScheduleSelec-
tor component, you can simply choose from a list of
valid schedules to setup or change the schedule of a
device.

Selectors

Schedule Selector components provide an easy way
for you to select a schedule to use for controlling a
particular component. As needed, you typically link its

output to an action of a control point or extension.
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Schedule component views

Weekly

Default view

for any weekly schedule component. In Work-
bench the Scheduler view provides four configura-
tion tabs:

Weekly Schedule

Sunday-through-Saturday (weekly) event times/
values. Use this to define the regular weekly
events.

Special Events

All exceptions to the defined weekly schedule, as
special events. Use this to define special event
times.

Properties Important properties such as default output,
schedule effective times, special event clean-up
operation, and schedule facets.

Summary for any selected day, provides a tabular summary

of all schedule events, with source. Also available
under the Scheduler view dropdown list:

Current Day
Summary

provides a simple 24-hour linear graph of schedule
event times and values for the current day.

Calendar

Default view

for a CalendarSchedule component. The Calendar
Scheduler view provides a calendar where you
can add, edit, or delete specific calendar days
(exceptions to the regular weekly schedule) and
establish relative priorities.

Trigger

Default view

for a TriggerSchedule component. The Trigger
Scheduler view provides a two-part view combin-
ing a “day picker” and an event “time picker” for
specifying when topics are fired on those days.

We configure a Weekly schedule and a Calendar Schedule in this chapter.

ule and Special Events.

n In a web browser the Scheduler view provides two configuration tabs: Weekly Sched-

While the Current Day Summary and Property Sheet views are available under Sched-
uler view dropdown list.
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Examples

Weekly Schedule
The task is to configure a weekly schedule which switches on the Light in the nor-

mal office time from Monday till Friday and from 8:00 till 17:00. Friday the office time

is reduced only from 8:00 till 14:00.

There is special event on 1st of September 2017. In this day the Light must be
switched off from 9:00 till 11:35 due to test.

Calendar Schedule
There are known official Holidays like Christmas or the Swiss National Day where
the office is unoccupied therefore the Light must be Switched off.

The steps to add and configure Schedulers to the Saia PCD Supervisor:

1.

2
3
4,
5
6
7

Creating folder for the scheduling components

. Add Weekly Scheduler component from Palette

. Configuring normal events weekly schedules

Configuring special events weekly schedules

. Add Calendar Scheduler component from the Palette
. Configuring Calendar Schedule

. Make the logic to control the physical point in the PCD device

or

Make the logic to control the physical point in the PCD device using reference be-
tween the schedulers.
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6.4.2 Creating folder for the scheduling components

Schedules can be created and added to any part of Saia PCD supervisor. However, it
makes sense to manage these in a central location.

1. In the Nav tree open 127.0.0.1(localhost) > Station > Config
2. Create there a folder called Scheduler.

3. Double click to the folder. The associated Wire Sheet will be opened.

» 5aia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet Help

4 B O- o a O 00 =~ [
n 127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers

- Nav Wire Sheet

|=® o @Mer:twork

@ My Host: SZ43LTI06GWF2.global.ds. honeywell.com
@ 127.0.0.1 [Demo_Station)
# Station (Demo_Station)
!. Alarm
e Config
@ Services
b 6 Drivers
@ Apps
0 Schematics
0 Schedulers
Q Files
E Hierarchy
@ History

More details of using Wire Sheet can be found inside of the Niagara docu-
mentation.
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Add Weekly Scheduler component from Palette

1. Open the schedule palette

- Palette
EI E] @ i schedule

» B BooleanSchedule
» B8 Enumschedule

B NumericSchedule

=::] StringSchedule
+ [ calendarSchedule

=21 TriggerSchedule

B BooleanScheduleSelector
v B NumericScheduleselector
» @ stringScheduleSelector
» B8 EnumscheduleSelector

<% Open Palette

Select one or more palettes to open, orjust start typing:

v schedule
Module Description
schedule Schedule Framewaork

0K Cancel

Browse...

ers folder.

™ Saia PCD® Supervisor

File Edit Search Bookmarks Tools

127.0.0.1 (Demo_Station) . Station (Demo_Station)
- Nav
l=° O @MyNetwork

J @ My Host : SZ43LTJ06GWF2.global.ds.honeywell.com
v (@ 127.0.0.1 (Demo_Station)
’ Station (Demo_Station)
! Alarm
@ Config
@ Services
g 6 Drivers
@ Apps
» 0 Schematics
0 Schedulers
Q Files
E Hierarchy

@ Histary

Window

Wire Sheet  Help

. Config . Schedulers

Wire Sheet

Weekly_Schedule_Light
Boolean Schedule

Status

Out Source

In

Next Time:

et Value

. Drag and Drop the BooleanSchedule component to the Wire Sheet of the Schedul-

In the pop-up dialog specify the name of the component (Weekly_Schedule_Light)
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6.4.4 Configuring normal events weekly schedules

1. Double click to the Weekly Schedule_Light function box to open the Scheduler
configuration window.
Saia PCD supervisor Schedules operate Sunday to Saturday and times
are set from top to bottom.

2. In the weekly view specify the time range for Monday. For that go to Monday 8:00
press the mouse left button and drag the mouse down till 17:00 o’clock.
The defined time range will be shown as green stripe.

< Saja PCD® Supervisor il - m] X

File  Edit Search Bookmarks Tools Window Help

4 oD O- o #f O 0 w- @ [P D |
127.0.0.1(Demo_Station)  © Station (Demo_Station]  © Config  : Schedulers  : Weekly Schedule Light #  scheduler -
- Nav i

P o ) My Netw

@ My Host : S743L TJO6GWF2.
@ 127.0.0.1 (Demo_Station)
’ Station (Demo_Statio
A Alsm
e Config
@ Services
© orivers
Apps
D Schematics

- Palette
W X B | schedul

[ Boaleanschedule EventStart |08:00 2M
B Enumschedule EventFinish |05:00 BM

BB NumericSchedule EventOutput [] null | @ tue
B stringschedule
B calendarschedule

B TriggerSchedule [™) save 7 Refresh

PP Weekly Schedule | [i] SpecialEvents  [8] Properties () Summary

3. Do not worry if you do not find the exact time. Below the graphical representation,
in the Event Starts and Event Finishes edit fields it is possible to type it.

In the headings of the green stripe and in the Event Output drop down box the
scheduled value can be seen (true). It is possible to invert it.

4. Define time schedule for Tuesday to Friday too in the same way. Take care the of-
fice time in Friday is until 14:00.
It is possible to do copy and paste. Right mouse click to the green stripe and select
copy day. The selected time span is then shown in blue colour. Right mouse click
to the remaining days and select paste day. Then set Friday 14:00 o"clock.
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5. Click Save at the bottom of the page.

«® Saia PCD® Supervisor

m] X
File Edit windo Help

127.0.0.1 (Demo_Station) @ Station (Demo_Station) Config ! Schedulers

P C () My Netw

b @ My Host: SZ43LTIOEGWF2.
~ (@ 127.0.0.1 (Demo_Station)

» & station (Demo_Statio
‘ Alarm
- @ Config
b @ services
b eDnvers
» @Apps

0 Schematics

- Palette
W X B | # schedu

EHH Booleanschedule EventStart |08:00 2M|2

BB Enumschedule EventFinish |02:[ PM 2

B8 Numericschedule EventOutput (] null (@ true
StringSchedule

: 5 BB weekly Schedule m Special Events m Properties Gsummary
CalendarSchedule

=::] TriggerSchedule

[™) save ‘ 7 Refresh

6.4.5 Configuring special events weekly schedules

1. Click to Special Events at the bottom of the page.

2. The Special Events summary page opens with the Today schedule visible.

@ Saia PCD® Supervisor

- O x
File  Edit 0

127.0.0.1 [Dema_Station)  © Statien (Demo_Station) Config  : Schedulers @ Weekly Schedule Light

4 PrevPage 4 PrevMonth Today | NextMonth p  Next Page p
¥ O (D) My Netw

Jul 2017

Sep 2017
L @ My Host: SZ43LTJOGGWFL.

w (@ 127.0.0.1 (Demo_Station)
v ’ Station (Demo_Statio
._‘ Alarm
® eConf\g
4 @Services
» @ Drivers
¥ eApps

» O schematics Name Summary

- Palette
[ ] [Z] E ischedul-

* [EH Booleanschedule

EventStart |03:29 PM
03:29 PM
BB enumschedule Event Finish
Add Edit Priori Priori Rename Delete Event Output 1§ t
BB NumericSchedule ® ty ty vent Output [] null (@) true
B8 stringschedule =
m = PP Weekly Schedule [l specialevents  [B] Properties  (5) summary
CalendarSchedule

::] TriggerSchedule

msave ‘ cllefre_'sh
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3. Click to Add and specify the date 1st of September 2017.

™ 5y

File  Edit Window  Help

127.0.01 (Demo_Station) ! Stetion (Demo_Station)  : Config  : Schedulers ! Weekly_Schedule_Light /7 Scheduler ~

4 PrevPage 4 PrevMonth  Today | MextMonth b NextPage p

~
? O @ My Netw Jul 2017 Sep 2017

b (@ My Host: SZ43LTIDEGNF2.
v (@ 127.0.0.1 (Demo_Station)
» & Station (Demo_statio
‘ Alarm

@Conﬁg
b @ services

e Drivers
@ Apps @ Add
» O schematics Name  Summal yame Switch Off due test 3:00AM

6:00 AM
Type |Date 900 AM

- Palette B 12:00PM

- 3:00PM
Any Weekday Sep
W X B | # schedul &00PM

9:00 PM

+ BH Booleanschedule OK Cancel EventStart |03:29 EM

EventFinish |03:23 BM

» BB Enumschedule
B Numericschedule Priority Priority Rename Delete Event Qutput[ ] null .true

B8 stringschedule
B colendarschedule
m TriggerSchedule m Save | c Refresh

B weekly Schedule m Spedial Events m Properties C‘)Summary

4. Click OK

5. Specify the schedule to switch off the Light from 9:00 till 11:35. Do this at the right
side of the window by using the mouse and typing the values by hand.
Do not forget to specify the “false” value to switch off the light

®> Saia PCD® Supervisor = - m} ¥

File  Edit

127.0.0.1 {Demo_Station)  © Station(Demo_Station)  © Confiz  © Schedulers  © Weekly f Scheduler -

4 PrevPage 4 PrevMonth Today | NextMonth B NextPage p

P
L O & wy ety Jul 2017 Sep 2017

k @ My Host : SZ43L TJOBGWF2.
v (@ 127.0.0.1 (Demo_Station)
v ’ Station [Demo_Statio

‘ Alarm
v © config
» @ Services
6 Drivers

@ Apps

b O schematics Name Summary Unscheduled
3:00AM

- D Schedulers Switch_Off_due_Test Date:1Sep 2017 S0DAM

9:00 AM

- Palette 12:00PM
3:00PM

- E] @ ischeduh 6:00 PM

9:00PM

+ B Booleanschedule
BB Enumschedule
B8 Numericschedule

» M StringSchedule

B calendarschedule BB Weekly Schedule ] specialEvents  [§] Properties (D) Summary
] TriggerSchedule

» P RoaleanscheduleSelertar [ save 7 Refresh

EventStart |04:06 EM
EventFinish |04:06 EM

@ Add ® Edit Priority Priority  [I] Rename 3¢ Delete Event Output [] null | false

6. Save the configuration
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7. Check the summary. Click to Summary at the Bottom of the page. Navigate to 1st
of September 2017. Then in the text summary it can be seen the Special Event

entry.

«® Saia PCD® Supervisor

File  Edit

Scheduler ~

! Weekly_Schedule_Light Vs

4 PrevMonth  Today | NextMonth p

127.0.0.1 {Demo_Station) ! Stetion (Demo_Station) @ Confiz  © Schedulers

4 Prev Page Next Page p

() My Netw

e O

b @ My Host: SZ43LTIOEGWF2.
~ (@ 127.0.0.1 (Demo_Station)

Oct2017

' gEEaEn -

> ’ Station (Demo_Statio Jul 2017 Aug 2017 Sep 2017

! Alarm

6 Config

b @ services
b e Drivers
b 6 Apps

1:
. AEEEH »
> IEEEE -
« DEEEE »

- AEEEHE -
> EIEE EE -
» HAEEE »

» M EEEE
v DEEEE

- EEEE -
s EEE @@
» (QEEE »

] 0 Schematics
- 0 Schedulers
+ E Weekly,

e Files

P — I

- JEEED~ |-D0EE ||+ B0E0E | |- 08

= [

- Palette
W X B | # schedul

B Booleanschedule

B Enumschedule

BB NumericSchedule

B stringschedule

BB calendarschedule

m TriggerSchedule

B BooleanScheduleSelector
B Numericscheduleselector

—_— m Save

Timestamp Output  Source

01-5ep-1712:00 AM CEST false{ok} Default Output

01-5ep-178:00AM CEST  truefok} Week: friday

01-5ep-17 ::00AM CEST  false{ok} Special Event: Switch_Off_due_Test

01-Sep-17 11:35 AM CEST  true{ok} Week: friday

FFE Weekly Schedule  [i] SpecialEvents  [H] Properties (D) Summary

7 Refresh
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6.4.6 Add Calendar Scheduler component from the Palette
1. Open the schedule palette

2. Drag and Drop the CalendarSchedule component to the Wire Sheet of the Sched-
ulers folder.

3. In the pop-up dialog specify the name of the component (Calendar_Schedule_
Light)

4. A Calendar Schedule function box is placed to the Wire Sheet.

™ Saja PCD@ Supervisor b - [m} X
File Edit Search Bookmarks Tools Window  WireSheet Help
4 o O- oA O 0 & - 2 ILI s o »
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers 7 Wire Sheet -

- Nav Wire Sheet
E O @

e Calendar_Schedule_Light H
Calendar Schedule
v (@ 127.0.0.1 (Demo_3t:

v ’ Station (Dema_
! Alarm
- @ Config

> @ senic Weekly_Schedule_Light
b 6 Driver Schedule

- Palette
w X 3 s

» B8 Booleanschedule

» BB EnumSchedule
» BB NumericSchedule

O - - - [T AR
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6.4.7 Configuring Calendar Schedule

1. Double click to the Calendar_Schedule_Light function box to open the Scheduler
configuration window.

2. Click Add to schedule the Christmas holiday from 25th of December till 31th of
December.

File Edit Search Bookmarks Tools Window  Help

127.0.0.1 (Demo_Station) : Station (Demo_Station) I Config . Calendar_Schedule_Light 4 Calendar Scheduler -

4 PrevPage 4 PrevMonth Today | NextMonth p

¥ o © Hynets Jul 2017 Aug 2017 Sep 2017

L

@ 127.0.0.1 (Demo_station)
4 , Station (Demo_Statio
A Alarm
v @ Config
b @ Services
6 Drivers
Apps
p o Schematics
v osdmdulers
b B weekly,

10 11 12 13 14

17 18 19 20 21
23 PLE 25 26 27T 28
30 31

Name Summary

o Add

Name Christmas_Holiday

~ Palette (A Type | DateRange

W X B | schedul 25 Any Year

Through
B Booleanschedule

» B8 EnumSchedule

» BB NumericSchedule o PR
B stringSchedule

» B calendarSchedule Edit Priority Priority | Rename Delete

| TriggerSchedule
D Save O Refresh

Dec Any Year

3. Click OK and then click Save.

4. Then it makes sense to define a holiday for 1st of January.
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5. Then specify the holiday for the 1st of August (Swiss National Day)

@ Saia PCD

File Edit S

window  Help

| o 0 - B D |

127.0.0.1 (Demo_Station) . Station (Demo_Station) I Config . Calendar_Schedule_Light A Calendar Scheduler -

4 PrevPage 4 PrevMonth  Today | NextMonth b MNextPage p

l:e G @ My Net Jul 2017 Sep 2017

v (@ 127.0.0.1 (Demo_Station)

v ’ Station (Demo_Statio
‘ Alarm
v e Config
] @ Services
] e Drivers
[ @ Apps
» o Schematics
v 0 Schedulers
b B Weekdy

Name Summary
FirstOfJan_Holiday Date:lJan

Christmas_Holidsy ~Date Range: 25 Dec- 31 Dec

- Palette = add

- E] E i schedul Mame Swiss_National Day_holiday
Type |Date

» BB BooleanSchedule
» BB Enumschedule
» B Numericschedule

0K Cancel
» B8 StringSchedule 4
» HH calendarSchedule ® Edit o Priority W Priority  [[]Rename 3 Delete
» @ TriggerSchedule
B Save O Refresh

Any Weekday Aug

6. Click OK, Click Save, Click Refresh.

7. Check the settings. Green background of the dates means schedule is set.

4® Saia PCD'® Supenvisor - - m} ¥

File  Edit

Window  Help

127.0.0.1 (Demo_Station) . Station (Demo_Station) B A edule_Light ¥ Calendar Scheduler -

4 PrevPage 4 PrevMonth  Today | NextMonth B  NextPage p

l=e G @ My Nety Sep 2017 Dec 2017

v (@ 127.0.0.1 {Demo_Station)
v ’ Station (Demao_Statio
‘ Alarm
v eCOnfig
] @Serwces
4 eDrwers
[ eApps
» °Schemat|f_t;
+ ) schedulers
b B weekly

7

10 11 12 13 14
17 18 19 20 21

Name Summary
Swiss_Mational_Day_holiday Date:1Aug

FirstOfJan_Holiday Date: 1Jan

Christmas_Holida Date Range: 25 Dec- 31 Dec
- Palette - i =

- E] E ischedul

» BB Booleanschedule
» BB Enumschedule
» B Numericschedule
» B stringschedule

B calendarschedule Priority Priority Rename Delete

» B TriggerSchedule
B Save O Refresh

Short summary is in the middle of the page
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Make the logic to control the physical point in the PCD device

The previous steps are describing how to add and configure the needed schedulers.
It is needed to transfer the Schedulers combined Out value to the data point which
is really communicated to the PCD Device. This point is called Enable_Light in the
Saia PCD Supervisor. In the PCD Device the application program monitors this Flag
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is
nobody in the building. During the specified time the Calendar Schedule output will be
high. We need to negate the output of the Calendar Schedule to get the correct logic.

1. Navigate in the Nav tree to the Scheduler folder.

2. Double click to the Scheduler folder. The Wire Sheet pops up.
3. Open the kitControl Palette.
4

. Drag and drop the “And” and “Not” function block form the Logic folder to the Wire
Sheet.

5. Connect the function block together as the picture shows.

<> Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Wire Sheet Help

= O & My Network Calendar_Schedule_Light  [r5) Not [1]
Calendar Schedule Mot

Status {ok] Out. true fok]
B+ Datapoints Poll Scheduler in ~{null] In Talze {ok)]
-~ Out false [ok]
¥ Points Next Time D1-Aug 17 1200 AM CEST|
Next Value true [ok}|
©) analoginput_1 |
© oigitalinput_ a

@ Digitalinput_1

true {ok}|
- Weekly_Schedule_Light m
© oigitalinput_2 Goolean Schedule

HEHE
B

true [ok]]

@ pigitalinput 3 tatus Tok]
@ pigitalinput 4 nut m-ﬂ
@ pigitalinput 5 Nt Time Z6-Jul-17 500
@ oizitalinput &
© oigitalinput_7
© enable_Light
[F Proxy Ext
@ alarms
D Histories

[l Device Infarmation

Gl Alarms Poll Frequency
6 secipnetwork
€ BacnetNetwork
@ apes
© schematics
© schedulers
BB weekly_Schedule_Light
BB calendar_Schedule_Light

The Out pin of the And Function box must be connected to the Enable_Light pin
IN16. But these Function Boxes are located in two different Wire Sheets.
We need to link these two pins together.

6. Open the Wire Sheet for the Scheduler folder (if it is not open). And select the And-
Function Box.
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7. Right mouse click to the Out pin of the And Function box, then select the Link
Mark command from the context menu.

Wire Sheet
Calendar_Schedule_Light Mot
CalendarSchedule E | hot n l
o] true [ok
In falze [ok]

Weekly_Schedule_Light m
Boolean Schedule

Edit Tags
Make Template

Cut Ctrl+X
Copy Ctrl+C

Paste Ctrl+v

Paste Special
Duplicate
Delete

Link Mark

Link From "And"

Link To "And"

8. Navigate to the Points folder of the Device where the Enable_Light point is located.

9. Right mouse click to the Points folder and select the Wire Sheet form the views
menu.

10. Organize the Function Boxes on the sheet to get some spaces between them.

At first time you open this Wire Sheet the Function Boxes which are represent-
ing the Points in that folder are overlapping each other. The Function Boxes are
configured that way that the Out, In10, In16 pins are visible. Right now these pins
are enough for our work. But keep in mind that, the visibility of the pins are config-
urable, so many other pins can be set to be displayed.

The meaning of the pins can be checked deeply in the Niagara manual.

11. Right mouse click to the In16 pin of the Enable_Light Function Box.
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12. Select the Link from “And” command form the context menu.

<®» Saia PCD® Supervisor

File  Edit Search Bookmarks Tools Window  WireSheet Help

N B O0O- o n O G w- 2 % @ 0B X &
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Drivers . SBCSystems . SBClpMetwork_Demao
- Nav Wire Sheet
Enable_Ligh!
l::s G @ My Metwork LJ]BwI.eanWr'rhh
@ Services :
Views
6 Drivers !
6 NiagaraNetwork Actions
© secsystems ) i

6 SBClpNetwork_Demao

X TuningPolicies Make Template

Analoginput_
° Devicel fhmenciii=t: FE Cut Ctrl+X
o Alarm Source Info Ctrl+C
4= Datapoints Poll Schedul
I atapointsFo eduler EEEtE |::trl+"'il
% Points
Paste Special
GAnaloglnput_l =f}
i Duplicate Ctrl+D
@ pigitalinput_ b Ak
o Digitalinput_1 Delete Delete
o Digitallmput_
o Digitalinput_2 Boolean Writab Find
@ pigitalinput_3 ol
o Digitalinput_4 | Link Mark
e —____ LinkFrom "And"
o Digitalinput_5 Digitalinput_ =
© pigitalinput foniinel

13. In the pop-up window the link between the two Function Boxes must be defined as
the picture shows. The link can be checked by reading the text at the bottom left
corner of the window.

™ Link X
And [Source] Enable_Light [Target]
Facets = ing
|— Out s |nl0
[ NullOn Inactive = In11
Propagate Flags = |nl2
== nA = |n13
w0 B e nld
-
= |nC == nl5
== |n D = |n16
e Fallback
Owverride Expiration
Min Active Time
Min Inactive Time
[ SetMin Inactive Time On Start
Link And.out-» Enable_Light.in16
OK Cancel

14. Click OK. The pop-up will be closed

15. In the Wire Sheet check the marks of the link and also check that the link is live. It
means that the Points/Enable_Light function box In16 pin follows the Schedulers/
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And Function Box Out pin of the And function box.

@ Saia PCD® Supervisor

<@ Saia PCD® Supervisor

File Edit Search Bookmarks s Window

Wire Sheet  Help File Edit Search Bookmarks Tools Window  WireSheet Help

@ wyetwork
w apps -
Q schematics O orivers
© schedulers O NisgaraNetwork
B Weekly_Schedule_Light © secsystems
B Calendar_Schedule_Light @ sccipNetwork Demo
Bnot X TuningPolicies
Bland @ oevicet
B Files © alarm sourcelnfo
(&) Hierarchy = Datapoints Poll Scheduler
@ History £ points

16. The state Out pin of the Enable_Light function box normally follows the state In16
n pin. The Out pin shows directly which value is downloaded the PCD device.

17. If the state of the Out pin has different value then the In16 pin the following can
happen.

A. The Out pin is forced by operator -> set back to Auto

Wire Sheet

fiEnable_Light qu
Boolean Writab

Out_ truefok @1

In1d - Tl

®[in1e true {ok
| Actions P Emergency Active
Digitall Ju f Inactil
Edit Tags Emergency Inacti

Out true [alarm,unac l ETTIEFEEF'I cy ﬂthD

Make Template S
Active

: Ctrl+X e
Analoginput_ CtrlX Inactive
Numeric Writsb

Ctr+C  Auto

B. - Other higher level of InX pin is getting value from somewhere.
- Check the logic if it is valid

Wire Sheet

EGI}igihllnput_ q] Enable_Lighd
Boolean Writab Boolean Writab
Qut falsejdt[@deﬂ%ﬂut false Jok] @ 10
In10 = {rull} In1o falze {ok}

Ini& —{rull} & Ini6 true fok
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C. - Inside of the Function Box other InX pin is selected with value to override
the output.

- To check it double click to the Function Box.
The prioritized override technique of the Out pin is described in the Niagara

manual.
- The picture shows that, In2 overrides In10 and In16 to command the Out
pin.
. Drivers I SBC Systems o SBClpMNetwork_Demo : Devicel . Points . Enable_Light
Property Sheet
© Enable_Light (Boolean Writable)
[ Facets trueText=true falseText=false 3 @) -
[3 Proxy Ext SBCProxyExt
[l status {ok}
@ Fault Cause
W Enabled @ true
M Device Facets » o -
W conversion 12 pefault

Ml Tuning Policy Mame  |Default Policy

w= Read Value false {ok}

= \Write Value false {ok} @ 2

[ Memory Address 999

ii Data Format Boolean
== Out false {ok} @ 2
= |nl - [null}

false [ok] E3

w=in. [ null .fﬂlse
= n3 - {mll} ¥
— nd - [null} ¥
== |n5 - {mull} ¥
= |ng - {mull}
= |n7 - {null} ¥
= |ng - [null}
= ng - {null} ¥
== |n10 false [okl ¥
= nll - {mll} ¥
= nl2 - [mull} ¥
- nl3 - {mull} ¥
= nld - {null} ¥
= |nl5 - {null} ¥
== |nl6 true {ok} ¥
m= Fallback true {ok} ¥
W Override Expiration null
[l Min Active Time +00000h 00m 003 =
(@l Min Inactive Time +00000h 00m 003 2

ﬁ Set Min Inactive Time On Start . false
[ Media Type Flag
[l comments

g Refresh D Save
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6.4.9

Make the logic to control the physical point in the PCD device
using reference between the schedulers.

The previous steps are describing how to add and configure the needed schedulers.
It is needed to transfer the Schedulers combined Out value to the data point which
is really communicated to the PCD Device. This point is called Enable_Light in the
Saia PCD Supervisor. In the PCD Device the application program monitors this Flag
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is
nobody in the building. During the specified time the Calendar Schedule output will be
high. We need to negate the output of the Calendar Schedule to get the correct logic.

There is another more elegant way to make the connection between the Calendar
Scheduler and the Weekly Scheduler. The way is to define reference between them.

The Calendar Scheduler is higher in priority, so we need to make a reference from the
Weekly Scheduler to the Calendar Scheduler.

—

. Navigate in the Nav tree to the Scheduler folder.

N

. Doubile click to the Scheduler folder. The Wire Sheet pops up.

w

. Double click to the Weekly_Schedule_Light. This will open the configuration win-
dow of the Scheduler.

N

. Click to Special Events at the bottom of the page
. Click to Add

[©2Ne)

. In the pop-up window go to the Type and select Reference then click to OK.

o Add X

Name Ewvent
Type Date

Date

Any Jul 2017 H:
Date Range m

Week And Day
OK Cancel
Custom

7. In the next pop-up window it is possible to select to which Scheduler the reference
must be added. Here there is only one scheduler listed. Select Calendar_Sched-
ule_Light then click OK.

mr Add X

Mame Event

Type Reference

Calendars

slot:/Schedulers/Calendar_Schedule_Light

oK Cancel ‘

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG

Creating/Engineering a project

General functions

8. The Event = Reference to the weekly scheduler is added. But it is “Unscheduled”,
can be seen in the right side.

<@ Saia PCD® Supervisor

File Edit

127.0.0.1(Demo_Station) . Station (Demo_Station)

&) My Network
——
» (D Histories
» [ DeviceInforn
» Gl AlarmsPoll F
» ) sBCipNetwork
b @ BacnetNetwork
» @ apes
» Q) schematics
+ O schedulers
b BB weekly_Schedule_Light
B calendar_Schedule_Light
» & Files
b [E=) Hierarchy
b @ History

- Palette
w X 3 |# rtcontrol

Q conversion
b 0 Energy
b QHvac

O Latches

GE

i Confiz @ Schedulers  © Weekly_Schedule Light /  Scheduler ~

4 PrevPage 4 PrevMonth  Today | NextMonth p

Sep 2017

Next Page P

Jul 2017

Name Summary Unscheduled

3:00AM

Event Reference: slot:/Schedulers/Calendar_Schedule_Light

6:00AM
Switch_Off_due_Test Date:1Sep2017

9:00AM

12:00PM

3:00PM

6:00PM

9:00PM

EventStart [02:24 EM
EventFinish 02:24 B4
® Add @ Edit Priority W Priority [I] Rename 3 Delete Event Output [] null | true

[ Weekly Schedule | [#f] SpecialEvents | [H] Properties  (E) Summary

[™] save 7 Refresh

9. We need to define that during the Holidays, when the Calendar_Schedule_Light
is high the Weekly_Schedule_Light must be low. For that the complete time range
has to be defined to false.

127.0.0.1(Demo_Station) . Station (Demo_Station)

() My Network

Py

b (D) Histories
» [ DeviceInforn
] “ Alarms PollF
» 6 sBCipNetwork
b Bacnethetwork
» @ apes
b 0 Schematics
+ ) schedulers
b B weekly_schedule_Light
BB calendar_schedule_Light
» & Files
b [E) Hierarchy

b @ History

- Palette
W X 3 |#§ vicontrol

Q conversion
Q Energy
Q Hvac

O Lstches

: Config

. Schedulers  : Weekly_Schedule_Light #  Scheduler ~

4 PrevPage 4 PrevMonth  Today | NextMonth p

Aug 2017

Next Page P

Jul 2017 Sep 2017

w bt I s
4 5
11 12

18 19

Name Summary

3:00AM
Event Reference: slot:/Schedulers/Calendar_Schedule_Light
6:00AM
Switch_Off_due_Test Date:1Sep2017
S:00AM

12:00PM
3:00PM

6:00PM

EventStart |02:30 EM
EventFinish |02:30 EM

® Add @ Edit Priority W Priority [I] Rename 3 Delete Event Output [ ] null | false

[ Weekly Schedule | [#f] SpecialEvents | [H] Properties  (E) Summary

7 Refresh

[™] save
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10. Save the settings

11.

12.
13.
14.

Test the configuration by adding the today to the Calendar_Schedule_Light. This
means create today as Holiday day.

Check that the Weekly _Schedule_Light Out pin goes low.
Remove the test setting from the Calandar_Schedule_Light.

Create reference between the Weekly Schedule_Light Out pin and the Enable_
Light In16 pin in the same way as it was described above.

As you see the Not and the And Function Boxes are not needed to realize the
same function.

@ Saiz PCD® Supervisor
LS {:]
File Edit Search Bookmarks Tools Window WireSheet Help SSPEDS SUpSNES
= File Edit Search Bookmarks Tools Window WireSheet  Help
4 O- o A C [ -~ = O
127.0.0.1 (Demo_Station)  © Station(Demo_Station)  : Config  : Schedulers
N 127.0.0.1 (Demo_Station)  © Station(Demo_Station) @ Config  : Drivers  : SBCSystems
- Nav Wire Sheet
- Nav Wire Sheet
L O @ my Network Calendar_Schedule_Light  f17) 9
= P s Enable_Lighi
= Sats o ¥ O @ My Network Semeanitign @
O Histories n ~ [rull . Ot false(oq @3]
Out false {ok] In10 = {ruill}
[l Device Information NestTime SiAuEA7 1250 A 10 alsrm Source Info ©{ims Trve fokd
NextValue ‘true Jok]
Gl Alarms Poll Frequency B¢ Datapoints Poll Scheduler
 seciphetwork % Points
6 Bacnethetwork © Analoginput_1
Apps faakly_Schedule Light @ oizitalinput_
Joolean Schedule "
© schematics @ vigitalinput_1 e
Numeric Writab
Q) schedulers O vigitalinput_2 e
B8 Weekly_Schedule_Light @ vigitalinput_3 . i
B calendar schedule Light B nicitalinnut 2
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6.5 Connect to 3rd Party Systems

If you have purchased an OPEN license and want to use values from non-Saia Bur-
gess Controls systems it is necessary to connect to the 3rd-party systems and add the
required points to the Saia PCD® Supervisor database.

6.5.1 Add the Required 3rd Party Drivers

1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers (Driver

Manager). n

4. Click on the New button. The New dialogue box is displayed.

m» MNew >

Typeto Add 6 Bacnet Metwork
Mumberto Add |1 [1-100]

OK | Cancel |

In the Type to Add box select the required driver, e.g. ‘BacnetNetwork’.

5. Click OK. The following dialogue box is displayed.

" MNew >

Name Type Enabled i

eﬂacnetNetwcrk BacnetNetwork  true

. Name BacnetlNetwork

. Type Bacnet Network
. Enabled ‘ true
0K Cancel

Change the default network Name to be a meaningful name.

6. Click OK. The Driver Manager will now show the driver.

Name Type Status  Enabled Fault Cause
6Niagaral~letv.'nrk Miagara Metwork {ok} true

) Bacnetietwork  BacnetNetwork  {ok} true

7. You now need to configure the driver
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6.5.2

6.5.3

6.5.4

6.5.4.1

Configure 3rd Party Drivers

The configuration of each 3rd party driver is different, refer to the Tridium Niagara docu-
mentation for the details of the driver.

Add 3rd Party Points to the Database

The method of adding points to the database for each 3rd party driver is different, refer
to the Tridium Niagara documentation for the details of the driver.

Using the BACnet Driver

The ability to use values from a BACnet system is quite common and is supported by
Saia PCD® Supervisor. This section provides an overview of how to use the BACnet
driver with Saia PCD® Supervisor. For full details refer to the Tridium Niagara documen-
tation.

Configure the BACnet Driver
1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers
(Driver Manager).

4. In the Nav tree open the folder for the already added BACnet driver (BacnetNet-
work) and double click Local Device.

5. Set the Object Id to the Saia PCD® Supervisor address on the BACnet network
(range 1-4194302).

Property Sheet
Bl Local Device {Local Bacnet Device)
(@ Status {fault}
Ml Fault Cause Invalid Object ID
[l Object Id device =i

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG Creating/Engineering a project

Connect to 3rd Party Systems

6. In the Nav tree open the BACnet Comm folder and double click Network and ex-
pand the IP port section also the adapter has to be chosen.

Property Sheet
Q Bacnet Comm (Bacnet Stack)
[l comm Control  Enable
l—] Client Bacnet Client Layer
li Server Bacnet Server Layer
li Transport Bacnet Transport Layer
[ Network Bacnet Network Layer
@ Router Table Bacnet Router Table
'. Ip Port NetworkPort: id=1 net=1 enabled max=2...
@ Network Number |1
-. Link B/IP (none:0xBACO) Standard
[ Adapter Thinkpad USB 3.0 Ethernet Adapter
(W Ip Address none
(W Udp Port 0xBACO
m Ip Device Type Standard
[l Bbmd Address null
W Registration Lifetime +00000n 15m 005 3
ﬁ Broadcast Distribution Table  BDT: 0 entries
(W Foreign Device Table Foreign Device Table
[l Bbmd Debug @ false
W Status [fault}
r‘ Fault Cause java.lang.IllegalStateException: BACnet/
Id— Poll Service BacnetMultiPoll
[l Max Devices max
m Enabled . true
@ Port1d 1
W Port Info Annex J IP
[ Routing Enabled @ true
[l Maintain Routing Enabled @ false
[ Minimum Router Update Time  [s00 ms
[ Router Discovery Timeout 5000 ms
@ Termination Time Value 120 s

7. Set the Network Number to 1.
8. Set Enabled to true.
9. Click .

File Edit Search Bookmarks Tools Window  PxEditor Help
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6.5.4.2 Discover and add BACnet Devices

In the Nav tree, open the Drivers folder and double click the BACnet driver. The view
pane will display the Bacnet Device Manager.

1. Click to Discover

The Configure Device Discovery dialogue box is displayed.

File Edit Search Bookmarks Tools Window Manager Help
127001 (Demo_Station)  : Station (Demo_Station)  : Config  : Drivers  : BacnetNetwork
P o @ My Network Discovered
)y tasts st oo glsbel s honepwelLeom Device Name Device D Netwk MACAddr Vendor Model Objects
@ 127.0.0.1 (Dema_station)
& station (Demo_station)
A Alam
© config
@ services
 orivers
N Network
O niagsraniervon «® Configure Device Discovery X
Q) sBC systems )
) Bacnetietmork (Wl Device Discovery Config
il Locinevie i Device Low Limit ]
W o, [ Device High Limit 4194302
= sendGlobalz | SelectAll | ClearAll
i clent (W Networks o
[ server [
[ Transport (@i Wait Response Time 10 s
(B Wetwark oK Cancel
[ Router Table
[l ioPort
3 Monitor Database
X Tuning Policies Name Exts DevicelD Status MNetwk MACAddr Vendor Model FirmwareRev App SWVersion
© Apps
& Files
Hierarchy
@ History
- Palette
W [X] B @ sbeofflinetngineering
S New Folder [) New # Edit M cancel
' Ssis PG5 Data Import Wizard
[ oo ]

If the address range of controllers is known then the Device Low Limit and Device
High Limit can be edited to reduce discovery time.

2. Click OK.

The discovery process starts. A progress bar at the top of the pane indicates the
status of the discovery. Once the discovery is complete the devices that have been
discovered are displayed in the Discovered list.

> Job Log

Status Timestamp

o Running 13-Apr-17 11:00 AM CEST

m Message
m Message
m Message

13-Apr-17 11:00 AM CEST
13-Apr-17 11:00 AM CEST

13-Apr-17 11:00 AM CEST

Message

Finding BACnet Devices...

Who-ls: Local Broadcast All Devices

Found BACnet device (object!d device:1) at address 1:172.23.13.4:47808...

Reading parameters for device:1, 1of 1

ok

Details
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During the discovery process you can click on the »» button at the top
right corner to display a Job Log giving details about the discovery pro-
cess so far.

In the Discovered list select the device(s) from which values are required. To
select more than one device hold down the CTRL key and click on the required

devices.

<@ Saia PCD® Supervisor

File Edit Search

127.0.0.1 (Demo_Station]

Bookmarks

: Station (Demo_Station)

Tools

: Config @ Drivers

Window

Manager  Help

. BacnetNetwork

~ Nav

 C

(%) My Network

» (@ My Host: SZ43LTJ06GWF2 global.dshoneywell.com

@ 127.0.0.1 [Demo_Station)
& station (Demo_station)
A alarm
© confie
@ services
 orivers

6 Nisgarahetwork

© s systems

9 Bacnethetwork
Bl LocalDevice

@ /* Bacnet Discover Devices

Discovered

Device Name DeviceID Metwk MACAddr Vendor Model Objects

;Tramir\gscentér device:1 1 172.23.13.4:04BAC0  SBC Saia Burgess Controls PCD3.M5560 244

The discovery will also find SBC Saia Burgess Controls deivces that have
BACnet compatibility. In order to easily identify these devices sort the list
by Vendor by clicking on the Vendor column.

Click Add or drag the selected device(s) to the Database list.
The Add dialogue box is displayed.

File Edit Search Bookmarks

P ® wyetwork

@ My Host: S243LTJ0BGWF2.global.ds honeywell.com
© 127.00.1 (Demo_Station)

- Palette
@ [x] B @& sboofflineEngineering

B ssia PGS Data Import Wizard

Manags

er  Help

@ Bocnet Discover Devices

Discovered
Device Name Device D Nebwk MACAddr Vendor Model Objects

i Trainingscenter  device:1 1 172.23.134:06BAC0 SEC Saia Burgess Controls  PCO3MSS60 244

<@ Add X
Name Type DevicelD Netwk MAC Addr Ensbled UseCov Max Cov Subscriptions &
i Trainingscenter] HonBacnet Device device:l 1 172.23.13.400BACO  true true max
[ Name =
[f Type Hor
[ Device ID Gevice 1
[l Netwk B [0-55535]
(g MAC Addr 172.23.13.4: 0XBACO
[l Enabled @ true
[ use Cov @
(il Max Cov Subscriptions  max
oK Gancel
Database
Name Exts DevicelD Status Netwk MAC Addr Vendor Model FirmwareRev  App SW Version

172.23.13 4:04BACO

& Teningscenter @O @O @ cevieer LB 1

KaNewrolder | [INew | #cdit @ Discover | M Concel _@Add | b Maich
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Review the settings for each device:

e |f required, change the device name in the Name box.

e [f multiple devices are listed, click on the device in the list (to highlight it) to view

its settings.

Check that the required devices have been added.

6.5.4.3

Add the required BACnet Points to the Database

This process allows you to add points, alarm configuration, schedules and histories

from previously discovered devices.

1. In the Nav tree, open the Drivers folder and double click the BACnet driver. The

view pane will display the Bacnet Device Manager.

2. In the Exts column of the Database list double click the required icon.

@ = Points
O -
(i

O -

The BACnet Point Manager is displayed.

Alarm Configuration
Schedules
Histories

@ Saia PCD® Supervisor

File Edit Search Bookmarks Tools

Window ~ Manager  Help

fvers @ BacnetNetwork  : Trainingscenter  : Points

Database

® Myhetork

@ My Host : SZ43LTJ0BGIWF2.global.dshoneywell.com
@ 127001 (bermo_station)
B station (Demo_Station)
A Aam

© 2005
@ Files
Hierarchy
@ History

- Palette
W [X] B | # sbofflineEngineering

=) soio PGS Data Import Wizard

Name Out ObjectiD PropertylD Index Read Write

3. Click Discover

R rolder]| | Qines)| | @it | oissover| | W cancell| | @adal] | B winicn| | @ agic
— I
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4. The discovery process starts. A progress bar at the top to the pane indicates the
status of the discovery.

Once the discovery is complete, points are displayed in the Discovered list:

it Search  Bookmarks Tools Window Manager Help

o O- o a O O - B ¥ @ 0B X

| station)  : Station (Demo_Station)  © Config  : Drvers  © Bac k  : Trainingscenter  : Points

© / sanetbiscoverpoints
@ yetwork Discovered
e . Object Name Object ID PropertylD Index Value Description
T sc___ac o1 as. multstatevaluet  presentisiue 1 sscmuen sfungot
sc___ac Lo AKsas_ multstatevalues pr 2 sscmuen sfungor
s o1 Fricas mulistatevslue2 presentislue 2 sscmuen shungor
SBC. :TC, *PCD_ ABSISBY:HMI multiStateValue:l  presentValue 3 SBCMurten
sc___ac peo_amssaiim multstatevalues  presentisiue s sscmuen
e Lo p—— oop 000 sechuren sfungor o2Regler
e Lo vE_RL_T_PD oopss : 10000 sschurten shungor
SBC_ :TC 101, VE_:PID loop:5 100.00  SBCMurten’ Luftung01 Regler
SBC_ :TC, 01, WT_:PID loop:4 15.00 SBCMurten aftung01 Regler
e Lo koD oo . 000 secmuren sfungot
e Lo FrRT_P1D oopz2 resentisioe 200 sschurten sfungot " Regler
sc___ Lot ABLD_PD Pyree—— LT Lofungor
SBC. :TC. 101, RL_T__:PID 0.00 SBCMurten aftung01 E
Osc____xc Lo " nsctve SCHurten sfungot
Osc e Lot T_MOTSMRM_ ;1 Inoctive SBCMurten sftungor
Cancel
Database
Nome Out ObjectiD PropertylD ndex Read Write

5. In the Discovered list select the required points (values). To select more than one
point hold down the CTRL key and click on the required points.

Remember that Saia PCD® Supervisor is licensed for use up to a specific

n number of points. It is good practice, therefore, to only add points that are
actually required. Adding points that won’t be used by Saia PCD® Super-
visor will not only waste resources but also generate unnecessary extra
network traffic.

6. Click to Add or drag the selected point(s) to the Database pane.

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22  §-107



Creating/Engineering a project Saia-Burgess Controls AG

Creating Schematics (Operator Views)

7. The Add dialogue box is displayed.

Saia PCD® Supervisor automatically chooses the most suitable writable
point type. However, this can be manually changed by selecting a point in
the list and choosing a different Item Type

o Add *
Name Type Enabled Object ID Property ID  Index Tuning Policy
Q SEC, TC :PCD AULT__ 1 MumericPoint  true analoginput:0  PresentValue -1 defaultPolicy
m Name SBC =iE :BCD,

m Type Humeric Point

m Enabled . true

[ Object ID Lnalog Input 0
E Property ID Present Value

m Index k

ﬁ Tuning Policy Name Defzult Folicy

E Data Type REAL

[l Read unsubscribed

E Write readonly

m Device Facets min=-inf *C,max=80.0 °C,precision=1"C,units="C,re... >> ol
E Facets min=-inf*C,max=80.0 °C,precision=1*C,units="C,re... >> ’9 ~
m Conversion TE Default

OK Cancel

8. Click to OK
9. The selected point(s) is added to the database.

Fle Edit  Search Hookmarks Tool

o/ HonBoenetPointManager -

- Nav 7 @ esnctbiscoverroints Success ) [¥]

[T e ] ® oy Network Discovered 192 objects

© My Host: SZABLTIOGGIF2.globaldshoneywell.com Otiect . Frepsty D Sinds: g
malosionuis sl

~ @ 127.00.1 (pemo_station) E
polec ) X BuluftmotorDrehzahlRackmeldung.

[chulungsiaum Temperatur Sollwerttcler
Name. Type Ensbled ObjectiD Property

Keffeeraum Temp.
multStatelalusé  PresentV

fchulungsraum Temperatur

blufidruck

Juttdruck.
presenty.

VorerhitzerRochsuftemperstur

e,
.

B m_
enumroint Presency
) B LocalDevice INES E 101 et Roluftemperstur
t y
-8 o BQec___mc__anaum
g o
LINE"S e, 101 RoaT Bitzungsraum Temp.
3 o
.INE"S T 101 vt mperatur
3 o
B0 e 101 w00 eratur Mitehwer o FreieKahlung
¢ o
@ dsec . o1 e Fohrungstemperatur Mittelwert
o1 AIRT_p1D ¢ o
B0 e 0w
o1 AP0 v P
Database Lo, RLT_PD 3 P Oabjects
Nome Out ObjectD PropertyID Index Lo FRIUMREN BooleanFoint  tue  binanveluesT  Presenty g

e
& Eoslesnpomt  tue  binsvaliess  presenty

» ©vinu

© i d o

> @ schedules ¢ o

» ©Trendtog ¢ o

» Bcontie ¢ ”

© hors i o

b @i

B termreny d i

@ ristory E e
W e Soolemnpomt e bnaweluess  presenty
w1 or_sse_kon toolemnpomt e bnasweuest  presenty
‘o1 AT sy Boclempoint e Woaoueds  presenty

ok | _cancel
- Palette [2a]

W X D |§ soconetngneenng

Y s s Datimport iz

MaNewrouder | QNew | ot viscover | M Concel [(@add | Busich @ Tagt

10. Repeat the above process to add points for each controller.
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6.5.4.4 Enable Honeywell BACnet Service

The Honeywell BACnet service must be enabled if you want to use the SBC specific
Add-ons provided by the SBC BACnet Utilities driver. This step must be done before
creating the BACnet network.

Enabling the service includes 2 steps:

1. Adding the service to the Services tree

2. Enabling the service on its Properties Sheet

In SBC NX 4.2.xx.xx.x.x and lower, the service is already added to the Services tree by
default. In SBC NX 4.3.xx.xx.x.x and higher, the service is not available by default and
must be added to the Services tree manually.

When using a station from a previous project in SBC NX 4.4.xx.xx.X.X, n
the Honeywell BACnet Service is available in disabled state as shown in
the Services tree and on the Properties Sheet. If available, the Honeywell

BACnet Service can be enabled/disabled at any time on the Properties
Sheet

6.5.4.4.1 Procedure to enable Honeywell BACnet Service

1. In the Palette tab at the bottom, select honBACnetUtilities from the drop-down
listbox, then open Services, and then drag&drop the HonBACnetService item to
the Services folder.

L o (%) My Network

e Config
@ BackupService
@ CategoryService
O JobService
@ RoleService
O userservice
- Palette
W [X] 3| @ honBAChetutilities
O alsrm
O Services

. HonBacnetService

Result: The Name dialog box displays.

55 Name I&w

@ HonBacnetService
0K Cancel
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2. Change the name if desired, and then click OK.

Result: The service is added to the Services folder.

e Config
@ Services
0 AlarmService
@ BackupService

@ CategoryService

WebService
7T PlatformServices

. HonBacnetService

n 3. Double-click the HonBacnetService in the tree.
- Nav [71  Property Sheet
P O ©) My Network (M HonBacnetService (Hon Bacnet Service)
== W Enabled @ false

B) Templateservice
© webserice

Y PlatformServices

(il Running @ ialse
- Fault Cause

[l HonBacnetservics

4. On the Property Sheet on the right, select 'true’ in the Enabled drop-down listbox.

Property Sheet
@l HonBacnetService (Hon Bacnet Service)
M Enabled @ true
[ Running @ false

[ Fault Cause

5. Click the Save button at the bottom.

Result: The service will be started indicated by "true” setting in the Running drop-
down listbox.

Property Sheet

(M HonBacnetService (Hon Bacnet Service)
M Enabled @ true
. Running @ true
[ Fault Cause

6. Continue by creating the BACnet network.
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6.6

6.6.1

6.6.1.1

Creating Schematics (Operator Views)

Creating Schematics (Operator Views)

Schematics within Saia PCD® Supervisor are known as Operator Views
(Presentation XML -- Px).

This section describes how to create the most commonly required features of Operator
Views. For more in depth information please refer to the Tridium documentation.

It is recommended that you create a template page that contains features that are
needed on each page, e.g. a logo, outside temperature, navigation buttons, etc. It is
also recommended that you create a folder to store all the Operator Views, and another
folder to store any images used on the pages.

The following steps are required to create Operator Views:

Prepare the folder structures

Preparing a good folder structure for the used Images and Operator views will help
keeping the project clear and understable. The engineering work will be faster because
used elements can be easily found.

Create a Folder for the Operator Views

Operator Views can be created at any point within Saia PCD® Supervisor e.g. added to
a folder, device or a module. However, this can make engineering unnecessarily com-
plicated so it is recommend that a folder is created to contain them.

1. In the Nav tree open localhost > Station.

2. Right click Config and select New> Folder. The Name dialogue box is displayed.

- Nav #A px
P o () My Network

@ My Host: 5743 TIDBGWF2.global.ds.honeywell.com
@ 127.0.0.1 (Demo_Station)
@ Station (Demo_Station)
A Alsrm
6 Config

MName- Type

© orivers «®» Name x

Owlagarawetwork ® Schematicsl
© sBCsystems
OK Cancel

© secipNetwork_Demo
6 Bacnetietwork
6 secipNetwark
© 2pps
A Files
Hierarchy
@ History

Specify the folders’s name e.g. ‘Schematics’.

3. Click to OK.
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6.6.1.2

6.6.1.3

6.6.1.4

Create a Folder for the Images

1. In the Nav tree open 127.0.0.1(localhost)>Station(Demo_Station).

2. Right click Files and select New> Folder. The Name dialogue box is displayed.

P

EO O @ My Network

@ My Host: SZ43LTJ0GGWF2.global.ds.honeywell.com

B owi

@ 127.0.0.1 [Demo_Station)
# Station (Demo_Station)
.‘ Alarm
e Config
@ Services
6 Drivers
6 NiagaraNetwork
© sBCsystems
6 SBClpNetwark_Demo
6 BacnetMetwork
 secipNetwork
@ apps
O Schematics
& Files
@ Hierarchy
eHistor}‘ <™ Name for Mew Folder

@ Images

oK Cancel

3. Specify the folders’s name e.g. ‘Images’.

4. Click to OK.

Prepare Images

Any external images that are to be used on Operator Views must be created using a
3rd party graphics package and sized to the size required on the Operator Views.

Once the images have been added to Saia PCD® Supervisor they cannot be
changed. SVG (Scaled Vector Graphics) images can be used and scaled inside in the

Saia PCD® Supervisor.

Add Images to Saia PCD® Supervisor

To use images within Saia PCD® Supervisor they must exist within the file structure of

Saia PCD® Supervisor.

1. In the Nav tree open My Host > My File System and navigate to the file that is to
be added (this could be a folder containing multiple graphics).

2. Right click the file or folder and select Copy.

3. In the Nav tree open My Host > Station(Saia PCD Supervisor) > Files and navi-

gate to the location the image(s) are to be stored

4. Right click the location (e.g. images) and select Paste.
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6.6.1.5 Customize the basic PX Template Page

Operator Views are created using the template PX Page (located - My Host > Sys
Home > defaults > workbench > newfiles > PxFile.px). By editing this page all future
Operator Views created will have this format.

1. In the Nav tree open My Host > My File System > Sys Home > defaults > work-
bench > newfiles.

2. Double click the PxFile.px file.

3. On the menu bar click the # icon to switch to PX Editor view.

File Edit Search Bookmarks Tools Window PxEditor Help

My Host: SZ4SLTIOBGNF2 globildshoneywellcom  © MyFileSystem  © SysHome  © defaults  © workbench  © newfiks  © PFlepx
¥ ) vy Network
@) My File System
A sysHome -
© usertiome ® Properties X
Oc CanvasPane ‘ R
e £ Canuaspane
O background [ ] defaut)
gz halign Center width |00 [0.00-10000.00]
oMmemES layer Height |s00] [0.00-10000.00]
! Flatforn scale None ok | cancel
@ 127.00.1 (Demo_Station) walign Center
& station (Demo_Station) viewsze  |500.0,4000 E
A i visible  [tue
© config
@ seviees _ok | st
6 orivers T
6 HisgaraNetwork
Q sBesystems
 sBCipNetwork Demo
6 Bacnethietwork
6 ssciphetwork
Aum
© schematics
B ries
Q resources
() saia_PCD_Supenvisor_Sbus Demo HC
Q offline
I

n The grid in the middle of the screen is the viewable area of the page.

4. Design the page layout as required.

5. Save the file (select File> Save, or press CTRL+S).
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6.6.2

Create a

PX Page

Operator Views are created by making a new view of an element in the Nav tree and
once a PX view is added it is the new default view of the element.

Operator Views are stored in the Saia PCD® Supervisor file structure, but are linked to

the element where the view has been attached.

To keep structure simple it is a good idea to create subfolders. These subfolders hold
the various schematics you want to create.
1. In the Nav tree open 127.0.0.1(localhost) > Station > Config and navigate to
where the PX Page is to be located

2. Right click the folder and select New > Folder. The Name dialogue box is dis-
played.

3. §pecify the page’s name e.g. ‘HeatingCircuit1’.

4. Click

* Nav
* C

@ My Host: SZ43LTJ06GWF2.global.ds.honeywell.com

@ My MNetwork

Q My File System
0 My Modules
& Platform

@ 127.0.0.1 {Demo_station)

# Station (Demao_Station)
._‘ Alarm
6 Config
@ Services
e Drivers
© apps

o Schematics

© HestingCircutit

Q Files
O Images
O offline
O
O resources

&1

o Name

® HesatingCircuitl

OK Cancel

© saia_PCO_Supervisor_Sbus_Demo_HC

OK

A folder is created.

5. Right click the folder you have just created and select Views > New View.
The New Px View dialogue box is displayed.

0000¢%

§1000007

B3 slot sheet

st Name playName  Defntion Fisgs Type
OPiopery 0 MestimgGicatt estingCirutt Oynomic  bejerol

Facets

Enter the name of the page (same as the folder just created) in the View Name

box.

6. Click OK

The PX Page will be created based on the template page.
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Edit a PX Page

The PX Editor is used to edit a PX Page.
1. In the Nav tree locate the PX file and double click on it.
2. On the menu bar click the # icon to switch to PX Editor view.
3. Change the page layout as required

4. Save the file (select File> Save, or press CTRL+S).

Create or Change PX Page Elements

After creating a new PX Page or opening an existing page for editing use the following
procedures to design the page layout and content.

Setting the Page Size and Background
To set the viewable area size:

1. Double click the layout grid to open the Properties dialogue box.
2. Click viewSize to set the visible screen size in pixels (maximum 10000 x 10000).

3. Click OK.

To set the background colour:

1. Double click the layout grid to open the Properties dialogue box.

2. Click the background as required and select either Solid or Gradient and use the
colour picker to set the required colour(s).

3. Click OK.

To set the background image:

1. Double click the layout grid to open the Properties dialogue box.
2. Click the background as required and select Image.
3. Select the required image file and alignment settings.

4. Click OK.
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6.6.3.3 Add Text

1. Right click the page and select New > Label. A label is added to the page.

2. Double click the label. The Properties dialogue box is displayed.
“m» Properties X
Label :]. 2 U
% Label
background l:l #ffffcd
blink false
enabled e
font (default) J
foreground l:l (default)
halign Center
image null J
layer
layout 300.0,20.0,130.0,30.0 |
=
textlconGap 4.00
textTolconAlig Right
valizn Center
visible e
wordWrapEna false

0K Cancel
3. Enter the required text in the text box.
4. Click OK.
6.6.3.4 Add an Image

Add your own image

Images are sized on the screen based on their native dimensions (pixel size) - you can-
not scale the image. Therefore, you may need to resize the image using your preferred
graphics editor before adding to the page.

1. Navigate to the required image using the Nav tree.

2. Click and drag the file to the layout grid and position as required.

It is recommended that any images you intend using in Saia PCD® Su-
pervisor are first copied into a folder within the Station.

As you drag the item on the page two green lines indicate the top left
corner where the item will be positioned.
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Add an Saia PCD® Supervisor Image

Saia PCD® Supervisor has some built in images that can be added to a PX Page.
Open the palette containing the required graphics. The following palettes contains use-
ful images, but there are others available

kitPx Covers elements like — logoff, buttons, PxInclude, line, rectangle
etc

kitPxHvac s a library of various hardware graphics — pumps, boilers etc

kitPxN4svg s similar to kitPx but all the graphics are SVG
(scalable vector graphics)

1. Navigate to the required image using the palette.

2. Click and drag the image to the layout grid and position as required. n

6.6.3.5 Add a Dynamic Object (Value)

1. Navigate to the required value using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select Bound Label.

«®> Make Widget >

" Make Widget
Make a new widget that is bound to the ord.

station:|slot:/Drivers/SBC320Systems/SBCIpNetwork_Demo/Devicel/paints/Heatingl/Qutside/Temperature/Physval

@ Bound Label BoundLabel o 2L 3
<> Include PxFile 2 Bound Label
<> From Palette background [ (defautt)
<> Workbench View — false
<> Properties [e— 0.0 none black [ ]
<> Actions
<> TimePlot Eacbid e
font (default) =
[ Format Text |2out.Value: foreground [~ (defauly)
[ Status None halign Center
[ Hyperlink image ol J
[ MouseOver None layer
[ sorder [o0noneblac | mouseOver |Nene
[# Make Display Name Label padding 0.0 [ ]
T <ord> []]
4.00

texticonGap
textToleanalig Right
wvalign Center
visible true

wordWrapEna false

2 Bound Label Binding
o] <ord>

degradeBehay MNone

hyperlink null
SSSS 5 s5displayNameTtypeDisplayNz |
popupEnable true

statusEffect |None

oK Cancel

5. Select Format Text and choose %out.value% to display the value.
6. Select Make Display Name Label to display the label.
7. Click OK.
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6.6.3.6 Add an Animated Image

Saia PCD® Supervisor has some built in images that can be animated depending on
value from the system.

1. Navigate to the value that is to be linked to the image using the Nav tree.

2. Click and drag the value to the layout grid and position as required.

3. When you release the mouse button the Make Widget dialogue box is displayed.
4

. Select From Palette.

80000000

z
H

. Open the palette containing the required graphics
. Navigate to the required image using the palette.
. Select the required image.

. Click OK.

0 N O O
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6.6.3.7 Add a Setpoint Slider
A slider can be added to enable an analogue value to be adjusted.
1. Navigate to the value that is to be linked to the slider using the Nav tree.
Click and drag the value to the layout grid and position as required.

When you release the mouse button the Make Widget dialogue box is displayed.

> W N

Select From Palette.

[
@ Make Widget X
File Edit Search Bookmarks Tools Window  PxEditor  Help = .
Y, Make Widget
Make a new widget that is bound to the ord.
4 oD O0O- o a O M - =
I R e G station:|slot:/Drivers/SBCS20Systems/SBCIpNetwork_Demo/DevieeLipoints/ 1/Room/ Offset
.0.0.1 (Demo_Station)  © Station (Demo_Station)  : Config  : Schematics
<> Bound Label Slider E 5 o:
<> Include PacFile A
P o (D My Network @ FromPalette enabied true
S o -
P < Workbench View erement11:00
& Properties
A Hesting1 layer
< Actions
0 sk = 100.00
<> TimePlot
EH opMode o 0.00
H outside w X B § ke orientation | Horizontal
A Return .
[ R (& eoundtabel thumbBrush [ (defaut)
upply
Hr [ ActionBution trackBrush  |<ord>
oom
EA Temperature HyperlinkButton = S0.00
© Basesetpoint (Bl Sucaunay visible e
—~
5 RefreshButton
O setpointofrset % setPointBinding
E Web Ej Eparyton o <o
BackButton
® starme degradeBehay None
© Histories P ForwardButton
= = M@ Logoffautton ek [
(B Device Information
Q oatopall [ RebootBution summary  %edisplayName?typeDisplayNe |
ata Poll Frequency
@ Pseudo_Point: [ ButtonGroup popupEnable(irue
seudo_Points
O Bacnethetwork @ analogmeter widgstEvent | octionPerformed
@ secipnetwork il sargreph widgetProper value
=] =P setPointslider
pps
© schemati setPointTogeleButton
ematics
O HestingGircutt: SetPointCheckBox
E i1
@ Properties x
Slider - B %
% Slider
Physval 5.4 enabled true
increment  |2-5¢
layer
layout 20.0,260.0,20.0,150.0
o 3.00
= -3.00
orientation  |Vertical

thumbBrush 1] (default
trackBrush | Stationslot:/Drivers/SBC520Systems/SBCIpNetwork_Demo/Devicel/points/Hi

value G500

visible )

% setPointBinding x
ord station:|slot:/Drivers/SBCS20Systems/SBCIpNetwark_Demo/Devicel/points/Hi

0.9

degradeBehay None

hyperink  |null
summary %displayName?typeDisplayNameds = %.%

popupEnabley rie

widgetEvent |ectionPerformed

widgetProper{ value

0K Cancel

5. Open the KitPx palette
6. Select SetPointSlider.
7. Click OK.
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6.6.3.8 Add a Button to Adjust a Value

1. Navigate to the value that is to be adjusted using the Nav tree.

2. Click and drag the value to the layout grid and position as required.

3. When you release the mouse button the Make Widget dialogue box is displayed.
4

. Select Actions.

1 > Make Widget bl

& ake widser
Make 2 new widieL that s bound 1 theord,

IpNetwork 1 T
Actions

© Emergency Override

oK cancel

5. Select Set.
6. Click OK.
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6.6.3.9 Add a Link to Another Page

1.

© ® N o o

Navigate to the PX Page that is to be linked to using the Nav tree.

2. Click and drag the PX Page to the layout grid and position as required.
3.
4

When you release the mouse button the Make Widget dialogue box is displayed.

. Select From Palette.

4 o O-b Ao 0 =- M0 B % © B X N 2 ¢ 0- Thaaaxg s o8
= o 3 .

- Nav B - Bound Ord|
¥ O ® wynetwork

© vyModules

o etromsscvgin

| octoutven -

ok | cancel

<@ File Chooer

Dfilespaces _

Ouywodiies

N Bookmarks (7]

popupEnable(1ve

ok | cancet

Open the KitPx palette.

Select HyperlinkButton.

Select the Hyperlink check box.
Enter the required text in the text box.

Click OK.
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6.6.3.10

2.

Add a Graph

1. Navigate to the required history using the Nav tree.

Click and drag the history to the layout grid and position as required.

. Select From Palette.

127.0.0.1 (Demo_station) ~ : Station (Demo_station) © Config
e O () My Network
O niagaranetwork
Q secsystems
 secipietwork_bemo
X TuningPolicies
@ Devicel
© 4larm Source Info
¢ Poll scheduler
& Points
@ Alarms
© alerm.myalarmList.MyName
@ nistories
& Logfile
(i Device Information
Qll DataPoll Frequency
© Pseudo_Points
6 BacnetNetwork
O Apps
© schematics
© HeatingCircuitt
& Files
(& Hierarchy
B History
- Palette
w X 3§ ke
[A) BoundLabel
ActionButton
HyperlinkButton
™ savegutton
Z Refreshutton
[3 Exportutton
4 Backsutton
P ForwardButton

: Schematics

© HeatingCircuitl

. When you release the mouse button the Make Widget dialogue box is displayed.

@ chart
(W wbViewBinding
@ circulsrGauge

[0 Hyperlink

@ Wake Widget X
" Make Widget
Make anewwidgetthatis bound to the ord.
station:[slot:/Drivers/SBC$20Systems/SBCIpNetwork_Demo/Devicel/histories/Logfile
& Bound Label WebWidget | ™ 2N 3
<> Include PxFile 2 Web Widget
& From Palette enabled true
< Workbench View s viewwebChart:ChartWidget
<> Properties
layer
& Actions,
visible true
W X B | # webchart 2 whView Binding
ord <ord>

oK Cancel

degradeBehay Mone

5. Open the webChart palette

6.
7.

Select Chart.
Click OK.
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6.6.4 Reuse Operator Views
Operator Views can be reused, saving significant engineering time.
Normally Operator Views are created by using a new view attached to a folder in a
centralised structure. However, as each PX Page is created in the file system in the ‘px’

folder, it is possible for a page to be reused by copying the file in the px folder and at-
taching it to the required folder.

1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page

. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Files > px.

2
3. Right click the PX Page that is to be reused and select Copy.
4

. Right click px and select Paste. The Name dialogue box is displayed. n
127.0.0.1 [Demo_Station) . Station (Demo_Station) . Files Dopx
- Nav
E@ O @MyNetwork

O Pseudo_Points
e BacnetMNetwork
@ apps
0 Schematics
O HeatingCircuit,
OHa
Qe
@ Files
D Images
Q offline
Q px
HC|
B 9
.,
Q resourc Copy
Q saia_rcj.
@ Hierarchy
@ Histary

- Palette Rename

Duplicate
Delete

BN EINCIE WES Refresh Tree Node

@ HistoryService

@ Name X

@ ==

0K Cancel

5. Enter a name for the pasted PX Page.
6. Click to OK. The PX Page will be added.

7. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Config
and navigate to where the new PX Page is to be located.
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8. Right click the folder and select New> Folder.
The Name dialogue box is displayed.

: Station (Demo_Station) . Schematics

127.0.0.1 (Demo_Station) : Config

& My Network

Q Pseudo_Points
6 BacnetMetwork

M coitTags lconFolder

- TextBlock

Make Template

- BooleanWritable
NumericWritable

EnumWritable

@ Name *

@ Jslosr]|
OK Cancel

9. Specify the folder’s name e.g. ‘HC2'.
10. Click OK A folder is created.

11. Right click the folder you have just created and select Views > New View.
The New Px View dialogue box is displayed.

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config
~ Nav
E@ O @ My Network
D Pseudo_Points
6 BacnetNetwork
Apps
D Schematics
© HeatingCircuit1
QHa
O He
@ Files fire Sheet
© images AX Property Sheet
©Q offline [y Property Sheet
Om 3 - Ca ry Sheet
Edit Tags
@ i = lot Sheet
[ Hg Make Template elation Sheet
F] 1
&) 1 Cut New View
I:O Y
O resoun By Guide Help
D Saia_P e )
Bajadoc Help
[E) Hierarchy [N Special
o~ Spy Local
Duplicate
- Palette AL Spy Remote
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> MNew Px View b4

m New Px View
Create a new view on the component using a pxfile

View Name HC2

View lcon module://icona/xlé6,/views,/view.png -

TargetMedia <@ Workbench PxMedia

Source & PxFile [}
<> DynamicView
0K | Cancel |
12. Enter the name of the page created above in the View Name box. n

13. Click OK The File already exists dialogue box is displayed.

™ File already exists. x

File already exists.

A Reuse existing file unmodified.

Owerwrite existing file contents.

Reuse | Overwrite Cancel

14. Click Reuse.

15. Edit the page as required.

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22  §-125



Creating/Engineering a project Saia-Burgess Controls AG

Creating Schematics (Operator Views)

6.6.5 Easy Templating Simple Objects
6.6.5.1 Create simple objects

1. Using the standard PxEditor, design a PxPage using graphics, labels or any com-
ponent you would usually use to design the page. Manually bind any points so the
graphics are a live representation of the object.

Bulb Simple Object

Demand Aus{faultstalel @ def

2. Using the Tools > Easy Templating Simple Object Creator, select the PxPage cre-
ated in step 1, and generate the Simple Object. The new object will appear in the
Easy Templating Sidebar when created — any errors will be shown in a toast popup.

Window  PxEditor  Help

Alarm Portal Click folder icon to browse Px files:

Certificate Management ' @

Easy Templating Simple Object Creator

Selected file: local|foxs:[file:*Demo/Bulb.px

OK ‘ Cancel

Easy Templating
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Using generated Simple Objects
1.

On a new PxPage, drag one of the Simple Objects from the Easy Templating Side-
bar onto the page.

lb 7 [ b_ t - Properties
Bulb Simple Objec .
p J Pxinclude ;f -
E
i Pxinclude
enabled e
5 . layer
B 550.0,430.0,400.0,300.0
ord local: file:~etsoFiles/Bulb/Bulb.etso
s C |
variables Control=
visible zue
2 Easy Templating Binding X
ko data CLICK_HERE_TO_CHODSE_BINDING

2. Using either the Properties Sidebar, or the Properties Popup (double click), there

will be a Easy Templating Binding on the Simple Object with a property reading
“CLICK_HERE_TO_CHOOSE_BINDING”. Clicking this will bring up matching loca-
tion which meet all the points used in the Simple Object.

| Please select location to bind Simple Object to...
| |station: |3lot: /MotorTemplateDeploy
station:|slot:/ImportedPoints/System3

| station:|slot:/TemplateDemo

station:|slot:/MotorTemplateDeploy

. Once a selection has been made, the resources needed for the Simple Object will

be copied over the from the Simple Object directory, into the running station. The
variable will then be set, linking the graphic to the chosen location.

|"+) Pxinclude [station:|slot:/]

)
Motor - Properties
LB
Pxinclude - BN 3
% pxinclude
e enabled true
] Runtime 3] layer
FbSignal S PPV - TR R —
Signal ard local:|foxs: [file:“etsoFiles/Motor/Motor.etso
variables Control=station:|slot:/Imported Points/System3
visible e
% Easy Templating Binding X
dats CLICK_HERE_TO_CHOOSE_BIMDING
o

4. If at any time you want to change where the Simple Object is bound to, repeat step

2 above and the variables location will be updated.
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6.6.6 Reuse a Generic PX Page

Saia PCD controllers often have the same control program and the associated Opera-
tor Views are identical, but reference data from different controllers. Or it is also possi-
ble that one controller has the same control program multiple times for multiple equip-
ment.

To reduce engineering time a PX Page with generic references to data in the controller
can be re-used for multiple controllers by attaching it to the required controllers (points)
in the Nav tree. In order to do this every reference from the PX page to the controller
(points) must be made generic, and the PX Page must be associated with the controller
or points folder.

Create generic PX page and make the ORDs relative:

n 1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page.

2. Open the Bound Ords pane.

3. Double click on the first ord that references a value in the controller. The Edit ord
dialogue box is displayed.

<

atation: |slot:/Drivers/SBCS205ystems/SBCIpNetwork_Demo/Devici [l ~  (Defaultview) -
» 0O-
OK Cancel

Original ORD in the Editfield:
"station:|slot:/Drivers/SBC$20Systems/SBClpNetwork_Demo/Device1/points/Heat-
ing1/Outside/Temperature/PhysVal"

4. Edit the ORD to make it generic by removing references to the site, LAN, and con-
troller. For example

1 Untitled - Notepad - O x

File Edit Format VYiew Help
station: |slot: /Drivers/SBC$20Systems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Outside/Temperature/PhysVal

o ord e
slot:butaside/Temperature/Phyaval B - (DefaultView) ~
» 0O-
OK Cancel
5. Click OK.

6. Press CTRL+S to save the page.
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Using Text Editor to make the ORDs relative

Text Editor can be used if more ORD has to be modified or the Relativize command
can be used.

Right mouse click to the page in the px folder to relativize
Select Views » Text Editor

The content of the px file is shown in XML format.

[« Saia PCD® Super

s Window TetCditor Help CEET—

80.0,230.9,150.0,260.0"

90.0,395.0,250.0,150.0" 1naE:

80.0,440.0,250.0,150.0"

> ia_PC0_Supenisor_Shus_Deme_HC 5
- T

widgetevent= y="valuer>

- Palette %] 2

<> Saia PCD'® Supervisor

File Edit Search Bookmarks Tools Window

127.0.0.1 {Demo_Station) ! Station (Demo_Station)

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22

6-129



Creating/Engineering a project Saia-Burgess Controls AG

Creating Schematics (Operator Views)

5. fill up the Find edit filed and the Replace with edit field.

'V
B E

~“opoo0e

<Slider layeut="75@.8,248.8,28.8,158.8" min="-3.8" max="3.8" increment="8.5" value="3.8" orientation="vertical
37 <SetPointBinding ord="slot:/Drivers/SBC$285ystems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Room/Temperature,
<IStatusToBrush name="trackBrush®/>

ReplaceAll

Associate a PX Page with a controller:
1. Right click the PX Page that is to be reused and select Copy.

2. Right click the px folder in the Nav tree and select Paste. The Name dialogue box
is displayed.

Enter a name for the PX Page (e.g. HC_generic).
Click OK.

In the Nav tree navigate to the controller that the page is to be associated.

o a &~ »

Right click the controller and select Views > New View. The New Px View dia-
logue box is displayed.

o New Px View x

m New Px View
Create a new view on the companent using a pxfile

View Name

View lcon module://icons/x16/views/view.png -

Target Media  <#» Workbench PxMedia

@ PxFile file:~pu/HC generic.px -
Source
&> DynamicView
0K Cancel
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7. Enter the name of the page created above in the View Name box.

8. Click OK The File already exists dialogue box is displayed.

™ File already exists. X

File already exists.
A Reuse existing file unmodified.

Owverwrite existing file contents.

Reuse | Overwrite Cancel

File  Edit

< moO-o Ao 0 - B % © B X a ¢ 0- Thaaarx g 68

: Points

Search  Bookmarks Tools Window  PxEditor  Help

© SBCIpNetwork Demo  © Devicel © Heatingl

¥ o © My Network
© sac systems
<@ Properties X
BoundLabel R R
2 Bound Label
background [_] (default
Bé pollscheduler e ol
@ roints border |0.0none black ]
B :;mgn enabled [trUe
Ack
B3 opode (T e i Kz el
B outside foreground [ (defautt)
A Temperature halign Center
3 Return image null [ |
H supoly layer
3 Room ::”; o 1300,1000,100.020.0 |
B wed M mouse Over |None
@ alarms PhysVal | 7
@ Histories 4 e% 47
S A e slot:Outside/Temperature/Physal C]
- Palette 7 texticoncap |%-00
W X D | sy textTolconAlig REN
= Center
@ Historyservice
visible [true

© auditHistoryservice
© LogHistoryservice
O Historypointtist

wordWrapEna false

| % soundtabeisindng
4 ord slot:Outside/Temperature/Physval

L3 historyPointListitem
degradeBehayNone

A hypetink | null

CCL e

7| summary | %displayName?ty peDisplayNamed=%.%
popupEnable(true

statuskffect |None:

oK Cancel

3 strngintenval
P strngeov

9. Click Reuse
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6-132

6.6.7

6.6.8

New Px / responsiv elements

B Menu bar automatically jumps to
another position

W "Station" and "Hierachy" fold-
ers are no longer included in the
browser nav tree

eiaiuny
E Managers
E! Properties
&) ron
BOH

B New "Flow Pane" offers the pos-
sibility to define the number of
columns and the pagination by
yourself

Dashboards

L a
L a |

3333

A Dashboard is an element on a PX Page which each user can customise to their re-

quirements.

To use dashboards the Dashboard palette needs to be opened and the Dashboard
Service needs to be added to the Services section of Saia PCD® Supervisor.

Dashboard panes are added to the PX view like any other Graphic, but it requires

some extra configuration.

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22




Saia-Burgess Controls AG Creating/Engineering a project

Set Up Saia PCD® Supervisor Users

6.6.8.1 Add the Dashboard Service

1. In the Nav tree open 127.0.0.1(localhost)>Stataion(Demo_Station) > Config >
Services.

2. Open the Dashboard palette and drag DashboardService onto Services. The
Name dialogue box is displayed.

127.0.0.1 (Demo_Station) : Station (Demo_Station) : Config . Drivers

- Nav

he & ) @ My Network

’ Station (Demo_Station)
‘ Alarm

e Config

@ Services
o AlarmService
@ BackupService
® CategoryService

@ JobService

@ RoleService

0 UserService

0 AuthenticationService

Er DebugService

@ BoxService

v FoxSery| <#» Name o

@ Hierard
® DashboardService
@ History:

O audithi o P
© LozHistrymer

@ ProgramsService
0 SearchService

o TagDictionaryService
TemplateService
¥ @ WebService

- Palette
] E E .dashboard

{ }DashbuardSEmoe
. DashboardPane

3. Click OK.
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6.6.8.2 Add a Dashboard to a PX Page
1. Create the PX Page as required.

2. Open the Dashboard palette and drag DashboardPane onto the page.
3. Open the webChart palette.

4. Drag either Chart or Circular Gauge onto the content of the Dashboard pane in
the widget tree.

- Widget Tree

D ScrollPane (Root)

% CanvasPane (Content)
. DashboardPane
E content

O w-® B % @ X N a4 0- QQakx s o8

A - Bound Ords 5]

ipEPEDEEEE ef

i, ~ PxLayers B

Status »

- Properties =]
Webmdser o2
* Webwidget

5. Go online
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6. Drag & Drop an analog value to the gouge
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6.7

Set Up Saia PCD® Supervisor Users

Security of Saia PCD® Supervisor is controlled by users. The access rights of each
user determines what information the user can access and what things they are able to
change/configure.

To achieve this the security within Saia PCD® Supervisor is managed using three ser-
vices:

1. Categories

Categories define what areas of the system a user can access.

2. Roles

Roles are used to group the categories together that are required for a particular
job and to define the level of access to those categories.

E.g. a boiler engineer would only need access to the boilers but would require a
high level of access. Therefore a role would be required for the engineers that gave
high level access to the category that gave access to the boilers.

An energy manager would need information from all the plant but with a lower level
of access. Therefore a role would be required for the energy manager that gave
low level access to a number of categories covering all the plant.

Categories are assigned to roles using the Category Browser which is just another
way of looking at the Nav tree.

. Users

Users define which roles the user has, their password, expiry, web access view.
The ‘admin’ user is a superuser level access which has access to the whole sys-
tem. Because of this details of the admin user’s password should carefully con-
trolled.

To configure users the required steps should be followed:
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Configure Categories

Before creating the necessary categories it is necessary to plan what is required, you
should consider the users and the distinct areas, then work out ‘\Where’ needs to be
granted access and create a category for each of these.

To configure categories the required steps should be followed:

Add a Category

User and Admin categories are created by default and additional categories are added
using the Category Manager.

The Admin category does not relate to the Admin user used to engineer Saia PCD®
Supervisor.

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click CategoryService
The CategoryBrowser is displayed in the view pane.

3. Click the view changer box and select Category Manager.
The Category Manager is displayed in the view pane.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools

~ Nav Category Browser
P o () My Network Inherit User Admin Category3 Category4 Categorys Category6 Category7 Categorys
- & 4om B Anam s @
© confiz Oconfig /2 )
@ services Eriles n/a )
© alsrmservice @History  n/a L]
@ BackupService
@ CategorySenvice
D User
D admin
@ sobsenvice
€ Roleservice
© userservice

Category Browser

Inherit User Admin Category3 Category4 Categorys Categorys Category7 Categorys

Anerm  nfa [ ] t.

Config  nfa L]
L) Property Sheet
Sries e °
@risory 2 @
ot Sheet
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4. Click New The New dialogue box is displayed.

o PNew >

Typeto Add ';5 Category
Mumberto Add |1 | [1-100]

0K | Cancel |

5. Click OK The dialogue box changes.

™ New *

Index Name B
@3 Heating_Circuits

ﬁ Index 3

m Name |Heating Circui sl

oK Cancel

6. Enter the name of the category in the Name box.

7. Click OK.

6.7.1.2 Set up the Categories

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click CategoryService
The CategoryBrowser is displayed in the view pane.

[<@ Saia PCD® Supenvisor
File Edit Search Bookmarks Tools Window CategoryBrowser Help
- Nav [Z1 | categoryBrowser
P C ) My Network Inherit User Admin Heating Circuits Category4 Categorys Category6 Category7 Categorys
= A = Aslerm M e e @
© coni O config n/a L )
@ services Services v
O alarmservice Drivers v
® Backupsenvice Apps. v
© Categorysenioe Oschematics e o o
HeatingCircuitL 7
HeL v
HC2 v
@ riles nfa o
Images 7
@ Authenticationservice offline v
I oebugsenvice O e o o
HCLpx v
HCZpx v
HC_generic.p v
HeatingCircuitLp: N4
O Logristorysenvice Home.p v
@ progamservie b Oresourees v
© SearchSenvice Saia_PCD_Supervisor_Shus_Demo_HC v
© TagbictionaryService @ristory s e e
- Palette 74} & Demo_ststion e o o
W X B | § webChat AuditHistory v
Hestingl_Outside_Temperature_PhysVal
@ chart
@ cirularcauge LoeHitony v
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3. Grant each category access to the required areas of the system by clicking the
required rows in the column for each category. To grant access to elements lower
in the hierarchy expand the appropriate row and click.

Categories are a parent child system so selecting the top level will grant
access to every child element under that level.

The inherit feature enables the access of the User category to be copied to another
category. If there is a tick on the Inherit column for a row when that row is selected
for another category the access from the User category is copied to the other cat-
egory and removed from the User category. To reinstate access to the User cat-
egory click the row in the User column.

n Due to this it is potentially easy to accidentally remove rights. n

A dot in a cell indicates access to that specific area. If the dot is black the access
will not be affected by the Inherit tick, if it is grey it will be affected.

It is recommended that the Admin category is given the same access in the Config
row as the User category i.e. leave the Inherit rows in the Config row are they are.
For the other rows (Alarm, Files, and History) the Inherit rows can be unticked to
enable you to specify the access more easily.

n By default the ‘Admin’ and ‘New’ categories will have no access.

It is recommended that the ‘Admin’ category has access to some of
the more complex areas of Saia PCD® Supervisor but not the whole of
Saia PCD® Supervisor.

4. Click M.

=0
fmx Saia PCD® Supenvsar

File Edit Search Bookmarks Tool: Window  Cateporyd
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6.7.2 Configure Roles

Roles use the categories to define what areas of the system can be accessed. They
can have multiple categories assigned. It is best to configure Roles with job roles in
mind rather than specific areas like categories.

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >

Services.

Double click RoleService

The Role Manager is displayed in the view pane.

[® Saia PCD® Supervisar

File Edit Search Bookmarks

@ MyNetwork

A Aarm
O config
@ services
© Alarmsenvice
@ Backupservice
@ CatesoryService

@ resting_Circuits
© Jobservice

LJ pebugservice
@ Bossenvice

¥ Foservice

@ Hierarchyservice
@ HistoryService
© nuditHistoryService

@ searchservice
© TagDictionaysenvice

- Palette
w X B | § webcher
@ chart

@ circularGauge

ools Window CategoryBrowser  Help

Category Browser

A Alarm
© config
Services
Drivers
Apps
O schematics
HeatingCircuitL
HC1
HC2
S iles
Images
offline
Oex
HCLpx
HC2.px
HC_generic.px
HeatingCircuitL.px

Home.px

Saia_PCD_Supervisor_Sbus_Demo_HC

@ History
i Demo_Station
AuditHistory
Heating1_Outside_Temperature_PhysVal

LogHistory

nfa L
nfa L
v
v
v
L
v
v
v
n/a
v
v
L
v
v
v
v
v
v
v
nia L
L
v
v
v

Admin Heating Circuits Category4 Categorys Categoryé Category7 Categorys
L L]

L

L L

L

L L]

L

L] L]

. Click New

inF [ew x>

Type to Add i-i Role

Mumberto Add 1 [1-100]
OK | Cancel

Click OK

The dialogue box changes.

The New dialogue box is displayed.

<M New

Name
[ HVC O None
'r_'. Name

[i Permissions

'Ti Viewable Hierarchies

Permissions  Viewable Hierarchies

HVC Operators

[ superUseraccess entire station, file system)

>

0K Cancel

»
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It is recommended that the SuperUser (access entire station, file system)
check box is NOT selected.

The Permissions dialogue box is displayed.

<@ Permissions

Admin

RIwl il

Operator

ficemy RIw| |

User

Admin

Heating_Circuits A
Category 4

Category 5

Category 6

Category 7

Category 8

0K | Cancel |

6. Specify the permissions for each category by clicking the appropriate column for

each category.

When you assign permissions, higher-level permissions (green check marks)

automatically include the lower level ones (grey check marks). For example, if you
enable admin level write (W), the system automatically enables admin level read
(R), as well as operator level read and write (RW).

The first column, Category, lists the groups to which you may grant permission.
The Operator and Admin columns relate to the permissions level configured on
each component. Below these headings are the cells to use for assigning one of
three permissions to each category:

R Read allows the user to view the object.

W  Write allows the user to change the object.
I Invoke allows the user to initiate an action related to the object.

Depending on how the permission level is set on the role, six permissions are de-

rived:

Permission Description
To allow a user to view operator level Check the Operator config flag on the slot and select the Operator R
information column on the permission map.

To allow a user to modify operator level
information (if it is not read only)

Check the Operator config flag on the slot and select the Operator
W column on the permission map.

To allow the user to view and invoke
operator-level operations (actions)

Check the Operator config flag on the slot and select the Operator |
column on the permission map

To allow the user to view admin level
information

Leave the Operator config flag unchecked on the slot and select the
Admin R column on the permission map.

To allow the user to modify admin level
information (if it is not read only)

Leave the Operator config flag unchecked on the slot and
select the Admin W column on the permission map.

To allow the user to view and invoke
admin-level operations (actions)

Leave the Operator config flag unchecked on the slot and select the
Admin | column on the permission map.
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7. Click OK.
8. Click OK A confirmation dialogue box is displayed.
9. Click Yes.

6.7.3 Configure Users

To configure users the required steps should be followed:

see chapter 6.7.4 Add Users 6.7.4

n 6.7.3.1 Configure NAV Files

NAV files are used to define the PX Page that is displayed when a user logs in. Each
user must have a NAV file assigned. It is recommend that a folder is created to store all

the NAV files.

6.7.3.2 Create a Folder for the NAV Files
1. Right click Files and select New> Folder. The Name dialogue box is displayed.

“» Mame for New Folder x

Q=

OK Cancel

2. Specify the folders’s name e.g. ‘NAV'.
3. Click OK.
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Create NAV Files

1.

2.

o a &~

In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config and
navigate to where the NAV file is to be located

Right click the folder and select New> NavFile.nav. The Name dialogue box is
displayed.

127.0.0.1 (Demo_Station)  : Station (Demo_Station)  © Files  © NAV

K C @ My Network

@ apps
© schematics
© HeatingCircuits
QHcL
QHa
& Files
© Images
(=1
[ HeLex
[ HeatingCircuitL.px
™) Home.px
[ Hezpx
[ He_genericpx
O resources
© saia_PCD_Supervisor_Sbus_Demo_HC

O offline

New Folder

BogFilebog

HtmlFile.html

Duplicate
- Palette
Delete

=X D A

@ chot Refresh Tree Node =
@ circularGauge . ReportPxFile.px

SyntheticModule.sjar

TextFile.xt

@ MName for Mew File x

@ Homel. nav

0K Cancel

Specify the file’s name e.g. ‘Home’.

Click OK The file is created.

Open the folder containing the NAV file.

Double click the NAV file. The Nav File Editor is displayed in the view pane.

®> Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Help

4 oD O0O- o O 0 - 2 0 =2

127.00.1(Demo_Station)  © Ststion (Demo_Station)  : Files  © NAV  © Homenav #  NavFileEditor ~

Result Tree 1objects

& My Network Display Name Target Ord [l

- Home  station:slot:/
O schedulers Ll |

@ Files
Q) images
QO offline
Qex

Q resources
Q) seia_PCD_Supervisor_Sbus_Dema_HC

Q nav

) Home.nav
» (&) Hierarchy
~

~ Palette

= G T (M kiControl ONew | #Edit X Delete 4 MoveUp ¥ MoveDown [ Show Components | [=] Show Files
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7. Click Show Components.
8. In the Result Tree double click to the NAV file. The Edit dialogue box is displayed.

*

o Edit

Dizplay Name [fems

station: |slot:/ & - (DefaultView) -
Target Ord

» 0-
lcon module://icons/x16/home . png -

0K Cancel

9. Click ™ - next to DefaultView. The Select Ord dialogue box is displayed.

n < Select Ord X

e Config
. Station Name
. Sys Info
@ Services
. Save
e Drivers
@ Apps

0 Schematics

Type
@ slot
<> Handle

OK Cancel

10. Navigate to the PX Page that is to be referenced by the NAV page and select it.

11. Click OK.
12. Click OK.
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6.7.4 Add Users

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Right click UserService and select Views > AX User Manager. The Ax User Man-
ager is displayed in the view pane.

«r Saia PCD® Supervisor

File Edit Search Bookmarks  Tools  Window User Manager Help

4 o O0O-on O 0 - = a0 & XK

127.0.0.1(Demo_Station) ~ : Station (Demo_Station)  : Config  © Services  : UserService /  UserManager -

~ Nav 7] Name Full Name Enabled Expiration Allow Concurrent Sessions Network User Languagv

(9] () My Network guest false Never true false
é ﬁmmm&mnﬁﬂﬁw - admin true Never true false
& station (Demo_station) BACnet true Never true
A alarm
© config
@ services
b Q) alarmservice
@ Backupservice
@® catezoryservice
» (D Jobservice
€D Roleservice
O userservice
O suthenticationsery

false
User Operator 1 true Never true true

~ Palette

W X 7B [# ktcontrol # EDIT X REMOVE By DUPLICATE

https://127.0.0.1/bajaux/webwidget/viewswebEditors:UserManagertheme=SBC&formFactor-maxguseL ocalWbRe=true&attachAfterinit=False

3. Click New. The New dialogue box is displayed.

™ New X

Typeto Add a User
Mumberto Add 1 [1-100]

OK | Cancel

Several users can be added at the same time. However, it is recommend-

ed to add users individually to prevent confusion when specifying pass-
words.

4. Click OK The dialogue box changes.
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5. Double click of the new user

Station (Demo_Station) ! Config o © UserService

Property Sheet
& Userl (User)
[ Full Name Operator 1
W Enabled @ true
(W Expiration & NeverExpires > ExpiresOn [24-Jul-2017 11:59 PM CEST
@ Lock Out @ fals=
@ Language
[ Email
Pazzword ssssssss
= Confirm |essssess
ljAuthenticaior Force Reset At Next Login . false

< MNeverExpires < ExpiresOn |24-Jul-2017 11:59 PM CEST

. Time Farmat (default)
P. Facets
Unit Conversion | Mone
[ Nav File null [ IR

m Prototype Name defaultPrototype
[ Network User @ true
@ Cell Phone Number

[\i Authentication Scheme Name DigestScheme

admin

[ Roles Engineer »
Energy manager

[ Allow Concurrent Sessions ® true

Type HTMLS Hx Profile

HxTheme SBC
Enable HxWorkbench Views . Yes

Enable Nav Tree Side Bar . Yes
Enable Search Side Bar . Yes
Enable Palette Side Bar . Yes
!i Default Web Profile
Enable Nav File Tree . Yes
Enable Config Tree . Yes
Enable Files Tree . Yes
Enable Histories Tree [ 1
Enable Hierarchies Tree . Yes
Enable View Selection . Yes
Mobile Mav File 'null - - )
!i Mobile Web Profile Type Default Hx Profile

HxTheme

[ User Pin Level Galileo User Pin

c Refresh I:] Save

6. Enter the user’s username in the Name box.
7. Enter the users full name in the Full Name box.

8. If the user is to expire on a specific date select the Expires On option and specify
the required date.

9. Select the roles for the user in the Roles box.

10. Enter the user’s password in the Password box.

n Passwords must be 10 digits alpha numeric with one or more capital
letter.

11. Re-enter the user’s password in the Confirm box.
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12.

13.

14.

15.

16.

17.
18.

19.
20.

21.

Backup & Restore

To force the user to change the password when they next login set Force Reset At
Next Login to frue.

To force the user to change the password on a specific date, select the Expires On
option and specify the required date.

If the password is to expire on a specific date select the Expires On option and
specify the required date.

Specify the NAV file that is linked to the PX Page that is to be displayed when the
user logs in in the Nav file box.

Specify what happens when a user logs in from a web browser in the Default Web
Profile box.

In the Type box select the required option. n

It is recommend that you select HTML5 Hx Profile as it will render the graphics in a
HTML5 format avoiding Java issues.

In the Hx Theme box select “SBC”.

Select Yes or No to specify whether the user has access to the following features:

- Hx workbench views
- Nav tree side bar

- search side bar

- palette side bar

- Nav file tree

- Config tree

- Files tree

- Histories tree

- Hierarchies tree

Click OK.
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6.8 Backup & Restore

To ensure that the Saia PCD® Supervisor configuration can be restored in the event of
hardware or software failure it is recommended that the Saia PCD® Supervisor station
is backed up. To reduce the risk it is recommended that the backup is performed in two

ways:

visor installation, platform password (normally PC login credentials) and the password
for the ‘admin’ user (specified when creating the Saia PCD® Supervisor station) are
available for use during any restore procedure.

n It is also important to ensure that the passphrase entered during the Saia PCD® Super-
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6.8.1

Backup & Restore

Backup the Configuration

Using the Station Copier

The Saia PCD® Supervisor configuration can be copied from the localhost back to the
local computer. This is not a true back up but it is useful as it makes the configuration
available offline and thus reusable in future Saia PCD® Supervisor installations.

1. In the Nav tree right-click on Platform and select Views > Station Copier. The
Station Copier is displayed in the view pane.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window
4 O- o A O [ B b
My Host : SZ43L TJ0GWF2 globalds.honeywellcom  : Platform /  Sation Copier -
- Nav Station Copier
¥ o © sk @ Stations on this computer & Stations on "localhost”
- B /C:/Users/E814666/Niagarad.2/tridium/stations Q ~stations
My File Syst
© wyiiesysiem Attila_test2 Attila_test2
© wyHodules CertLab_04 Certlab_oa
@ application Director JACEDS JACEDS
© certificate Management JACED4 final JACED4.final
O Loicon Installer SBC_SBUS_Test1 SBC_SBUS_Test1
© License Manager SBC_SBUS Test2 SBC_TM2016_Workshop
© Platform administration SBC_TM2016_Workshop StationSup04
et StationSup04 Training_Center_V1

Training_Center_V1
@ 1criip Confizurstion B-center

@ Remote File System
@ 127.0.0.1 (Demo_station)
& station (Demo_station)
A Alsrm
© config
@ services

© Alarmservice
@ BackupSenvice

@ categoryService P copy

@ Jobservice i
€ roleservice
[f] rename
© userservice
b @ AuthenticationService ¥ Delete

- Palette
W X B | #§ webchart

@ chart

@ circularGauge

2. In the right-hand column (Stations on “localhost”) click the station to be copied (e.g.
Saia PCD® Supervisor).

The Localhost is the live version of Saia PCD® Supervisor. Copying from left to
right will overwrite the live version with an older PC version. To copy the live ver-
sion to the PC it is RIGHT to LEFT

3. Click < Copy. The Station Transfer Wizard is displayed.

<®» Station Transfer Wizard X

f'\ Transferring station "Demo_Station™
What name would you like the new station to have?

Station name Demo_Station

4 Back P Next / Finish X cancel
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4. Enter the name of the backup copy (e.g. Saia PCD® Supervisor Backup).
5. Click Next.

“®> Station Transfer Wizard X

" Transferring station "Demo_Station™
Which station files are to be copied?

&> Copy files from selected directories
&> Copy every file in the station directory and its subdirectories
& Copy only the "config.bog" station databasefile

4 Back

Finish A cancel

“® Station Transfer Wizard X

f"l Transferring station "Demo_Station™
u How do you want to deal with any existing files?
&> Delete the existing "Demo_Station" directory before copying
& :Overwrite existing station fileswith new files, while leaving other files intact;

4 Back P Next Finish K cancel

6. Select Copy every file in the station directory and its subdirectories.

7. Click Next.

8. If the station already exists in the destination you will be prompted to delete the
entire station, or just overwrite duplicate files. Select the required option and click
Next.

<& Station Transfer Wizard X

f'\ Transferring station "Demo_Station®™
Please review yourchanges

Allstation files will be copied from "localhost” to the local computer

Please select the "Finish" button to start the transfer.

‘ Back p Next - \/ i Flnish x Cancel
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9. Click Finish to start copying the files. Once the copy is complete the following dia-

10.
11.

12.
13.
14.

logue box is displayed.

“#» Transferring station

‘. J Transferring station

Completing transfer:

° Savestation  Success
€D Transferfiles  Success

B L e e R L i T e e e e e e P e Ll o)
~3tations/Demo Station/shared/Saia PCD Supervisor Sbus Demo HC/CPU001/ TCPIPDBX.src
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_CFU00l.inc
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001.src
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPU001_HLKSE M1
~3tations/Demo_Station/shared/Saia PCD Supervisor Sbus Demo HC/CEU001/_ CPU001 HLESE M1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPFU001_Heating 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPU001_Heating 1
~atations/Demo_Station/shared/Saia PCD Supervisor Sbus Demo HC/CPU001/ CPU0O1 Heizung 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPFU001_Heizung 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_ Demo HC/CPU001/hdlog.fxp
~3tations/Demo_Station/shared/Saia PCD Supervisor Sbus_Demo HC/CFUO001l/hdlogl.fxp
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/heating circuit.fs
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/Libs

~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/Saia PCD Supervisor Sbus
~stations/Demo Station/shared/Saia PCD Supervisor Sbus Demo HC/ lastopen
~3tations/Demo_Station/shared/offline/alarmdata/CPU00L.xml
~3tations/Demo_Station/shared/offline/engineering/system.bog

~3tations/Demo Station/shared/offline/hdlogsdata/CPU00L.xml

~3tations/Demo Station/shared/offline/pointdata/CPU00L.xml

~stations/Demo Station/shared/px/HCl.px

~gtations/Demo_Station/shared/px/HC2.px

~3tations/Demo_Station/shared/px/HC generic.px
~3tations/Demo_Station/shared/px/HeatingCircuitl.px

~3tations/Demo Station/shared/px/Home.px
~3tations/Demo_Station/shared/resources/AlarmTexts/CPU00L.xml

~stations/Demo Station/shared/resources/encodings.xml

Transfer complete.

Close

Click Close.

In the Nav tree open My File System and navigate to

C:/Users/MyUserName/Niagara4.7/Saia Burgess Controls/stations

Right-click the required station folder and select Copy.

Navigate to the required storage location (e.g. a plug-in memory device).

Right-click and select Paste.
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6.8.2 Using the Backup Service

Using the Backup Service the backup file has not only the content of the station but
also the default settings of the Workbench where the station was created and backed

up.
The user can as well specify, if the alarm or histories database should be a part of the
backup .dist file.

Doing a station backup, will prevent data-lose of the running station in case of hard-
ware or system failure.

Station backups are stored as ‘.dist’ files in
C:/Users/MyUserName/Niagara4.7/Saia Burgess Controls/backups

n 1. In the Nav tree open Station > Config > Services.
2. Right click BackupServices and choose Views > Ax Property Sheet.

> Saja PCD® Supervisor = X
File Edit Search Bookmarks Tools Window Help
14 o O- B A C 0 - B =
127.0.0.1 (Demo_Station) ~ : Station (Demo_Station)  : Config  © Services @ BackupService #  AXProperty Sheet +
~ Nav Property Sheet
l=. o @Mywﬁwmk @ BackupService (Backup Service)
_ - [ status {ok}
@ services [ Fault Cause
O aarmservice [ Enabled @ e
@ Backupsenvice [ Exclude Files +.hdb; *. adb; *.1ock; *backup#*; console. *; ool
CategoryService
6 carezors filesnshistory ® X
@ Jobsenvice -
file:r alarm
@ Roleservice [ Exclude Directories
O userservice
© AuthenticationService
& pebugservice [ Offline Exclude Files *.lock; *backup*;console. *;config.bog.b*
® Boxservice ® X
¥ Foxservice
@ HierarchyService (@ Offline Exclude Directories

b @ HistoryService
© AuditHistoryService
O LogHistoryservice
@) Programservice
0 searchsenvice
© Tsebictionsnysenvice
TemplateService
@ websenvice

» B Ssia PGS Data Import Wizard
™ Platformservices

» { ] pashboardservice

- Palette

w X B | @ webchart
@ chart

@ circulsrGauge

7 Refresh [M] save

3. In the Exclude Directories box click file:*history and click X.
4. In the Exclude Directories box click file:Aalarm and click .

5. Click Save.
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6. In the Nav tree double click BackupService. The Backup Manager is displayed in

the view pane.

Backup & Restore

[@ Saia PCD® Supervisor

File Edit Search Bookmarks Tools  Window

Help

127.00.1(Demo_Station)  : Station (Demo_Station]  : Config  : Services

() My Network

v @ services

» O Alarmservice

© authenticationservice
» L Debugservice
» @ Boxservice
b B Foxservice
b @ Hierarchysenvice
b @ Historyservice
» @ AuditHistoryService
» @ LogHistoryService
@ Programsenvice
» @ searchService
» Q) TasbictionaryService
» @) TemplateService
> @ webservice
» B3 Ssia PG5 Data Import Wizard
p T platformServices
» { ] pashboardservice

- Palette
= X 3
» @ chart

+ @ circularcauge

@ webchart

© BackupService

Backups

Timestamp

¥T) 12-Apr-17 8:27 AM CEST
) 12-Apr-175:33 PM CEST

¥0) 13-Apr-17 10:31 AM CEST

#  BackupManager ~

3 objects
Host  Path User ®

127,001 files/Ca

SBC/01_Projects/Niagara_user_manual_pictures/backup_Demo_Station_170412_0826.dist admin

127001 file:/C:/00_SBC/0L_Projects/Ni anual_pictures/backup_Demo_Station_170412_1732.dist admin

a_user_m.

127.004  file:/C:/00_SBC/01_Projects/Niagara_user_manual_pictures/backup_Demo_Station_170413_1030.dist admin

D) Backup

7. Click Backup. The File Chooser dialogue is displayed.

“®» File Chooser

L File Spaces

Current Path
~backups

bed

@) My File System
« oA E|

A Bookmarks
o A
-

File name:

Files of type: Distribution File

backup Demo Station 170501 _1647.dist

i o- R 8

Save

Cancel

8. If required rename the backup in the File name box.

9. Click Save.

. Ensure the backup file is stored securely.
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6.8.3 Restore the Configuration
6.8.3.1 Restore Using the Station Copier

To restore a station copy follow the procedure described in chapter
6.8.1 Backup the Configuration but copy the station from left to right.

6.8.3.2 Restore the Station Using the dist file
1. Rename the backup.dist file to a zip by renaming the extension and unzip it.

2. Copy the unziped station to the User home station folder.

| @ 9 = | stations
Home Share View
‘* IJ o Cut x I New item ~ @ Open FH setect all
w-| Copy path o i~ 1‘] Easy access = Edit 10 Select non
Pin to Quick Copy Paste _ Move Copy Delete Rename Mew Properties
access ‘ﬂ Paste shortcut ta to - folder - £ History D‘:_Iln\tert seled
Clipboard Crganize Mew Open Select
= v P » ThisPC » OSDISK(C) » Users » EB1 » Miagarad.3 » tridiumn » stations »
# Quick access Name Date modified Type
[ Desktop - DDC_Suite 27 EM_06 File folder
; Downloads P Demo_Station File folder
@ e i Derno_Station_frorm_backup File folder
. SBC_SUP_TrainingCenter_SBUS File folder
& Pictures -

3. Use the station copier to copy it to the daemon home and start.

«® Saia PCD® Supervisor b

File Edit Search Bookmarks  Tools  Window Help

14 > O- o O G -~ 2

My Host : SZ43LTJ06GWF2.2lobal.ds.honeywell.com (Demo_Station] ~ © Platform Station Copier ~

~ Nav Station Copier
I o a1 (&) stationson this computer & Stationson "localhost”

/Cz/Users/EB14666/Niagarad.3/tri 0
@ My Host: 5243LTJ0

) 1y File System DDC_Suite_27_EN_06 DDC_Suite_27_EN_06

A sysHome Demo_Station Demo_Station

~stations

Demo_Station_from_backup Demo_Station_2

© usertom ) copy

® SBC_SUP_TrainingCenter_SBUS SBC_SUP_TrainingCenter_SBUS

= 4 copy
(=]
[X] Rename

~ Palette X pelete
w X 9 |#¢
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7 Using Saia PCD® Supervisor

This section covers the general procedures for day-to-day use of Saia PCD® Supervi-
Sor.

Once configured Saia PCD® Supervisor needs to be running all the time to enable to
collect logged data, control occupation times, process alarms and allow users to ac-
cess information.

If AUTO-START was selected when the Saia PCD® Supervisor station was created, the
Station will be running whenever the PC is started and running.

If this is not the case the Saia PCD® Supervisor station must be started manually
see chapter 7.3 Manual start the Saia PCD® Supervisor Station

Goto ..

7
7.1 Access Saia PCD® Supervisor .
7.2 Use Saia PCD® Supervisor

7.3 Manual start the Saia PCD® Supervisor Station
7.4 HTML5 Enhancements

7.5 Cloud Connector

7.6 Bulk deploy

7.7 VvykonPro modules (on reguest)

7.8 Setting customized login and background logo

7.9 Headstation and Substation Ping Read Timeout

7.10 Setting up the S-Bus clock

7.11 Use of UDP config slot from the Property sheet in every headstation
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71 Access Saia PCD® Supervisor

Saia PCD® Supervisor can be accessed from a PC using the Saia PCD® Supervisor ap-
plication or from a web browser.

n When accessing Saia PCD® Supervisor from a web browser not all features are avail-
able.

711 Launch the Saia PCD® Supervisor Application
1. Click Start and choose All Programs.

2. Navigate to the Saia PCD Supervisor folder
3. Click Saia PCD Supervisor v1.0R
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Access Saia PCD® Supervisor

4. The Saia PCD® Supervisor application window will open:

'_"L_ Windows Update
M Wireshark Legacy
M Wireshark
-4 XPS Viewer

. 7-Zip

. Accessories

, FileZilla FTP Client
. Games

. LonMark

. Maintenance

. Notepad++
./ PG5 Suite V2.2.221
. SaiaPCDSupervisor

L4 Alarm Portal

E Conscle

[=] Demo Station

[ Install Platform Daemon

“#» Saia PCD Supervisor Beta (Console) —

“#* Saia PCD Supervisor Beta
& Uninstall

4 Back

A

| |Search programs and files

Attila

Documents

Pictures

Music

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

Shutdown | ¥ |

9

<@ Saia PCD® Supervisor

Bookmarks

o A O

File Edit Search
0~
SBChome.html

~ Nav
O [@wn

> @ MyHost: SZ43LTIOBGWF2.¢
» 127.0.0.1 (Demo_Station)

~ Palette
wm X B @ «tex

» (B BoundLabel

Tools

Window  Help

Z a0 w-0 0 B R X © Ee]

SAIA BURGESS CONTROLS

)

supervisor

Saia PCD*

Host ID: Win-BCEF-FASD-6162-2CA6
Version: 2.0

niagara‘4
Version: 4.7.U1

Copyright Tridium, Inc 1996-2017
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7111 Log on

(of course the Platform must be running always).

1. In the Nav tree double click on Station. The Authentication dialogue box is dis-
played with a default user selected:

File Edit Search Bookmarks Tools Window  Help

127.0.0.1 [Demo_Station)

- Nav 127.0.0.1 (Demo_Station) 1 objects

P O &) My e Name Description =

@ Station (Demo_Station] Foxsession to a Niagara station
@ MyHast: SZ43LTJ0EGWR2 5

|
127.0.0.1 {Demo_Station) \
@ Station (Demo_Station < Authentication x

| % Authentication
I Logon required for access
7 Realm
Name ip:127.0.0.1 [foms:
Scheme  Fox(n4digest)

Credentials

Username

Change User
Password  [XTTTTIN]

|
[ Remember these credentials

oK Cancel

2. To select a different user click Change User, otherwise go to step 5.

5
4mr Authentication M
% Authentication
Logon required for access
Realm

Name ip:127.0.0.1|foxs:
Scheme  Fox

Credentials

Username |

[#] Rememberthis user

OK Cancel

ﬂ Select the Remember this user tickbox to make this the default username.

3. Enter a new Username.

4. Click OK.

5. Type the appropriate password in the Password box.

6. Click OK The user associated navigation (and start page) will be invoked

71.1.2 Log off

1. When you have finished using Saia PCD® Supervisor it is important to log off from
Saia PCD® Supervisor to ensure that the system cannot be accessed by unau-
thorised users. Logging off requires you to disconnect from both the Platform and
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Station.

2. In the Nav tree right-click on My Host and select Disconnect. The Disconnect
dialogue box is displayed.

ke Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

127.0.0.1 (SBC_SBus_Project) : Station (SBC_SBus_Project)

- Nav 5% Station (SBC_SBus_Project)

K O ) My Network Name Description

A Alarm Alarm Database
+ (@ MyHost: WIN-IFE3J6TBIU

Disconnect
b @ 127.0.0.1 (SBC_SBus_Proj e 54 The station configuration d

Open Platform File System accessed over Fi

e Diagnostics information for
Open Station >
> «m» Disconnect ‘ E

Hierarchy views of remote

My Spy

History database @ Disconnect from host "My Host : WIN-IFE3JETEIUL"T
Refresh Tree Node
Go Into E ﬂ 7

3. Click Yes to disconnect.

7.1.2 Access Saia PCD® Supervisor from a Web Browser

1. Go to the IP address of the PC running Saia PCD® Supervisor. The Saia PCD®
Supervisor log on page is displayed.

[ Privacy error

“ C | A Notsecure | b#rg//localhost/ord r

Your connection is not private

Attackers might be trying to steal your information from localhost (for example,
passwords, messages, or credit cards). NET:ERR_CERT AUTHORITY_INVALID

O Automatically report details of possible security incidents to Google. Privacy policy

HIDE ADVANCED Back to safety

This server could not prove that it is localhost; its security certificate is not trusted by your
computer's operating system. This may be caused by a misconfiguration or an attacker
intercepting your connection. Learn more.

Proceed to localhost {unsafe

n Please contact your local IT-department to get certificate!
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2. Proceed to localhost

© Schematics

Folder

— o >
<@ Login =
< C Ox | A Notsecure | b#ps//127.0.0.1/prelogin .
an
Sr
SAIA BURGESS CONTROLS
Demo_Station
Username: | ]
Use of this software is subject to the
End User License Agreement and other Third Party Licenses
© 2017 Saia Burgess Controls. All Rights Reserved | Data privacy and Imprint
- O X
«®» Config x
“ C 1} | A Notsecure | h#ps//127.0.0.1/ord/station:%7 Cslot:/ g g
Config O ® 1} Property Sheet v [X]
QActions & Topics [8 Slot Details
Display Name Value Commands
(@ Station Name Demo_Station
(@ Sys Info Kd
@ Services Service Container
 Drivers Driver Container
© Apps App Container

3. Enter your user name.

4. Click Login.

5. Enter your password.

6. Click Login.

If the correct certificates, are installed then the security warning is not
coming up. The connection is immediately built from the browser to the
server.

7-6
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71.21 Log off
1. Click “X”

- a x
«® Config x
= (& iy ‘A Not secure | b#s%://127.0.0.1/ord/station:%7Cslot;/ r e B
Config C t} Property Sheet G

Commands

Are you sure you want to log off?

YES NO

2. Click Yes.
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7-8

7.2

7.2.1

7211

7.21.2

Use Saia PCD® Supervisor

Once you have accessed Saia PCD® Supervisor it can be used in two different ways:

-> 7.2.1 Using Saia PCD® Supervisor via Operator Views

> 7.2.2.2 Nav Tree

The method you use will depend on how Saia PCD® Supervisor has been configured,
your level of access and the tasks you want to do.

Using Saia PCD® Supervisor via Operator Views

Use of Saia PCD® Supervisor via Operator Views (PX Pages) requires more initial
configuration, but enables users to access the system using graphical pages tailored to
their requirements in a controlled way.

The Operator Views will have been designed to provide clickable links to either move
between pages or select particular controls (e.g. to change a set point, change occu-
pancy times, etc). When you log in you will be taken to a landing page from which you
can navigate to the required information and, if allowed, make adjustments. Simply
click on the links provided; the user interface should make it obvious what the link does.

Access the Operator Views
When you log on a PX Page will normally be displayed allowing you to navigate to
parts of the system that you have access to.

If a PX Page is not displayed and you want to navigate the system using Operator
Views you will need to display the required page from the Nav tree.

1. In the Nav tree open
127.0.0.1(localhost) > Station(Demo_Station) > Files > PX > and navigate to the
required PX Page (start page).

2. Double click the page.

Use the Operator Views
Navigation

Once a PX Page is displayed you will be able to navigate to other parts of the system
by clicking on the links provided. These links may be in the form of text hyperlinks but-
tons, or graphics with hyperlinks depending on how the page has been configured. The
display should make it clear the function of each item on the page.
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File  Edit Search Bookmarks Tools  Window He

The next and previous buttons ( * * ) can be used to move between the pages you
have already viewed.
Adjustments

If you have the authority and the page has been configured appropriately you may be
able to make adjustments by clicking on various graphical elements, e.g. sliders and
buttons.

I s |

The meaning and use of such items should be intuitive.

Use Dashboards

A Dashboard is an item on a PX Page that enables you to choose the information that
is displayed. Once you have set up the item it can be saved so that next time you visit
the page your selections are visible. Selections made by other users do not affect
yours. A PX Page may contain one or more dashboard items.

There are two types of dashboard item; Gauges and Charts.

Gauge

A gauge type dashboard appears as shown below and enables an analogue value to
be represented in a graphical way.

70 <]

48600°C

o Physval &

Un configured Configured
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7.21.4

Chart

A chart type dashboard appears as shown below and enables values to be represented
as a graph, e.qg. histories. Time schedules can also be added enabling you to view the
occupancy state and when a parameter is at a certain value.

) B Today _@eABO O = ® B Today @@ ADOo® o
Heatingl_Outside_lemperature_fahysVal

Un configured Configured

Configuring a Dashboard

Configuring a dashboard requires access to the Nav free.

Adding an item to a Dashboard

- Use the Nav tree to locate the point required.

- Drag the point onto the dashboard. For charts you can add more than one value.
Save a Dashboard
« Click [ on the dashboard.

» Saia PCD® Supervisor

File  Edit Search Bookmarks Tools  Window
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7.2.2

7.2.21

7.2.2.2

7.2.2.3

7.2.2.4

Use Saia PCD® Supervisor

Using Saia PCD® Supervisor via the Nav Tree

Basic Controls and Navigation

To see the location of the following Saia PCD® Supervisor controls and features, refer

to the diagram on chapter “2.2 User Interface Application (Host PC)”

Nav Tree
To show the side bar:

- On the menu bar select Window > Side Bars and ensure Show Side Bars is
checked.

To add a Nav tree to the side bar:
- On the menu bar select Window > Side Bars > Nav.
To remove a Nav tree from the side bar:

- Click the arrow to the left of the Nav tree title and select Close.

Palettes
To show the side bar:

- On the menu bar select Window > Side Bars and ensure Show Side Bars is
checked.

To add a Palette to the side bar:
- On the menu bar select Window > Side Bars > Palette.

- Click the file icon and select the Palette type from the displayed options.

To remove a Palette from the side bar:

- Click the arrow to the left of the Palette title and select Close.

Locator Bar
To navigate down the hierarchy:

- Holding the mouse over an item: a small arrow will appear.

- Click the arrow to reveal a drop down box and select the required option.
To navigate up the hierarchy:

- Click on an item in the bar to navigate back to that level.
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To navigate to specific location:

- Click in a blank area of the locator bar and type the path directly into the box.

7.2.25 View Pane & View Changer
To change the view of a selected item:
- Click the view changer box and choose the required view.

Or

Right-click the item (e.g. in the Nav tree), then select Views > and the required
view.

7.2.2.6 Viewing and Changing values of a Point
To view a point value:

- Use the Nav tree to locate the point required.

- Double click the point (or right-click and select Views > AX Property Sheet) to view
its Property Sheet. The Out item will indicate the current point value.

To change a point value (writable points only):

1. Use the Nav tree to locate the point required, right-click the point and select
Actions > Set Value.
Or
Click the button that allows the value to be adjusted.

The Set dialogue box is displayed.

im» Set b4
3. 000 C
oK | Cancel ‘

2. Type the required value.

As default Saia PCD® Supervisor does not check that the value entered is
valid. The limits can be set for Numeric Writable. When the operator types
value outside of the limits the value will not be accepted.

3. Click OK.
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7.2.2.7

Viewing Alarms
Viewing Alarms Using the Alarm History
1. In the Nav tree open the Services folder (under Station > Config).

2. Right-click AlarmService and select Views > Alarm Db View. The Alarm History

is displayed in the view pane.

[« Saia PCD® Supervisor —

File Edit Search Bookmarks Tools Window  Help

a2y 2 ®

& o ) My Network

& My File System

Timestamp SourceState AckState Source Alarm Class Priority Message Text
@ My Modules

A 02-May-17T2LIBAMCEST  Norml nacked  172.23.13.19:19/myAlarmList/7 DefaultAlarmClass 255 ErorT

o My Tools i )
ey A 02-Moy-177:2127AM CEST  Normal Unacked  172.23.13.19:15/myhlarmList/8 Default Alarm Class 255 Errors
@ 127.0.0.1 (Demo_station) M 02-May-177:23:5T AM CEST  Normal Unacked ~ 172.23.13.19:18/myAlarmList/5 DefaultAlarm Class 255 General error
& station (Demo_station) A\ 02-May-177:24:00AM CEST  Normal Unacked  172.23.13.19:15/myhlarmList/3 DefaultAlarm Class 255 e B
A alerm M 02-May-177:24:01 AM CEST  Normal Unacked  172.23.13.19:19/myAlsrmlist/2 DefaultAlarm Class 255 short circuit
© config A 02-May-178:14:13AM CEST  Normal Unacked  SBCIpNetwork DemoDevicel  DefaultAlarm Closs 255 Ping Success
A 02-Mzy-178:3ISTAMCEST  Offnorma | Unacked  Alarm Critical Alarms 255 Pump Error
A 02-May-179:33:52AM CEST  Offnorma | Unacked 17223.1319:19/myAlarmList/4 DefaultAlarm Class 255 Window open
A 02-M3y-17 933152 AM CEST  Offnorma | Unscked  172.23.13.19:19/myAlsrmList/1 DefaultAlarm Class 255 Errorin Pump Heating

© AuditHistoryService
© Logtistorysenvice
- Palette =A

W X B | @ webChat

3. Use the selector box (top left) to choose the required period.

It is recommended that the Saia PCD® Supervisor user need to use the
updated station in order to load the SBC Alarm Console page correctly.

Alarm History 9 Alarms
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7.2.2.8 Using the Alarm Console

The Alarm Console allows you to view details of each alarm, acknowledge an alarm or
add notes to alarms. Notes are useful to record actions (particularly for critical alarms)
such as who has been notified, contact numbers and agreed timescales for fixing the
problem.

To view specific alarm details:

1. In the Nav tree open the Station > Config > Services folder.

2. Double click AlarmService. The view pane will display the Alarm Service wire
sheet.

3. Double click on the required ConsoleRecipient to open the Alarm Console:

® Saia PCD® Supervisor

File Edit Search Bookmarks  Tools  Window Wire Sheet  Help

127.0.0.1(Demo_Station) o Station ([Demo_Station) & I Services I AlarmService
- Nav Wire Sheet
P O () My Network
- - B ‘Mlarm Db Config [
File Alarm Bb Cortlz
) Wy File System
Alarm Class A
¥ MyTaals [Marm
e e ]
& Platform
@ 127.0.0.1 {Demo_Station) e !I = o =
& siation (Demo_station) ‘:'"“c"” B
jarm t
A Aam L J Status {udJ
© config
@ services
O Alarmservice
@ BackupService
@ categoryservice
@ Jobservice
-
SBC Alarm Console
Time Range Tto 7 G)
Timestamp Source State  Ack State Source Alarm Class Priority Message Text
A 02-May-179:33:52 AMCEST  Offnormal OAcked/1Unacked 172.23.13.19:19/myAlarmList/4 Default Alarm Class 255 Window open
A 02-May-179:33:52 AMCEST  Offnormal OAcked/1Unacked 172.23.13.19:19/myAlarmList/1 Default Alarm Class 255 Errorin Pump Hesting
.‘ 02-May-17 8:33:5TAMCEST  Offnormal OAcked /11 Unacked Alarm Critical Alarms 255 Pump Error
A 02-May-17 8:14:13AMCEST  Mormal OAcked /2 Unacked  SBClpMetwork_Demo Devicel Default Alarm Class 255 Ping Success
A 02-May-17 7:24:01 AMCEST  Mormal OAcked/1Unacked 172.23.13.19:19/myAlarmList /2 Defsult Alarm Class 255 Shortcircuit
A 02-May-17 7:24:00 AMCEST  Normal OAcked/1Unacked 172.23.13.19:19/myAlarmList/3 DefaultAlarm Class 255 Power breakdown
! 02-May-17 T:23:5TAMCEST  Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/5 Default Alarm Class 255 General error
‘ 02-May-17 7:21:27TAMCEST ~ Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/8 Default Alarm Class 255 Error@
‘ 02-May-17 7:21:26 AM CEST Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList /7 Default Alarm Class 255 Error?
A 01-May-17 10:00:37 AM CEST  Offnarmal 0Acked/1Unacked BacnetNetwork Trainingscenter Defzult Alarm Class 255 Ping Failed
A 01-May-178:32:22 AMCEST  Normal OAcked/1Unacked 172.23.13.19:19/myAlarmList/6 Default Alarm Class 255 Erroré
A 18-Apr-17 7:50:44 AM CEST Normal OAcked/1Unacked SBClpMetwork CPUOOL Default Alarm Class 255 Ping Success
A 13-Apr-17 4:19:14 PM CEST Narmal OAcked /36 Unacked slot:/Drivers/BacnetNetwork/Trainingscenter/alarms  DefaultAlarm Class 255 Narmal
.. 12-Apr-17 12:47:14PM CEST  Offnormal 1Acked /0 Unacked  172.23.13.19:19/myAlarmList/1 Default Alarm Class 255 Errorin Pump Heating
.! 12-Apr-17 9:43:29 AM CEST offnormal 1Acked /0Unacked  172.23.13.19:19/myAlarmList/2 Default Alarm Class 255 Shortcircuit
.‘ 12-Apr-17 3:43:29 AM CEST Offnormal 1Acked /0Unacked  172.23.13.19:1%/myAlarmList /6 Default Alarm Class 255 Erroré
.‘ 12-Apr-17 4323 AM CEST Offnormal 1Acked /OUnacked  172.23.13.19:1%/myAlarmList/5 DefaultAlarm Class 255 General error

Current alarms are indicated by a red icon, retuned to Normal alarms are
indicated by a green icon.
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4. Double click an alarm line to open the Alarm Viewer. This will list all current and
cleared alarms related to the same alarm condition:

@ locals| lot:/Drivers/SBCS2 SBCIpNetwork_Demo/Devicel/points/Heating1/Supply/Pump/Alarm/Alarm x
Timestamp Source State AckState Source Alarm Class  Priority Message Text ®

M 02-May-178:335TAMCEST  Offnormal ~ Unacked  Alarm  CriticalAlarms 255 Pump Error

A 18-Apr-1710:45:40 AMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 18-Apr-17 10:37:45 AMCEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 18-Apr-179:3%:09 AM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 18-Apr-179:3L44 AMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 13-Apr-179:08:39 AM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 18-Apr-178:38:09 AM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 18-Apr-178:06:38 AM CEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 18-Apr-1TT:SE5IAMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 13-Apr-174:14:29PM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 13-Apr-172:3T:59 PM CEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

& Acknowledge Hyperink P nNotes Review Video [¥] close

5. Double click an alarm to open the Alarm Record, giving full details of the alarm.

“® Alarm Record

Timestamp b2-May-17 8:33:57 AM CEST

Uuid 11£20d495-73ab-4601-82d8-8e650d54cabd

Source State Offnormal

Ack State Unacked

Ack Required true

Source Rlarm

Alarm Class Critical Alarms

Priority 255

Normal Time null

Ack Time null

User Unknown User

Alarm Data Alarm Value true
Count 21
Escalated
From State normal
Message Text Pump Error
Notes ))
Numeric Value 1
Offnormal Value true
Present Value true
Source Name Rlarm
Status {ok}l @ def
Time Zone Europe/Berlin (+1/+2)
To State offnormal

Alarm Transition Offnormal

Last Update 02-May-17 8:33:57 BEM CEST
4 | a Acknowledge

local: |station: |slot:/Drivers/SBC Systems/SBCIpNetwork Demo/Devicel/pointsa/Heatingl/Supply/Pump/Alarm/Alarm

Hyperlink

E] Close

E Notes |

To acknowledge an alarm:

1. Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record

for a specific alarm.

2. Click the Acknowledge button.

Multiple alarms can be selected and acknowledged at the same time in
the Alarm Console or Alarm Viewer by clicking in conjunction with CTRL

and/or Shift keys.
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To view or add notes for an alarm:

1. Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record
for a specific alarm.

2. Click the Notes button. The Notes window is displayed and any previously added
notes will be shown with a timestamp in the top section:

» Notes X

## 02-May-17 8:39 BM CEST - admin ##
There is a serious bug in the syatem. Do not panic!

My shift is over. I drink a beer.

! Add Note | E] Close |

3. Type any new details in the lower section and click the Add Note button to save, or
click Close to close the window without adding a new note.

ﬂ You cannot add notes to multiple alarms.

7229 Viewing and changing Occupation Times (Scheduler and Calendar)
in Saia PCD® Supervisor

Changing the Weekly Schedule

The weekly schedule determines the occupation times for a normal week, i.e. no Spe-
cial Events apply.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired WeeklySchedule.

2. Double click the WeeklySchedule. The Scheduler is displayed in the view pane.
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[E)save | CRefrech

3. Select the Weekly Schedule tab.

4. Specify the required occupation times:

To add a new time period:
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods:
Drag the top or bottom edge of the green rectangles to the required time.

To set all day occupation:
Right click the day and select All Day Event.

To a apply a period a day’s times Monday to Friday:
Right click the day and select Apply M-F.

To remove a time period:
Right-click the rectangle and select Delete Event.

To remove all time periods for a day:
Right click the day and select Clear Day.

To copy a day:
Right click the day and select Copy Day then right click the day the times
are to be copied to and select Paste Day.

5. Click Save.

Editing Special Events

Special events enable different occupation times to be used on specific days.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired BooleanSchedule.

2. Double click the WeeklySchedule. The Scheduler is displayed in the view pane.
3. Select the Special Events tab.
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2 (Provbage 4 Proviionth |Taday | NextMonth b WextPage b
¥ o ® wyhetwon May 2017 Jun2017 Ju2017 Aug2017 Sep2017 0d2017 Nov2017 Dec2017
= smt wtf s|fsmtwtf sf|smtwtif s|fsmtwtf sflsmtwtif s|/[smtwtifsifsmtwtifs||smtwt s

~ Palette
»E D [§ e

B Enumscheduleselector

@Onrd @t apdonty ¥ prionity [l rename X Delete

BB WeeklySchedule | B SpeclEvents ) Properties (D Summary

. Specify the required Special Events:

Add a special event
1. Click Add. The Add dialogue box is displayed.

o Add bt

Name Christmas

Type |DateRange

25 Dec Any Year m
Through
26 Dec Any Year m
0K | Cancel ‘

2. Specify a name for the special event in the Name box.

3. Select Date or Date Range in the Type box.

Specify the date(s) the special event applies to:

Date: Specify the day month and year in the appropriate box.

Date Range: Specify the day month and year for the beginning of the range in the
appropriate box in the top row and specify the day month and year for the end of
the range in the appropriate box in the bottom row

4. Click OK.
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Edit the times
» Click the special event for which the times are to be edited.
To add a new time period:
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods:
Drag the top or bottom edge of the green rectangles to the required time.

To set all day occupation:
Right click the day and select All Day Event.

To remove a time period:
Right-click the rectangle and select Delete Event.

To remove all time periods:
Right click the rectangle and select Clear Day.

To ensure non-occupancy outside the specified periods
Right click the day and select Schedule Defaults.

Rename a special event

1. Right click the special event that is to be renamed.

2. Click Rename. The Rename dialogue box is displayed.

Name Summary

Christmas = g nge: 25 Dec- 26 Dec
Add

Swiss52420Mational 524 Aug 2017
Edit
Rename

Priority
Delete

3. Enter the new name.

4®» Rename >

@ EnterName

OK | Cancel

4. Click OK.
5. Delete a special event

6. Right click the special event that is to be deleted.
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7. Click Delete. The Confirm dialogue box is displayed.

™ Confirm x

@ Delete "Swiss52420National52420Day"
Yes ’ No

8. Click Yes.
9. Click Save.

Editing the CalendarSchedule

If a CalendarSchedule has been added to specify days different occupation times are
used, these days can be edited by add or removing events from the CalendarSchedule.
1

. In the Nav tree open Localhost > Station(Demo_station), navigate to the required

CalendarSchedule.

2. Double click the CalendarSchedule. The Scheduler is displayed in the view pane..

[« 5eia PCD® Superisor

Sttion (Demo_Station)  : Config  : Calendarschedule

A Prevpage 4 Prevonth Today | NextMonth b NextPage )

Way 2017 Jun 2017 2017
smtwt (s

smtwtfs

Aug 2017

smtwtf s

Seop2017

emtwtf s

Oat2017

smtwtf s

Nov2017

smtwtfsllem

Anns
- Palette B
X D (@ shede

B Booleanschedule
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Add a date
1. Click Add. The Add dialogue box is displayed.

@ Add X

Name Ewvent

Type |Date

Any Weekday 2 May 2017 m

OK Cancel

2. Specify a name for the special event in the Name box.

3. Select Date or Date Range in the Type box.

Specify the date(s) the special event applies to:

Date: Specify the day month and year in the appropriate box.

Date Range: Specify the day month and year for the beginning of the range in the
appropriate box in the top row and specify the day month and year for the end of

the range in the appropriate box in the bottom row.

4. Click OK.

Edit a date
1. Double click the date that is to be edited.

2. Edit the date as required.

Rename a date
1. Right click the date that is to be renamed.

2. Click Rename. The Rename dialogue box is displayed.

Name Summary

Christmas i rioe: 25 Dec- 26 Dec
Add

Swiss52420Mational 524 Aug 2017
Edit
Rename

3. Enter the new name.

« Rename X
@ erictome

0K Cancel

4. Click OK
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Delete a date
1. Right click the date that is to be deleted.

2. Click Delete. The Confirm dialogue box is displayed.
3. Click Yes.
4. Click Save.

7.2.210 Viewing a History (Graph)
1. In the Nav tree open the History folder (Station > History).
2. Open the folder for the required controller.
3. Double click on the history that you wish to view. The Chart view is displayed.

. [« Seia PCD® Supervsor - 6 X

Heating_Outside Temperature_Physval
- Nav B @ R Today -@QaABDoe o
Heatingl Outside Temperature PhysvVal @ Heatingl_Outside_lemperature_Physva

40.000

20.000

20000
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Viewing Multiple Plot Graphs

To add another plot to the same chart:
Drag the required history from the Nav tree onto the Chart view.

Adjusting the Displayed Information

To change the displayed time period:
Use the selector (at the top left of the Chart view) to choose the required
time period.

To change the horizontal scale:
Mouse over the appropriate scale until the cursor changes to a double ar-
row.
Drag the mouse left or right to change the scale.

To change the vertical scale:
Mouse over the appropriate scale until the cursor changes to a double ar-
row.
Drag the mouse up or down to change the scale.

Viewing the Source Data

To view the source data in table form:
Click the View Changer and select History Table.

Exporting a Graph or Data Table

1. In the Nav tree, right-click on the required history and select Export. The Export
dialogue box is displayed.

2. In the Select Exporter box select the required export type and file format.
3. Choose the export method (e.g. Save to File).
4. Click OK.

Viewing Live Updates

1. View the desired plot (as described above) and change the view to History Chart.

2. Click the Play button » to start getting history updates. At the bottom right corner
of the window the message ‘Waiting on first Live Update...” will appear.

3. When the time period has elapsed the message will change to show ‘Last Live
Update’ with the date and time of the update.

If you zoom in on the chart, live updates will not be visible anymore. If you
need to see values that are not visible on the chart you need to switch to
History Table view
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7.3 Manual start the Saia PCD® Supervisor Station

1. In the Nav tree open
My Host > Station(Saia PCD® Supervisor) > Platform > Services.

2. Double click Application Director. The Application Director is displayed in the
view pane.

[@ SaiaPCD® Supenisor - X
fle  Edu
/  Application Director ~
~ Nav [ Application Director
¥ o @ My Network Connectedtolocalhost
Name. Type St Detae AukorStart Resorkon Fllre &
My Host: SZ43LTI06GHF2 globlds honeywellcom
9 - S a2 saton ide  fomnlsforeniahtpniahtpens ke tue
My FileSystem
Centab 08 saton ide  fomnlsforen/ahtpniahtpenis ke te
© wyvodes B centab hitpenia it
B ey 5 bemo_station sotion ldle  for191Lfoxs=4911 http=niafttps=243 true true
1 Pltfom 5 sncens saton e fomnsforeniahtpniahtpens ke tue
@ Appicatonvrecor 5 snceos il woon e fomnsfommahpnampens ke e
© certfcate Management B sec_saus Testt. sation ldle  foxn/sfor=n/ahtipniahtips=n/a false e
O oscan nsaler S sec TMte Workshop staton Wl foensfos-nahtipishtpe/s  false  tue
g““"*'-‘a“%" [Ep— e i obrm i aamvami 1 e
Platorm Adninsration
® EvanngCenter 1 saton e fornifos-nahtpishtpenis  fase  tue
station Covier
O Tee/p confguration o 17 CES1] {Sbolpbeives] +++++ Signed vaise in comvertByrersayToSionedint 1s & @ suto-strt
e CEST] [Sbelpbriver] +++++ Signed value in convertBytehrrayTosignedlat
? © Remoteriesystem 1m0 CiSi] [Spelpriver| ++ees Sigued Velie in comverisyieArraylovignealnt 1s Bl Restartonaire
S R CEST] [Sbelpbriver] +++++ Signed velue in convertByrehrrayloSignedlnt ia
ERRpae 1L INFO CEST] [SbclpDriver] ****+ Signed value ir rtByteArrayloSignedInt is : Start
&' saton vemo_saton) o CEST] [MIgDriver] +++at 3igumd Velue 1 GonveriByleALEeyIOSIguntIat 1o & -
e CEST] [Sbelpbriver] +++++ Signed value in convertBytehrraylosignedlnt is
R CEST] [Sbelpbriver] +++++ Signed velue in convertByrehrrayloSignedint 1s Restart
o CESI) [Shopbriver] e+t Signcd value in convertByrehrrayloSignedlnt 1a
e CEST] [Shelpbriver] +++++ Signed value in convertByrehrraylosignedlnt is Reboot
R CEST] [Sbelpbriver] +++++ Signed velue in convertByrehrrayloSignedlnt is
o il
R
o Dump Threads
R -
Be SaveDoE
i) Verify Software
INFO i
e
INFO Clear Output.
INFO -
- palette Rl vause output
mr
mr Output Dislog
D [§ e =
TR Stream To File
[ T ]
BB enumschedule o Output Settings
[ T——— R CEST] [Sbelpbriver] ++4++ Signed value in
o CESI] [Spelpbriver] +++e+ Signed value in
BB sungschedule R0 CEST] [Sbelpbriver] +++++ Signed value i
mr CEST] [Sbelpbriver] +++++ Signed value in
D calendarschedule e CEST] [Spelpbriver] +++es Signed value in
e R CEST] [Sbelpbriver] +++++ Signed value i
BB Togeerschedul INFO CEST] [console] Quit
B8 Booleanscheduleselecor 1m0 Cisi| [sya) saving station.
R Gest] [sys] Saved bog (2¢2m)
BB Numercscheduleselecor mr cest) zox] C 1 < Workbench &
o CE3t) [sya) Seavion stoppe;
BB singsheduleseector o CosT] (£on] Secvice stopped
mr CEST] [zox] 0K sezver stopped on port [1911]
BB enumscheduleselecor INFO CEST] [fox] FOXS server stopped on port [1911]
R CEST] [web] ety scopped.
R CEST) [aya] Services st
) 024317 CEST] (33] *++ Station shucdowm ++%

Stat: Start the selcted application

3. Click Start.
The station will be started, check that a ‘Station Started’ message is shown.

[ Saia PCD® Supenvisor

File Edit Scarch Bookmarks Tools Window Help

WF2 globalds honeywelleom . Platform 7 Applicaon Direc]

-+ Nav [ Application Director
¥ o @ wynetwork Comectadtolocalhost
Name Type  Status  Detaie AutoStart Restarton Fiure il
© iy RSO 2 b honeswelcom g T -
sl st astion s formn/apttpenlatittpsenla  folse tue
b @ wyrilesystem = m z = : = =
© tytodiles S contab e saton e famnafosmniahttomaiabitpsnia  fabe |t
P e = emo_station sttion Running. for=1S1Lfoxs=4911L htpen/ahtpsedd3 te e
2 platorm =y saton idle  foenlsfocnlehpenahtpsna  fae e
@ Aopication Dircior B saceos_final sation 1dle fomenioptpmniahupsenfs  fose e
Q certficate Management. B sec_seus_Test1 stetion Wle  foxen/a foxs=n/aillp/ahtips=n/a  folse e
O Lexconinsuler 500 ™M2016 Workshop sation Idle  forn/afox-niohtto-niohtipsn/s  fose  tre
g““"””“"““ 5 satonsupes soton e fomnafommnloptpniabtora  fose tme
Plattorm Administraton
ElTining Center ¥1 stston Idle  forn/afoc-nishto-nishtpen/s  false  tue
® stotion Copier
© 1001 Confgurstion ) Launching Nisgera Runcise Environsent @ auto-siare
203:52 02-May-17 CEST) (ave] Booring
@ Remoteilesystem 03:53 02-May-17 CEST] [sys] Logging inivielized B Restarton e

<04

02May-17 CEST] [aya. regiatry] Up-to-date [133ma]

127001 (Demo_Station) :04:00 02-May-17 CEST] [sya. regisory] Loaded [37ms] it
02-May-17 CEST) (sys] Niagara runtime booted (°C: -2.36.34%) on (8341m3)

&' Station Demo_staton) ooy Sl e & = stop
02-May-17 CEST] [Soclpbraver] *v+s* BSbcUapComiContiy is imitialised == T
02-May-17 CE o Lo inicialised sers
02-May-17 CEST] [SbCIpDriver] ++++ BSBCUGpCOMICONTIg 13 initialised *+sn Reboot
02-May-17 CEST) [sys] Loaded (14edns)
02May-17 CEST [alazn. davabase] Loadi: K

90 alarms, 184 pages] —
) Dump Threads

02 tay 17 CEST] (sagdictionaey] Niagose tagdictionary ia out of dace or hao becn medificd. saveBog
U2-May-1] CESI| [CAQU1CTIOnAEy] Niagara Taqaictionary nas been reloaded.
C2okay-17 CEST] (oye.mixin] Updaced [oma Venty software
02-May-17 CEST] (Web] JecCy Web server svarced on HITES porc 443
pr Vaki How in =
02-May-17 CEST] (SbelpDrives] Device piaging: Devicel r Outp
(9-3ay-17 CEST] (SbeTphriver] Randing BCD Tnformatson: Devical —

- Palette 02-May-17 CEST] [honBACaesUciliviea.bacnes] DlonBacnecDevice: started: ]
02-ay-17 CEST] [fox] FOK server starced on port (1911] GRIADRE

w E D E e 02 tay 17 CEST] (fox] FOKS sexver staseed on post (4911]

10:04:04 02-4av-17 CEST! Stream T File
4702 Yoy 17 CEST) (aya] +++ Stavion Svarved (1344ms) (11855m0 coval] * |
sy

BB sooleanschedule 04+
TNFO (10:04:05 03-May-17 CEST]

BB Enumschedule Our—|
B8 numencschedule
BB stringSchedule.
B Calendarschedule
B Triggerschedule
BB Bolemchedleseector INFO [10:04:04 02-May-17 CESI] [sys] Niagara Runtime Environment: 4.2.36.34

D numeesieduieseiesr ‘ INFO [10:04:04 02-May-17 CEST][sys] *** Station Started (1344ms) [11855m3 total] ***
BB stringScheduleSelector
BB enumscheduleselector
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7.4

HTML5 Enhancements

HTML5 Enhancements

Improved and newly created base templates for improved usability, also for mobile
devices.

B Time program view improved
® (complete in HTML5)

B Alarm console new
® (complete in HTMLS)
® Improved use of available space
® Responsive: details fold-out, automatic scaling

B Role manager new
® (complete in HTMLS5)
® |Improved use of available space
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Cloud Connector

7.4.1 New reporting functions
B All reporting visualizations are fully inte- py— -
grated in HTML5 -
X 8§ repor
o ReportWidgets
B Responsive design for mobile devices %) canvasPane
@ BoundLabel
m BoundTable
. O Reporting
B Can now also be used in the dashboard B
D ExportSource
B2 EmailRecipient
B Improved export functions O Fiereapent
@ BqlGrid
E ComponentGrid
O GridExamples
B Predefined examples in the palette Bl Atpointsgalarid
E AllPointsNeqlGrid
7 E RelativeBqlGrid
® NEQL and BQL can be combined I comcenviomensid
Ii[ PointListComponentGrid
7.5 Cloud Connector

Enables station to establish secured connection to the cloud

service

B Included in installation and at no ad-
ditional cost - Part of Software Mainte-
nance Service (SMA)

B First cloud offers:
® Backup as a Service (BaaS) - offers

B Reduction of operating costs
B Improved uptime, reliability and energy
efficiency
B Reduce data loss with automatic backup
e

Cloud Connector Device Registration

secure and scalable backups in the Device Regitered o
cloud (Available from Tridium) Cloud ComneclorErabled. @

® Action management - manage com- _ A
Device Connected t

mon priority problems from anywhere
using the app

® Performance Analysis - Automatic Er-
ror Detection and Notification

System Type Plant

System GUID - none -

REGISTER DEVICE
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7.6

7.7

Bulk deploy

Bulk deploy

A single action can create multiple instances of one or more templates on a station

B The mass provision process includes these primary steps:
® Select a template and create an Excel file from it
® Each Excel worksheet contains a row with the unique information required by
each Device
® This “customized” Excel file is selected for mass implementation and extracts all

ne nzent Jaw Page Layout ormulss  Data  Rewew  View  Meig  \PTel me what you w
oy
b, 0 - A A : Wrap Te p Ny & X m ?_ Ay p
4 Z
! - emat et D Farmat Sot & Find &
= B I U A £ ¥ Merge & Cente o 9 s pabila - & E Filtar - Sel
— = Hur + i -
G sge v
A B c D E F G H 1 J K L L]
1 Template Description 1 Configs
2 Slot Name s gecAddr hs:geoCity hs:geoState
3 User Tip
4 Slot Type baja:Siring " baga:String " baja:String
5 R I _ Default Value
& Parent Component Slot Path " Deployed Name "Display Name " Position "Unique Device 7 Description
T Drivers/BacnetNetwork Floor2 Floor 2 Thames Hotel New Orkisans Loumssana
8 Drivers/BacnethNetwork Floor3 Floor 3 Thames Hotel New Orieans Louissana
9 Drivers/BacnetNetwork Floord Floor 4 Thames Hotel New Orieans Louisiana
10 Drivers/BacnetNetwork Flooe5 Floor 5 Thames Hotel New Orleans Louisiana

1"
12
Tridium-Floor.ntpl Tridium-RoomDehocatpl | Tridum-RoomStandard ntpl 7

VykonPro modules (on request)

The VykonPro module is a collection of station components and px widgets that are
provided as a value add to the Vykon channel partners. The station components and
px widgets only function in a station whose license is branded Vykon (brandld="vykon”
or brandld="vykon.security”). There are no extra features required in the license file for
the components to function.

B These tools are designed to save - Palette & - Palette 5]
programming time, extend the standard X D @ wero W ® B @ whenproTansfom
Offenng, and help W|th System deve|0p- [8 wkonprotula [l TableToHistory
ment O BA HistorySourceDelta

"W VykonProservice TransformChartPane
B A demonstration station called "vy- (e :
" . . Q conversion ~ Palette 4]
konProTest" is available from Niagara Q eney
W [X] B § wkonProutil
Central g: )
i . vac @D BatchCategoryAssignmentTool
® The station shows how each single O g W
component can be implemented in g""'“‘“ 81 satchproxyConversiontditor
report arms
the vykonPro modules O sexestansom 8:0m”mm
O timer AbsTimeOverrides
Ou © AbsTimeOverrid
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7.8

Setting customized login and background logo

This chapter describes how an user can add and save the customized station login
design with customized background logo.

Adding slots for customized login and background logo

1. In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Services.

2. Click on WebService.

Nav

# O () My Network

© searchsenvice
© TagbictionaryService
TemplateService
@ webservice
4 BatchJobservice
£ EasyDatabaseManagersanvice
T Platformservices
[ SeiaP&3sDataimportivizard
& calileoservice
© privers
O niagarsNetwork
O Bacnetnetwork
6 ModbusTepNetwork
© 4ops
@& Files
3 Hierarchy
O Histore
- Palette

W X B @ sslicosupervisor

Galileoservice

- Easy Templating

[7] = Property Sheet
@ webservice (Web Service)
[ status
[ Fault Cause
[ Enabled
(@ Http Port
[l Http Enabled
(gl Https Port
(M Https Enabled
(@ Https Only
[ Https Min Protocol
[ Cipher Suite Group
(W Hittps Cert
[l Require Https For Passwords
(@ x Frame Options.
[l Remember User Id Cookie
(W Allow Username Autocomplete
[ Login Template
[ LogFile Directory
[l Client Environments
(3l Show Stack Trace
[ web Launcher Module Caching Type
(i web Launcher Config
» [ Cache Config
[l Hostname Redirect Settings
@ Jettywebserver
& user Data Storage

[ force Custom Login Settings at Restart

fok}

@ true

80tcp

@ false

443 tcp

[ I

® e

TLSvL.0-
Recommended
tridium

@ true

Sameorigin

[ I

@ rrue

& nol

file:~ weblogs
Client Environments
@ false

Host

Web Launcher Config
Cache Config
Hostname Redirect Settings
Jetty Web Server (started)
User Data Config

@ fatse

3 Refresh

@] save

3. Go to the AX Slot Sheet view from the View Selector.

4. Right click on the page and select Add Slot.

5. The Add Slot dialogue box is displayed. Type the correct and same name in the
Name area. Select the required Type. User can select baja Ord or baja String.

Click OK.

Y |aja:ServerPort
aja:Boolean
@ja:ServerPort
aja:Boolean
!aga:So olean
|aja:SsiTIsERLmM

gja: TlsCipherSuite

aja:String

|aj.::E‘,o alean
;eb:xFrameantwon
|zja:Boolean
jaJa:FL;\ olean
ia,a:T;'Desnec
izja:ao olean

Bja:0rd

peb:ClientEnvironr
aja:Boolean
peb:AppletModule

Fh:w:bstamcnnﬁ

(O Property 3 httpPort b
Add Slot |
O Property 4  httpEnabled
Name
O Property 5 httpsPort logo
(O Property &  httpsEnabled
Type
Property 7  httpsOnly
Qe il baja string n -
i el s
O Property 9  dpherSuiteGroup Flags OrdList
|
O Property 10 httpsCert [ operator ] NoAudit  OrdToCategoryMap
y m -, Password
(O Property 11 requireHttpsForPa [ Rreadonly (B e
[ T — PasswordAuthenticator
(O Property 12 xFrameOptions Lol Clsencisy o
., | PasswordCache |
= [J Execute On Change [] Metadata
() Property 13 rememberlseridcy PasswordHistory
TSnsIERt Uinfelzre: 4 g
O Property 14 allowUsernameAu| oy - PasswordSgength
[ summary [ Non-Critic 5 5
= R PermissionGroupinfo
O Property 15 loginTemplate = UserDefi
| | =Rl il [ ——
Py rty 16 ipEnabled x
O ERERE [ SRR L_J Fan in D User Defin PermissionsMap
(O Property 17 logFileDirectory [ Hidden [ userpefin pxiew
O Property 18 cdientEnvironment ] D [ user Defin RelTime
= ; |
(O Property 19 showStackTrace | JAsn Relation
| P o im i
O Property 20 appletModuleCach
O Property 21 webStartConfig l 0K | Cancel
(O Property 22 cacheConfig Cache Config Frozen
O Property 23 warmupConfig Warmup Config Frozen hM

web:CacheConfig

webWebWarmupCi
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6. Similarly, create one more slot for the css login. Click OK.

For more details on how to add or edit a Slot, refer to Tridium Niagara
documentation docuser file which is available in the Niagara workbench.

7. Go to the AX Property Sheet view from the View Selector.

To set the customized logo background colour:

1. Go to the newly added logo property.
2. Click Folder icon. The File Chooser dialogue box is displayed.

3. Select the required logo image file.

Property Sheet

@ webService (Web Service)
(M Status {ok}
[ Fault Cause
[ Enabled ® e 7
(@ Http Port 80 tcp
. HitpEnabled 4#» File Chooser > |
il Https Port
[l HttpsEnabled || B FileSpaces [ |
= 1 e Alogin |
Ll Https Only Fileson Station (SBCImpc S
= - 4« oA ®E S B3 '
[l Https Min Protd | ) My Modules |
= | a favico.png
.l Cipher Suite Grq |
— 1 E favico.svg |
Ll Https Cert
i ) [ togin.cs=
.l Require Https F{
o | logo.sve
Ml X Frame Option] & h

[ Remember Usej "
1 o Loading Preview

(@ Allow Usernam{ R Bookmarks [

. Login Templatd

[ Log File Directol »

[ Client Environn]

Wi Show Stack Traf

Ll Web Launcherh: Filaname: [Togoravg opeanl| |
. Web Launcher g Files of type: AllFiles(".") cancel | |
\Jl Cache Config

[ Hostname Redirect Settings Hostname Redirect Settings

@ JettyWebServer Jetty Web Server (started)

& User Data Storage User Data Config

[ force Custom Login Settings at Restart @ false
[ logo null 1M

[ loginCss null - )

4. Click Save to apply your changes.

To set the customized css login:

1. Go to the newly added css login property.
2. Click Folder icon. The File Chooser dialogue box is displayed.
3. Select the required css file with login details.

4. Click Save to apply your changes.
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To retain customized css login and logo after the station restart:

1. Go to the Force Custom Login Settings at Restart property.

In order to access Force Custom Login Settings at Restart property, user
must add the GalileoService in the Nav tree under the Services portal from
Palette. For more details, refer to Tridium Niagara documentation docuser

file which is available in the Niagara workbench.

2. To retain customized css login and logo even after the station restart, select the
Force Custom Login Settings at Restart property to true.

- Nav

t

Q

- Palette
W ] B @ selicosupenisor

[ catileoservice

- Easy Templating

Property Sheet
0 et -

(@ Http Port
(J Http Enabled
[ Https Port
W Https Enabled

[ Https Only

[ Https Min Protocol

[ Cipher Suite Group

(gl Https Cert

[l Require Https For Passwords
M X Frame Options

W Remember User Id Cookie

M Allow Username Autocomplete
(J Login Template

[ LogFile Directory

M Client Environments

[l Show Stack Trace

b Launcher Module Caching Type
[ web Launcher Config

(W cache Config

W Hostname Redirect Settings

@ Jettywebserver

& User Data Storage

[ force Custom Login Settings at Restart
[ logo

[ loginCss

] nut

file:~weblogs

Client Environments

Web Launcher Config
Cache Config

Hostname Redirect Settings
Jetty Web Server (started)
User Data Config

@ faise logo.svg

file:~] gm,q:w. cas

|

7 Refresh

3. To override customized css login and logo on station restart, select the Force
Custom Login Settings at Restart property to false.

7.9 Headstation and Substation Ping Read Timeout

The communication between the headstation devices and substation devices is critical
and need to ne consistently synchronous. Particularly for the substations, it takes more

time to get the response for the request sent compared to the headstation.

To overcome this difference, a new “Headstation Ping Read Timeout” property slot is
introduced in Headstation devices. Similarly, a new “Substation Ping Read Timeout”
property slot is introduced in Substation devices and the read timeout is increased from

250 millisecond (ms) to 4000 millisecond (ms) by default.

This conversion is only valid for SBC specific media types.

Using a Headstation Ping Read Timeout property slot:

1. In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Drivers.

2. Go to SBCIpNetwork and select the Headstation.
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3. Go to the AX Slot Sheet view from the View Selector.

Headstation and Substation Ping Read Timeout

4. Select the Headstation Ping Read Timeout property from the Slot list. Right click
on it and select Config Flangs.

5. The Config Flags dialogue box is displayed. Remove the selection of Hidden flag.

() Property 27 deviceName | Frozen ] bajacString
| «» Config Flags
(:) Property 28 isProgramCH Frozen rh bajaBoolean
O Property 20 programCRC) (] [Giperaton O Ho Audit Frazen Baja:string
ot
O Property 30 statusErrorM| [ ] Re Frozen baja:String
O Property 31 wuid L 4 Frozen rhd bajacUuid
O Property 32 statusUuld ge [] Metadata Frozen rhd baja:Uuid
O Property 33 pingRetryCol == e Frozen bajainteger
O summa O Non-Critical
OAC:IOI' 34 readAlarms == == Frozen haL void (void
O Action 35 readMultiPoi D Fanin Frozen ha void (void
O Property 36 dataPollFreq (5] Hidden Frozen h controlTimeTrigger
O Property 37 udpConfig a DQl.:(c».(;.;.ne Frozen h sbesbeudpCommConfig
() Property 38 headstationy || /- Frozen h bajacinteger
O property 39 SbeSubsStati Dynamic sheSheSubstation
0K I Cancel I
O Property 40 displayName- e ———— Cynamic bajaNameMap

6. Click OK.

7. Go to the AX Property Sheet view from the View Selector.

For more details about Config Flags, refer to Tridium Niagara documenta-
tion docuser file which is available in the Niagara workbench.

) orivers
) Nizgaraetwork
) sacipNetwork
X TuningPolic
© Head_o1_sE:

b & Head_02_sB
~ Palette

=X D § e

© printerRecipients
1O alarmservice

& AlarmClass

£ AlsrmClassFoldes
© Recipients

© extensions

10 Alarm Source nfo

@ s8¢ substation
© s8csubstation
© 5BC SubStation 05_A
© sac substation
© secsubstation
© sBcsubstation
© s8¢ substation ¢
© secsubsttion
1D Booleanwritable

REgistennritePointSub

A €3 ~ork/Bacli/pointsiloops200 () Addition76 @) Head_01_SBCIP Device_IPTS

Property Sheet

© Head_01_SBCIP Device_IPT8 [SBCHeadStation)

(@ Status

(@ Enabled

(@ Fault Cause
- CJ Health
s © Alarm Source Info

B+ Datapoines Poll scheduler
D Foints M 'p Address
1@ alarms W Station id
® Historles (M Read Timeout
e . o~
M Device Information % Points
(0]
esec SubStation 01_ATS &) Alarms
© secsubstat @ Histories

(W Ftp Username
(M Ftp Password

(@ displayNames

CIP Device_IP181

(M Device Information

(@ Http Password

[ Status Error Message

{J Ping Retry Count

© SBC Substation 02_A78

- © SBC SubStation 03_ATS8
= @ SBC Substation 04_ATS
SBC SubStation 05_AT8

© sBC substation 07_A78

© SBC SubStation 06_AT8

© SBC SubStation 08_AT8

© sSBC SubStation 09_AT8

@ SBC SubStation 10_A78

B+ Datapoints Poll Scheduler

(@ Datapoints Poll Frequency

(@ Program € R € Mismatcherror

M Headstation Ping Read Timeout
© SBC SubStation D1_AT8

{ok}

@ true

Ok [04-Nov-20 2:36 PM IST]
Alarm Source Info
N Poll Scheduler

Mormal

199.63.33.78:5050

3000 ms [200- 60000]
SBCPointDeviceExt
Alarms

Histories
SBCDevicelnformation
root

esessens
Program Version 4DCBC2C3 imported from B

3 [2-5]

250 I ms (250 - 20000]
$BCSubstation
{SbcSubStation20=5BC SubStation O0S5_A78:;51
SBCSubStation

SBCSubstation

SBCSubstation

SBCSubsStation

SBCSubstation

SBCSubStation

SBCSubStation

SBCSubsStation

SBCSubStation

false {ok} @ def

56.0 {ok] @ def

5 Refresh |

[T save

8. The Headstation Ping Read Timeout property slot is now listed in the Property
sheet with default value of 250 ms. This value is user configurable ranging from

250 ms to 20000

ms.
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Using a Substation Ping Read Timeout property slot:
1. In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Drivers.

2. Go to SBCIpNetwork > Headstation > Substation.
3. Go to the AX Slot Sheet view from the View Selector.
4

. Select the Substation Ping Read Timeout property from the Slot list. Right click
on it and select Config Flangs.

5. The Config Flags dialogue box is displayed. Remove the selection of Hidden flag.

6. Click OK.

For more details about Config Flags, refer to Tridium Niagara documenta-
tion docuser file which is available in the Niagara workbench.

. Go to the AX Property Sheet view from the View Selector.

Nav T £) ork/Bacla/points/Loops200 () Addition76 | (@) SBC SubsStation 01_ATS
tt O ® Property Sheet
© 5BC SubStation 01_A78 (SBCSubStation
[m Status {ok}
Head_01_SBCIP Device_IP73 M EnaGied @ true
0 Alsrm source In M Fault Cause
B+ Datapoints Poll Scheduler L Health Ok [04-Nov-20 2:36 PM IST]
B¢ Datz s Poll Schedule
B Foints © Alarm Source Info Alarm Source Info
& Atarms e+ Datapo | Scheduler N Poll Scheduler
) Histories M Datapol Frequency
M Device Information (M 1p Address 8:505
© s8¢ Substation 01 ATS W Station Id 1
g BbSt 3 ATE M Read Timeout 250 ms (200 - 60000]
@ Points SBCPointDevicebxt
@ Alarms Alarms
[l Device Information seCDevicelnformation
3 [1-5]
4000 ms [250 - 20000)
© Hesd_04_3BCIP De
© Head_05_SBOIP Device_IP187
~ Palette
m X B | § e
© printerfecipients
© Alarmservice
& AlarmClass
B AlarmClassFolder

© recipients
E sions

 Refresh Save

8. The Substation Ping Read Timeout property slot is now listed in the Property
sheet with default value of 4000 ms (4 seconds). This value is user configurable
ranging from 250 ms to 20000 ms.
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7.10 Setting up the S-Bus clock

A new SBC Clock feature enables you to set the seven day clock which captures 14
times. Each day can be assigned with two values, On or Off. Also the same set SBC
Clock points can be read and write to the Saia PCD devices.

To add a S-Bus clock

1. Click on the folder icon under Palette. Open Palette dialogue box is displayed.

2. Select SBC IP Driver from drop down list. “Points” palette will be displayed under
Palette window area.

3. Go to Points. Select SBCClock and then drag and drop it to the Points folder of
required station or device under Nav. tree.

= Nav A € ..ork/Baci3/points/Loops200 () AdditionTe ) SBCClock
t# O @ My Network Property Sheet
© valvers €©) sBcClock (SbccClock 7
© veluezo W Facets > O-
Q wiFile [ Proxy Ext SBCProxyExt
0 win W Status {ok}
0 writer [ Fault Cause
G wiire2 (W Enabled
3 alarming (M Device Facets
EH HoLog
EAl Hologe il Conversion
E]H.’.‘In;" (@ Tuning Policy Name E
Hs == Read Value 1.00 {ok},0.00 [ok},0.00 {ok},0.00 [ok],!
M- = Write Value {ok}
© secclock W Memory Address -1
@ alsrme M Data Format Signed Int
M Device Information - Out 1.00 [ok},0.00 {ok},0.00 [ok],0.00 {ok},!
M Se T Monda
|_,. e 1220
comments
[ mediaType clock
= Palette A MondayOn 1.00 {ok}
= MondayOff 0.00 {eok}
| X 3l TuesdayOn 0.00 {ok}
F saciphetwork TuesdayOff 0.00 {ok}
-] wednesdayon 0.00 {ok}
9=;L-:~h$'a'-<u- WednesdayOff 0.00 {ok}
1 PCDDeviceFolder ThursdayOn 0.00 {ok}
ThursdayOff 0.00 {ok}
FridayOn 0.00 {ok}
FridayOff 0.00 {ok}
SaturdayOn 0.00 {ok}
SaturdayOff 0.00 {ok}
Sundayon 0.00 {ok}
SundayOff 0.00 {ok}
7 Refresh ‘_(@Save |

4. Now, the SBCClock Point is added under tree. Click SBCClock.

5. Set On or Off status for selected day (Monday to Sunday). Then, add the time in
the form of integer number type.
For example: Selected Day to Write - Monday On
Value for Selected Day - 1220.

6. Click Save to save data to supervisor.

7. To write the saved values into the controller/device, right-click on the AX Property
Sheet. Go to Actions > Set.
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7.1 Use of UDP config slot from the Property sheet in every headstation

To overcome the issue of exception from the overfilled stack, every workstation is
added with one UDP channel from version 3.0. Now, each headstation can process
32 transaction threads which can help to process received and sent requets. This will
enhance the communication speed and performance.
—

* MNav

" 5 l:;) My Network

I Tuning Policies
@) Head_01_SBCIP Device 1P78
o Alarm 5S¢ Views

IQ- Datapoi

o AY Dr. "
& Points New t
@ Alarms

(AR Edit Tags
7 e 113k Template
© sBcsub

Cut

Copy

SBC Sub)
© secsub

© secsub Spy Remote

Link Mark

(=BT ojation Mark
© secsub
D eoolear
L) REgister

- Palette Rename A
I m 3 . alarm

O PrinterRecipients
o AlarmService

A AlarmClass
9 AlarmClassFolder
D Recipients
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8.1
8.1.1

Introduction

Saia PCD® Supervisor - Point View Widget

Introduction

Purpose and Deliverables of the Point View Widget

The Point View Widget is a browser-based interface designed for BEMS (Building
Energy Management System) users in order to perform the most common operations
requested to maintain and run any BEMS system efficiently.

The point view widget is interconnected with the standard Niagara user administration.
This provides a customized solution considering individual user requirements (restric-
tions) when working with point lists. The Niagara user administration allows any kind of
deep-structured definition for users. As an example, 3 typical BEMS user types (pro-
files), each having specific prerequisites and operational needs, are described in the
following:

Operator

» Familiar and comfortable with software based on standard browser technology
* No knowledge of BEMS internals

* Individual user access possible by user privilege management

* Viewing core information of points: value, status, alarms, and logs

» Search for names using wildcards

» Operations applicable to multiple points in one step

* Quick filtering for points in alarm, in overridden state, and with logs

» Saving point lists as favourites

Service Manager

* The service manager can apply all functions of the operator. In addition, the servic
manager can:

- Apply multi-string search with no need to know SQL
- Present and extract data as Excel report
- Easily access historical data and display point logs

- Convert complex schematics into an easy understandable tabular format for
a comprehensive overview of system health status

Partner

* Has super-user (admin) rights and can apply all functions of the operator and ser-
vice manager

* As a superuser having excellent expertise, he is able to design individual user
profiles (e.g. operator, service manager, etc.) which allow these users to take out
the required information from the BEMS effectively based on the usage of the point
view widget

* Needs less pre-engineering and post-customization to support the users

For detailed instructions on how to create user profiles using the Niagara user adminis-
tration, we recommend a training that can be provided by the corresponding Honeywell
TAC department.
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Prerequisites

8.2 Prerequisites

In order to run the Niagara Supervisor and make use of the point view widget, make
sure, that the following prerequisites are fulfilled:

* Niagara 4.7 is installed on the PC
* The Modules folder contains the following Galileo modules:
- galileoPointListWrapper-rt
- galileoPointViewer-rt
- galileoPointViewer-ux
- galileoSignalR-rt
» The Niagara Workbench is started
* The platform is connected
» The station is running and connected

+ The Galileo services “PointListViewService” and “SignalService” are available in
the “Services” folder. If the station is originally created based on a Tridium template,
n please refer to the “Selecting the Right Station Template “, page. 6 section for add-
ing the missing services to the station.

8.2.1 What's new with Niagara 4.7?

Point-List-View

» Standard view is now selectable

* PLV at global system level (no more missing data points)

» Tooltip for description

» Points are updated after station restart

+ History extensions are also displayed via the log icon

» Set/ Override are configurable

* The PLV correctly displays the decimal places defined in the lexicon file

v Actior -
Label ¥ Value * Log Status ¥ Path = DataFormat ¥
© Register

& Flag

aa

(<]

Register
@ Flag
©  Register
& Flag

©  Register

i |

U H oM 20w Updating point details_,
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8.2.2 Selecting the Right Station Template

In order to apply the point view widget, select the brand-specific template when creat-
ing the station, e.g. the Saia PCD Supervisor System template for the Saia Burgess

Controls AG brand. This adds the required services to the Services folder automatically.

If the station is created using a Tridium template, you must manually add the required

services from the “galileoPointViewer” and “galileoSignalR” palettes to the Services
folder as described in the following:

Procedure
1. In the Palette pane, open a new palette by clicking the Open icon.

= Palette

» E B | § wtcontrol
T ContiPalette

D Alarm
© constants
O conversion

RESULT: The Open Palette dialog box displays.

s il
= Open Palette ﬁ
Select one or more palettesto open, or just start typing: Browse...
Y galil
Module Description ]
galileoPointViewer Galileo point list view
galileoSignalR Honeywell Push Server for Niagara
galileoSupervisor IQVISION 2.20[ALPHA-1] - Galileo Common Supervisor - WE
OK | Cancel |

2. Enter ‘galileo’ or the first part of the string in the search field.

RESULT: The galileo items are displayed.

» Palette
B [X] D | @ sslieoPointviewer
history D&

i alarm
galileoPointViewer

i galileoSignalR

[l PointListvie

i galileoSupervisor
i kitControl

3. Select e.g. ‘galileoPointViewer™ at first.
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RESULT: The "PointListViewService' is displayed.
- Palette
w E @ I galileoPointViewer

m PointListViewService

4. Select the "PointListViewService' in the Palette, and then drag&drop it to the Ser-
vices folder in the Nav tree.

L () My Network

‘. Alarm
e Config
L

PoirfLi

@ BackupService
@ CategoryService

O JobService
G RoleService
o UserService

0 AuthenticationService
[-? DebugService

@ BoxService

¥ roxservice

@ Hierarchysenvice
@ HistoryService

O auditHistoryservice
o LogHistoryService
@ ProgramService

0 SearchService

° TagDictionaryService
TemplateService
@ webservice

T PlatformServices
ﬁrivers

D ops

Q File
@ Hieggrchy
@ Hisbry

- Palette

. E @ galileoPointViewer

[l PointListViewService

RESULT: The Name dialog box displays.
Ei MName ﬁﬁ

® FointListViewService

0K | Cancel ‘

-

5. If desired, change the name, and then click the OK button.

RESULT: The "PointListViewService" is added to the Services folder in the Nav tree.
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@ WebService
TIT PlatformServices

il PointListViewService

6. Add the "SignalService™ in the same way to the Services folder (see the following
screenshots).

- Palette
=4 E E iga!ileo&ignalR

¥ signalService
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Starting Niagara Supervisor

8.3 Starting Niagara Supervisor

Procedure

1. Open your browser and enter the IP address, URL, or hostname into the address
field.

2. If your browser does not allow a secure https connection, continue by applying the
unsecure mode provided by the browser.

RESULT. The Login dialog box displays showing the name of the station, in
this case “Demo”, in the title line.

£ Username: admin
s Change User
v

Password: |

n -

Use of this software is subject to the
End User License Agreement and other Third Party Licenses

To connect using Java Web Start click here

3. If not already displayed in the Username field, enter your user name, and in the
Password field, enter your password.

4. Click the Login button.

RESULT: The Station window displays. The Nav tree is shown on the left and the
Config folder is pre-selected.

Nav Config o® th PropertySheet v [X]
] n O Actions & Toples [B Slot Details
| »© connig
File isplay Name alue ommands
-] Display N Val C d:
A Histories
Hierarchy M Station Mame Dema
(W Sysinfo rd
@ services Service Container
O Drivers Driver Container
@ Apps App Container
xercise older
Qe Fold
QO Home Folder
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Starting Niagara Supervisor

8.3.1 Enabling Point View Widget

The points of the station to be displayed via point view widget can be located in any
driver and/or Niagara folder.

Procedure

1. After login (see “Starting Niagara Supervisor” section), expand the Config folder
and browse to the Home folder which typically displays the building graphically.

2. Double-click the Home folder.

RESULT:

On the right pane, the building graphic displays.

HomeDashboard HomeDashboard + [X]

Home EE EE BN

Innovative | Performant | Scalable | Secure

°7¢ o

Fenmierl (7] 4 superwsor ¥£ s

3. Navigate to the plant by clicking the Plant button in the graphic.

RESULT.

On the right pane, the plant graphic displays.

05/08/2019 13:32 | User

[ Fovo» [ TomBuang s e o8]
AHU 2D >
@18.9'(:

TimeRange [~ @ 7to?

1 Source(s) / 2 Alarmis) w

.‘- 05/08/2019 11:49 Adr-Handling-Unit general alarm Offnormal Abr-Handling-Unit has at least one alarm co... 355 OAcked / 2 Unacked AHU 30

"B ACKNOWLEDGE

B nores ® suewce Y s
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Starting Niagara Supervisor

Orin 2D:
wum =
051082019 13:31 | User.  Demo |
& Toal Bldg Aams s oA
Q AHU 2D

® 18.1 °C a\-m

i @
e -

18.0 °C

'y

)
T)
|

e

+1 TV . :
b 3= 1 ==p
o 0.0% & A 1.'-.;‘ C
5 .{E\ 0.0 % .{l.y 0.7 % L)

4. On the upper right corner, click the drop-down listbox and then click on Point View

Widget in the menu.
AHU v | [
AHU

Point View Widget

Property Sheet®
AX Property Sheet
AX Slot Sheet

RESULT. On the right pane, the point list displays. By default, the list is displayed in
the Default View.

Building PointView Widget (]
21 Points | Q) search by Point Label ] |£JH]LI@| ’ Default View - |
Label * Value ¥ Log Status ¥ Path £
©  NumericWritable
SupplyTemp 20.88°C ol ok o, p
] OaTemp 115°C ol o, DaTemp
RecoveryTemp 16.00°C ak 101 01, g
MixedTemp 8.00°C ok /D 01 g
ReturnTemp 19.00°C ok 01/ gl
ty] FLI_AI 21,00 pf _0Vp gl 141
FLI_AIR 30,00 % ok 0P 1A12
OaDamper 100.00 % ok _0Vp JrAnalogOutp
HeatValve £0.00 % ok O 01/ UrAnalogo:
ExhaustDamper 100.00 % ak /D _01/p Uranalago Dy
ReturnDamper 20,00 % ak 01/ UrAnEIogO
CoolValve 000% ak Lo1p JrAnalog Coolvalve
FL1_AO1 3.80 ok 0/ JAnalogOUTPULFLY_ACT
FLI_ADZ 8.00 ok 0P IrANBloEOUtPULFLY_ADZ
HeatSetpoint 23.00°C ok . )
CoolSetpoint 15.00°C ok D 0/ 1 g
& BooleanWritable
| ReturnFan & OFF alarm 0V UrBinaryO
SupplyFan & on ok 01p UrBinaryc
RecWheel @ OFF ok _01/p HUrBinaryos
©  EnumWritable
PlantMode Auto ok 01ip

n«.z»u

For a detailed description of the point view widget screen, please refer to the subse-
quent “Point View Widget Description” section, page 146.

8-8 Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG Saia PCD® Supervisor - Point View Widget

Starting Niagara Supervisor

8.3.2 Engineering Mode

When PointListViewService is activated the detail pane on the right side uses as de-
fault the PointView Widget.

Niagara default views assigned to the hierarchy elements listed in the tree on the left
side are inactive. During engineering activities this is not always an advantage. To
activate the Niagara default views assigned to the hierarchy elements the engineering
mode has to be activated.

Procedure

At the PointListViewService hierarchy element use right click Actions menu and select
Change Mode.

o LogHistoryService

Views

Actions Add Configuration
. . !
New Load Configurations

Change Mode

© Tagoictic
Templat]
© webse
T Edit Tags

E pointis Make Template

E Carelmp

T Platfor Cut
© orivers Copy

Select Engineering Mode

% Change Mode *
Engineering Mode

OK | Canoell

RESULT: Standard Niagara default views assigned to the hierarchy elements listed in
the tree on the left side are active.

Engineering mode can be deactivated using the same menu selecting Live Mode.

% Change Mode X
Live Mode

OK | Canoell

Engineering Mode will automatically be deactivated when user logs off or station is
restarted.
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Point View Widget Description

8.4 Point View Widget Description

This section briefly describes the components and functions of the Point Widget View.
For descriptions of the numbers assignment, please refer to the corresponding table
below and on the next page.

4 ® @
e 21 Points | Q. Search by Point Label ‘Ql'm,]&‘ [ etautt view v |
H 6 Label ® Value * Log Status * Path # @
e ©  NumericWritable
SupplyTemp 20.88°C olly ok 1Driver u,
ol OaTemp @ 115%C 0 ok u
RecoveryTemp 16.00°C ok Dr L g}
MixedTemp B00°C ok Drive X g}
ReturnTemp 19.00 °C ok fDriver X o
e ) ALI_AN 21.00 pf U, 1A
FLI_AIZ 30,00 % ok FDriver: U, 1Mz
Cabamper 100.00% ok J, Danamper
@ HeatValve B0.00 % ok U, g
ExhaustDamper 100.00 % ok FDriversiBacy K
ReturnDamper 2000% ok x
Coolvave 000% ok fDrver U oolvalve
FLI_ADY 380 ok u_ 1401
FL1_AD2 800 ok 1ACZ
HeatSetpoint #300%C ok Dr ! HITEpON
CoolSetpoint 19.00°C ok Drrve X g
@ ©  BooleanWritable
ReturnFan C OFF harm an
SupphyFan - on k U,
Recwheel - oF ok fDriver u,
@ EnumWritable
PlantMode Aute ok u,
H . 2w W [mr]

Fig. 1. Point View Widget Overview

Table 1. Functions of the Point View Widget

No. Name Functional Description

1 Point View Widget Here you select the Point View Widget from the drop-down listbox for
Enable displaying the point list.

2 Plant / Folder Name | Shows the name of the plant/folder selected in the Nav tree or accessed
via plant graphic

3 No. of Points Shows the number of points included in the point list

4 Point List In the area below, the point list is displayed

5 Point Properties Shows the point properties as configured via column toggler (17).
Point properties can be:
* Label
Point name
* Value
Point value
* Logs
Graphic history icon in case point has a history (11)
« Status
Auto, manual, or alarm
* Path
Location of the point
* PointType (disabled by default)
Point type such as NumericWritable, BooleanWritable, etc.

6 Point Group Shows the point category to which the points belong
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8.4.1

Point View Widget Description

7 Alarm Status Indicator | If displayed, the point is in alarm
8 Override Status If displayed, the point in in manual state and its point value is overridden
Indicator

9 Label Name / Proper- Shows the point name. By clicking the blue name, the propertysheet displays for

tysheet editing

10 Point Value Allows the direct change of a writable point’s value

11 History Indicator If displayed in the Logs column, the point has a history (history extension as-
signed). By clicking the blue History icon, the chart displays.

12 Point View Mode Allows selecting the source of the points to be displayed. Points can originate in
the Points folder or its subfolders, or any other folder underneath the driver/net-
work (default view), in a graphic (PX page), or in a favourite

13 Filtering by Status Allows quick display of points which are overridden, or in alarm, or which have
histories.

14 Filtering by Label Allows searching points by name (label) by entering concatenated strings using
wildcards.

15 Actions Menu Provides the following actions:

« Setting points into manual mode

« Setting points into auto mode

« Setting points to fallback value / relinquish default value
» Export points to a CSV file

» Saving points to a favourite

16 Point Selection Here you select the point(s) by clicking the checkboxes

17 Column Toggler Allows configuring the point properties to be displayed columnwise.

18 Group Toggler Allows toggling the point group (showing/hide)

19 Page Browser Allows setting the number of displayed points per page and browsing through the
list pages

20 Column Sorter Allows ascending and descending sorting of the corresponding column

For detailed descriptions on each component and function, please refer to correspond-
ing subsequent sections.

Basic Working Techniques

This section describes general functions of configuration, display and navigation of list.

Setting Columns Display

The Column Toggler (17) allows the configuration of the point properties to be dis-
played per column.

1. On top right corner, click the ColumnToggler icon E=.

2. In the drop-down menu, check the point property you want to display in a column. To

hide a point property, uncheck the property.

-
Select All

[ Value

[ Log

[ Status

v] Path

PointType
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Expanding and Collapsing Point Groups

Points are arranged in point type groups (6) such as NumericWritable, BooleanWritable
etc. If a high number of points are arranged in a group and you want to optimize the list
display for viewing other point type groups on one page, you can use the Group Tog-
gler (18) to collapse a group. As required you can expand the group again by using the
Group Toggler.

Label ¥
@0 NumericWritable @
@ BooleanWritable
ReturnFan

SupplyFan

RecWheel

1. To collapse a point group, click the down arrow @ in front of the group name.

n 2. To expand a collapsed point group, click the horizontal arrow © in front of the group
name.

Setting Point Count Display and Page Browsing

At the bottom of the list, the Page Browser (19) allows setting the number of displayed
points per page and browsing through the list pages.

n 2w M 20

1. For adjusting the number of displayed points per page, click the right-handed Page
drop-downlist 12° " and select the number from 20, 40, or 60.

20 3

40

60

2. For browsing through the list pages, click the forward » » and backward ¥ « but-
tons or click on the page number.

Sorting Point Properties in Column

Point properties can be sorted ascending and descending in their columns by using the
upward/downward arrows (20) right to the column title (property name).

Value ¥ @

20.81°C
257 °C
16,00 °C
8,50 °C

18.00°C
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Point View Widget Description

1. To sort the properties in ascending order, click the upward arrow a .
2. To sort the properties in descending order, click the downward arrow w.

Selecting Point View Mode

Points can be located or included in any of the following places in your station:

* Points folder and subfolders underneath the device and/or network
* Individual folders underneath the device and/or network

* Any Niagara folder

* Graphic (PX) file

» Favourites (must first have been created in the Point View Widget)
Referring to this, the following point view modes are selectable:

* Default View
shows all points of the station

* Graphic Views
shows all points used in the selected graphic

» Favourites
shows all points saved in the favourite

When selecting the point view mode, only the points included in the selected Point
View are listed in the point list.

By default, the Default View mode is preselected after the points are loaded in the Point
View Widget.

Procedure

1. In the control bar, click the “Point View Mode” drop-down listbox (12), and then click
the view.

22 Points _' Default View @ {':7

- Default View

Label © Value ¢ Graphic Views
®  NumericWritable AHU

SupplyTemp 19.55°C Favourites

QaTemp 2.30 % Digital10

RecoveryTemp 8.00 °C

MixedTemp 8.50°C

ReturnTemp 19.00 °C

FL1_AI1 10.00 pf

RESULT. The point list is updated according to the selected view.
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Point View Widget Description

8.4.3 Filtering Points

Points can be filtered by their label (hame) and status. The filtering functions apply in
all point view modes: Default view, Graphic views and Favourites.

Please refer to the subsequent sections for detailed descriptions for the two methods.

8.4.3.1 Filtering Points by Status

By applying predefined filters (13), points of the current point list can be filtered by the
following status:

* Overridden points
* Points with histories (trend points)
+ Points in alarm

n Multiple predefined point filters can be used simultaneously.

When using more than one filter, the filters will be logically linked with AND.
That is, for example, when searching for overridden points and points in
alarm, only those points which fulfil both filter criteria, will be listed. Filters can
also be applied additionally to the search function as described in the “Filter-
ing Points by Label”. In this case, that filtering logic will be considered addi-
tionally.

Applying a Predefined Filter

1. To apply a predefined filter, click the icon, e.g. the Alarm icon &,

RESULT: The filter is enabled and the icon toggles to active state indicated by the
blue color &,

2. To release a predefined filter, toggle the filter by clicking the Alarm icon I again.
Example: Filtering for overridden points

Procedure

1. To filter for overridden points, click the Overridden icon |9 in the control bar.
RESULT: The icon toggles to active state . In the list, only points that are in “over-
ridden” status are displayed. The overridden status of a point is indicated by the
hand symbol - in front of the point label and by the message “overridden” in the
Status column

E Default View T Actions -

Label ¥ Value # Logs Status ¥ Path *
@ NumericWritable

FL1_AIN 10.00 pf

HeatSetpoint 21.00°C

For filtering for points in alarm or with histories, apply the corresponding filter functions
in the same way.
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8.4.3.2

Point Status Indications

The status of a point is indicated graphically (override hand symbol, alarm rectangle) in
front of the point label and descriptive in the Status column. As an exception, for a point
with a history, the graphic indication is displayed in the Logs column by a chart symbol.

Point View Widget Description

Graphic Point Status Indications

- Overridden point

Label ¥

@ NumericWritable
FL1_AIN

- Pointin alarm

Label

Value ¥

10.00 pf

Value ~

& BooleanWritable

I FrostProtect

- Point with history

Label ¥ Value ¥

& MNumericWritable

SupplyTemp 19,12°C

The different colors and status descriptions for alarm points are described in the follow-

ing table (see below):

Logs Status ¥

overrigden

Logs Status ~

unackedAlarm

Logs

ol

Table 2. Alarm Status and its Color Indications

Color Status Text | Cause

Red UnackedAlarm | < The current state of the alarm source is OffNormal and the alarm is not
acknowledged

Alarm * The current state of the alarm source is Fault and the alarm is not

acknowledged

Ere UnackedAlarm | The current state of the alarm source is Normal and the alarm is not

I acknowledged

Orange Alarm The current state of the alarm source is Normal and the alarm is acknowl-
edged

Yellow Alarm » The current state of the alarm source is OffNormal and the alarm is
acknowledged
» The current state of the alarm source is Fault and the alarm is acknowl-
edged

White Ok The current state of the alarm source is Normal and the alarm is acknowl-

edged
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8.4.3.3 Filtering Points by Label

In the current point list, points can be filtered (searched) by point label (14). This can be
done by entering simple or concatenated text strings using wildcards.

8.4.34 Procedure

1. In the Search by Point Label field, enter the string.
RESULT: The point list is updated with the found points instantly as you type the
string.

When using a concatenated text string, the text string parts will be logically
linked with OR. That is, for example, when entering “temp+set”, any points
having either “temp” or “set”, or both in their label will be listed. The search
function can be applied additionally to the status filtering function as de-

n scribed in the “Filtering Points by Status” section. In this case, that filtering
logic will be considered additionally.

Examples: Filtering for points that contain “temp” in its label. In a second step, filtering
for points that contain “set” in its label.

5 Points temp

Label ¥

@ NumericWritable
SupplyTemp
OaTemp
RecoveryTemp
MixedTemp

ReturnTemp

Fig. 2. Searching in point labels using single text string

RESULT. All points containing “temp” in its label are listed.

7 Points tén‘p*i&d

Label ¥

©  NumericWritable
SupplyTemp
OaTemp
RecoveryTemp
MixedTemp
ReturnTemp
HeatSetpoint

CoolSetpoint

Fig. 3. Searching in point label using concatenated text string

RESULT: All points containing “temp” and all points containing “set” in their labels are
listed.
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8.44 Setting Point Values

The value of a point is set by one of the following causes:

* Automatic update
executed by the running application, see “Relinquishing Points” section

* Manual override
Explicitly done by the user, see “Manual Override (Direct Point Editing)” section and
“Manual Override (Enhanced Point Editing)”.

» Fallback value / Relinquish default
Pre-setting defined by the user, see “Setting Point to Fallback / Relinquish Default
Value” section.

8.4.4.1 Manual Override (Direct Point Editing)

You can manually override the value of a single writable point by changing its value di-

rectly in its Value field (Direct Point Editing). The overridden status is indicated descrip-

tive in the Status column (overridden) and graphically by the hand symbol -  in front of

the point label. In the priority array, the changed value is written to the slots "In8" and

‘Out’. n
Direct point editing allows changing the value of a single writable point in one step. For
changing values of multiple writable points simultaneously, please refer to the “Manual

Override (Enhanced Point Editing)’section.

Label = Value * Log Status *

© NumericWritable

CoolSetpoint / 19.00 °C ok
® BooleanWritable @ \
ReturnFan & ON ok
Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as
examples for direct point editing.

1. Overriding Value of NumericWritable Point
For overriding the value of a single NumericWritable point, click the value in the
Value column (for overriding the value of a BooleanWritable point, see step 3).

Label * Value *
© NumericWritable
CoolSetpoint 16,0|
Fig. 4. Example “Manual Override of NumericWritable Point”
2. Enter the value, and then press ENTER key.

Label * Value + Log Status ¥

& NumericWritable

CoolSetpoint 16.00 °C overridden

RESULT: The value is overridden. The overridden status is indicated descrip-
tive in the Status column (overridden) and graphically by the hand symbol - in front
of the point label. At the bottom, the history of point editing is shown in the Updating
point details... window (see step 4).

3. Overriding Value of BooleanWritable Point

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22 8-17



Saia PCD® Supervisor - Point View Widget Saia-Burgess Controls AG

Point View Widget Description

8-18

For overriding the value of a single BooleanWritable point, click the left and right
edge respectively (depending on the current status) of the binary switch icon @ in
the Value column.

Label * Value ¥ Log Status *

© BooleanWritable
ReturnFan @ on ok

Fig. 5. Example “Manual Override of BooleanWritable Point”

RESULT: The value is overridden. The overridden status is indicated descriptive in
the Status column (overridden) and graphically by the hand symbol - in front of the
point label. At the bottom, the history of point editing is shown in the Updating point
details... window (see step 4).

Label * Value * Log Status *

O BooleanWritable

ReturnFan OFF overridden

4. Viewing Point Editing History
The Updating point details... window at the bottom shows the actions performed to
the points and their point labels.

Updating point details... |i
Editing CoolSetpoint v
Editing ReturnFan v

5. To view details of an edited point, click the down arrow . The point path is displayed
and a green arrow indicates that the point value has been successfully changed.

Updating point details... |£
Editing CoolSetpoint ~
CoolSetpoint
/Drivers/Bacneth e:wc-rk.f.ﬂ-‘«l—u_mfpointsf.a‘«HU.f'AnaIog\e’a\uer'c 00...
Editing ReturnFan ~

ReturnFan

/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOutput/Re...

6. To hide the Updating edit point details... window, click the Hide icon [~.

7. To re-display the Updating edit point details... window, click the View icon ~1.

Updating edit point details... '/T
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Manual Override (Enhanced Point Editing)

You can manually override a single writable point or multiple writable points of the
same group with the same value simultaneously by using the Set to Manual action (En-
hanced Point Editing) in the Actions menu. In addition, enhanced point editing allows
applying a certain duration the points should stay in manual override.

The following options are available:

* Permanent

* 1,15, or 3 minutes

* 1,2 o0r 3 hours

* Override expiration: discards current duration

The overridden status is indicated descriptive in the Status column (overridden) and
graphically by the hand symbol -  in front of the point label. In the priority array, the
changed value is written to the slots 'In8" and "Out’.

Multiple writable points can have the same or different facets.
Multiple writable Enum points must have the same Enum range.

Label = Value = Log Status = Path Set To Auto

©  NumericWritable

© BooleanWritable

| ReturnFan

SupplyFan

Procedure

In the following steps, NumericWritable and BooleanWritable points are described as
examples for enhanced point editing.

1. Overriding Value of NumericWritable Points
Select the points you want to override manually by checking the checkbox at the
point label (for overriding the value of BooleanWritable points, see step 5).

3 Label = Value # Log Status *
@ NumericWritable

2 OaDamper 100.00 %

ExhaustDamper 100.00 %

Fig. 6. Example “Manual Override of NumericWritable Points”

2. Click the Actions menu (15) on the top, and then click Set to Manual.

Actions ‘ -
- 5et To Manual

Set To Auto

Export to CSV

Save to Favourites
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RESULT: The Override dialog box displays and shows the number of selected
points.
Override: 2 points

Override Value

Duration

‘ Permanent

Cancel Save

3. Inthe Override Value field, enter the value, and from the Duration drop-down list,
select the duration.

QOverride: 2 points

Override Value

85

Duration
Permanent

Permanent
1 Minute
15 Minutes Cancel m
30 Minutes
1 Hour

2 Hours

3 Hours

T PSR I R

Override: 2 points

Override Value

95

Duration

1 Hour

Cancel

4. Click the Save button.

RESULT: Any selectable points are overridden with the new value as indicated in
the Value column. The overridden status is indicated descriptive in the Status col-
umn (overridden) and graphically by the hand symbol -  in front of the point label.
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Label ¥

@ NumericWritable
OaDamper

ExhaustDamper

Point View Widget Description

Value Logs Status ¥
95.00 % overridden
95.00 % overridden

At the bottom, the history of point editing is shown in the Updating point details...

window.

Updating edit point details...

Editing OaDamper + 1 points

4

~

, OaDamper
/Drivers/BacnetNetwork/AHU_01/points/AHU/AnalogOutput/QaDamper
ExhaustDamper

/Drivers/BacnetNetwork/AHU_01/points/AHU/AnalogOutput/ExhaustDamper

For detailed description of the Updating point details... window, please refer to step
“Viewing Point Editing History”.

5. Overriding Value of BooleanWritable Points
For overriding BooleanWritable points, please apply the previous steps 1 and 2 in
the same way as described for the NumericWritable points above.

Label *

a

BooleanWritable

ReturnFan

A Qo

SupplyFan

Value * Log Status ¥
@ on k
[ ¢ N k

Fig. 7. Example “Manual Override of BooleanWritable Points”

6. In the Override Value field, select the “false” state, and from the Duration drop-down

list, select the duration.

Override: 2 points

false

15 Minutes

7. Click the Save button.

RESULT: The points are overridden with the new value as indicated by the toggled
switch icon in the Value column. The overridden status is indicated descriptive
in the Status column (overridden) and graphically by the hand symbol -  in front of

the point label.
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Label + Value

© BooleanWritable

@ ReturnFan OFF
SupplyFan OFF

At the bottom, the history of point editing is shown
dow.

Updating point details... |i

Editing ReturnFan + 1 points ~

, ReturnFan

/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOutput/R...

SupplyFan
/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOutput/s...

“Viewing Point Editing History”.

Log Status *

overridden

overridden

in the Updating point details... win-

For detailed description of the Updating point details... window, please refer to step

8-22

8.4.43 Inline Command Editing
The Inline Command option allows to edit point values in the Point View Widget.
Click on the point value opens edit field where new value can be entered.
© NumericWritable
Analog_Out_1 20.0 % [Drivers/NiagaraNetwork
Analog_Out_2 12.0 /Drivers/NiagaraNetwork/
Analog_Out_3 20.0 % ok @def [Drivers/MiagaraNetwork/
Analog_Out_4 20.0% ok,@def /Drivers/NiagaraNewwork/
By pressing the enter key value will be set and point state changes to overridden.
© NumericWritable
Analog Out_1 200 % /Dr
Analog Out_2 120% Dr
Analog_Out_3 200% /Driv
Analog Out_4 20.0 % Drivers/Niagara
8.44.4 Inline Command Configuration
8.4.4.41 Disable Default Override state by Network point type configuration

Point state changes by default to override after point value editing. Automatically de-
fault setting can be disabled via configuration of Point Types.

Procedure
1. At the PointListViewService hierarchy element use right click Actions menu and
select Add Configuration.
© Tagictigoancanic
.-
© webser Actions »

¥ signal

E rointti

Add Configuration
Load Configurations

Change Mode
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In case if new Drivers or Point Type definitions were added to the configu-
ratons.xml file before starting the configuration press Load Configurations
at the PointListViewService right click Actions menu.

2. Configuration of Point Types
- Enter a configuration name,
- Select the Network Type

- Select Point Types where the default override state should be disabled
(multi selection via ‘ctrl’ key)

- Press “Save”.

§ Add Configurstion X

The in-line edit action for the point viewer defaults to override,
Use this dialog to change this to "set” for specific driver/point types.

Configuration Name  €BUS_network_NisgarePoints

Network Type CBusetwork

Paint Types

Digitsl Remote

Save ‘ Load Configurations | Clase |

RESULT: For the selected Point Types the default override state after editing the point
value will not be set. The point state will stay unchanged. l.e. This is the same opera-
tion as in Action Set menu of single point

Analog_Out 2

Analog_Out]
Analog_Out,

© ginary_out I

0 Binary_Out

O einary_out_JEIERS

0 Binary_Out
BacnetiwsNetwork
* Local Device Cut

E Bacnet Comm Lopy

Make Template

Auto

Points can be configured only grouped per point types not per single point.
Only one configuration per network is possible. i.e. all applying point types
within the same network have to be in one configuration.
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8.445 Edit existing Configurations

Added Configurations are displayed under the PointListViewService.

@ TemplateService

@ WebService

¥ signalservice

E pointListviewservice
[ BACnet_A0_BO_Default_To_Set
. CBUS_network_NiagaraPoints

CarelmportWizard Service

T PlatformServices

fj Drivers

For changes double click on the entry and use dialog on the right pane

Property Sheet

W BACnet_AO_BO_Default_To_Sat (Point List View Configuration
[« ryService
© LogHistoryService
© TagDictionaryservice
) Templateservice
@ webservies

M Configuration

¥ signalservice Point Types
B rointListviewservice
[ BACnet 40 BO Default To_Set

In case if new Drivers or Point Type definitions were added to the configu-
ratons.xml file before starting the configuration press Load Configurations
at the PointListViewService right click Actions menu.

8.4.4.6 Relinquishing Points
When setting the point value of a point that is in manual override to Auto, the point
value will be relinquished. In the priority array, the slots 'In 8 and "Out’ will be cleared.
You can relinquish a single writable point or multiple writable points of the same group
simultaneously.

Relinquishing multiple points belonging to different groups (e.g. Numer-
icWritable and BooleanWritable) simultaneously is not possible.

Label ¥ Value * Log Status =

NumericWritable

OaD

mper

aQeoe

ExhaustDamper

ReturnDamper

a

BooleanWritable

| ReturnFan

SupplyFan

Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as
examples for relinquishing points.

1. Relinquishing NumericWritable Points
Select the points, you want to relinquish by checking the checkbox at the point label
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(for relinquishing the value of BooleanWritable points, see step 4).

Label Value # Logs Status ¥
© NumericWritable
OaDamper 95.00 % overridden

ExhaustDamper 95.00 % overridden

2. Click the Actions menu on the top, and then click Set to Auto.

Actions v

Set To Manual

Set To Auto {t’)
Set

Export to C5V

Save to Favourites

RESULT: The Relinquish dialog box displays and shows the number of selected
points.

Relinquish: 2 points

® Auto

Cancel Apply

3. Click the Apply button.

RESULT: The points are relinquished to Auto as indicated in the Value column. The
auto status is indicated descriptive in the Status column (ok). At the front of the
point label, the overridden hand symbol - is removed.

Label Value ¥ Logs Status ¥

© NumericWritable
OaDamper 100.00 % ok

ExhaustDamper 100.00 % ok

. Relinquishing BooleanWritable Points
For BooleanWritable points, apply the previous steps 1 through 3 in the same way
as described for the NumericWritable points above.

Label * Value * Log Status ¥
© BooleanWritable

@ ReturnFan OFF overridden
SupplyFan OFF overridden

RESULT: The points are relinquished to Auto as indicated by the toggled switch icon
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@& in the Value column. The auto status is indicated descriptive in the Status col-
umn (ok). At the front of the point label, the overridden hand symbol - is removed.

Label = Value Log Status ¥
@ BooleanWritable

® ReturnFan @& on ok
SupplyFan [ ¢ ON ok

8.4.4.7 Setting Point to Fallback / Relinquish Default Value

By using the Set action of the Actions menu (15), you can write a value to the Fallback
value (Niagara points) or Relinquish Default (BACnet points) in the priority array. This
function can be applied to a single writable point or multiple writable points of the same
group simultaneously. Multiple writable points of the same group can have different
initial values (true or false).

Points which are already in the desired state, remain in this state, the others are up-
dated accordingly.

n Applying the Set action simultaneously to multiple writable points of differ-
ent groups (e.g. NumericWritable and BooleanWritable) is not possible.

~ D oo v
Set To Manual
Label = Value = Log Status = Patt Set To Auto

© NumericWritable Set

Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as
examples for the Set action application.

1. Setting NumericWritable Points to Fallback / Relinquish Default Value
Select the points, of which you want to set the fallback value and relinquish default
respectively (for setting the value of BooleanWritable points, see step 5).

Label * Value * Log Status *
© NumericWritable
MixedTemp 12,00 °C ok

3 ReturnTemp 19.00 °C ok

2. Click the Actions menu (15) on the top, and then click Set.

Actions v
Set To Manual

Set To Auto

Set {b
Export to CSV

Save to Favourites
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RESULT: The Set dialog box displays and shows the number of selected points.

Set: 2 points

Cancel
3. Enter the value.
Set: 2 points
14
Cancel Apply

4. Click the Apply button.

RESULT: The value is set as indicated in the Value column.

Label = Value * Log Status =
Q@ NumericWritable
MixedTemp 14.00°C ok
@ ReturnTemp 14,00 °C ok

At the bottom, the history of point editing is shown in the Updating point details...
window.

Updating point details... |£
Editing MixedTemp + 1 points ~
, MixedTemp

“ /Drivers/BacnetMetwork/AHU_01/points/AH U/Analoginput/Mixe....

ReturnTemp
' 4

2z /Drivers/BacnetNetwork/AHU_01/points/AHU/Analoginput/Retu...

For detailed description of the Updating point details... window, please refer to step
“Viewing Point Editing History” above.

. Setting BooleanWritable Writable Points to Fallback / Relinquish Default Value
Please apply the previous steps 1 and 2 in the same way as described for the Nu-
mericWritable points.

Label = Value * Log Status *

© BooleanWritable

ReturnFan ON ok

SupplyFan ON ok
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RESULT: The Set dialog box displays and shows the number of selected points.

Set: 2 points

Cancel m
6. Select the other value.

Set: 2 points

false

7. Click the Apply button.

RESULT: The value is set as indicated in the Value column.

Label = Value =

© BooleanWritable
I ™ ReturnFan

B SupplyFan

OFF

OFF

Log Status ~

alarm,unackedAlarm

ok

At the bottom, the Updating edit point details... window displays and shows the actions

performed to the points and their point labels.

At the bottom, the history of point editing is shown in the Updating point details... win-

dow.

Updating point details...

Editing ReturnFan + 1 points ~

_ ReturnFan

W
/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOutput/R...

SupplyFan
* /Drivers/BacnetNetwork/AHU_01/points/AH U/BinaryQutputs...

For detailed description of the Updating point details... window, please refer to step

“Viewing Point Editing History”.
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8.45 Saving Points to Favourites

Points of particular interest which should be viewed more often, can be saved into a
favourite for quick display (fast access list).

The points to be saved to a favourite can be assorted from any accessible source (see
“Selecting Point View Mode* section) and by using any available point filtering method
(see “Filtering Points* section).

Procedure

1. Select the points (16), you want to save to a favourite, then click the Actions menu
(15), and then click Save to Favourites.

Label % Value # Logs Status ¥

RESULT: The Save to Favourites dialog box displays.

Save to Favourites

Saved favourite will only be available for current node.

2. In the Name field, enter the name.

For the name, any alphanumeric characters and the following characters
are allowed: -, _. The following characters are not allowed: @ ,!, #, %,

$ ..

3. Click the Save button.

RESULT: The favourite is saved under Favourites in the View Point Mode menu. To
view a favourite, please refer to the “Viewing Favourites” section.
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8.4.5.1 Viewing Favourites

Procedure

1. To view a favourite points list, click the Point View Mode menu, and then click the
favourite under Favourites.

Default View

Default View

Graphic Views
AHU

Favourites

Supply Line

RESULT: The favourite point list is displayed.

Label ® Value * logs  Status Path *

@ NumericWritable

OaTemp 193°C ollo ok
SupplyTernp 20,06 *C 1L1%] ok
OaDamper B0.00 %

RecoveryTemp 16.00 °C ak
MixedTemp 8.50°C ok
HeatValve 80.00 %

CoolValve 0.00 % ok

8.45.2 Renaming Favourites

Procedure

1. To rename a favourite points list, click the Point View Mode menu, and then click
the Rename icon # right to the favourite.

Supply Line
Default View

Graphic Views

AHU

Favourites

Supply Line |
O
RESULT: The Rename Favourite dialog box displays.

Rename Favourite
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2. In the Name field, change the name, and then click the Save button.

Rename Favourite

RESULT: The favourite is saved with the new name and available in the Point View
Mode menu.

8.4.5.3 Deleting Favourites

Procedure

1. To delete a favourite points list, click the Point View Mode menu, and then click the
Delete icon 11 right to the favourite.

Default View -

Default View

Graphic Views
AHU

Favourites

Supply Line

0

RESULT: The Delete Favourite dialog box displays.

Delete Favourite

2. Click the Delete button.

RESULT: The favourite is deleted in the Favourites menu.
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8.4.6

8.4.7

Exporting Points to CSV
A point list can be exported to an Excel CSV file.

Procedure

1. To export a points list to a CSV file, click the Actions menu (15), and then click Ex-
port to CSV.

Actions E

Set To Manual

Set To Auto
Export to C5V {b

Save to Favourites

RESULT: The complete point list is exported to the CSV file.

ﬂ Particular individual points cannot be exported to a CSV file.

Viewing Point Histories

If a single point has a history assigned by the Niagara history extension, its history can
be shown graphically.

Procedure
1. To view the history of a point, click the History icon ol in the Logs column (11).

Logs

0o
RESULT: The chart of the point is displayed in standard Niagara format.

Chart

SupplyTemp
® [ Today @ Q ADO® e
AHU_01 SupplyTemp (@) AHU_01 SupplyTemp
21.0
20.8
20.6
20.4
20.2
200 ,
19.8
19.6
19.4
19.2
19.0
1210 12:11 12:12 12:13 12:14 12:15 1216 12:17 12:18 12:19 12:20 12:21 12:22 12:23
29-Jan-18 pm

2. For detailed information on working with charts in Niagara, please refer to the Nia-
gara online documentation.
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Editing Point Properties

The detailed point properties of each individual point can be shown on the property
sheet. The point properties are shown in the corresponding default view of the prop-
erty sheet. The default views of property sheets are different depending on the origin
(controller, driver) of the points. That is, the property sheet of a generic Niagara point
is shown in another default view as a point based on a specific driver. In the following
procedure, a Niagara point is used as an example.

Procedure
1. To display the properties of a point, click the name of the point in the Label column.

Label =

© NumericWritable

Sup%Temp

RESULT: The property sheet of the point is displayed in its default view.

Property Sheet o
o ® t
SupplyTemp O Actions & Topics [H Slot Details
Display Name Value Commands
(W Facets units="C,precision=1 °C,min=-inf °C,max=+inf °C rd
[3 ProxyExt null
Out 19.9 °C {ok} @ 10
Inl - {null}
In2 0.0 "C® null - {null}
In3 0.0 C®null -{null}
In4 0.0 'C®null - {null}
In5 0.0 C® null - {null}
In6 0.0 C#¥null - {null}
In7 0.0 C#®null -{null} =

Fig. 12. Example “Default View of Niagara Point Property Sheet”

2. For detailed information on working with the various property sheets, please refer
to the corresponding Niagara documentation and the proprietary driver and controller
documentation.
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8.4.9 Delete Points View

* The Delete Point View shows an overview of all data points that are not used in the

project

- Not on a PX page

- No alarm/trend extension
- Not on the wire sheet

- From another application

* Applicable for any communication driver

* Under Files an xml file is stored, which shows all unused data points including a

mark if it has already been deleted

Remove Unused Points

517 unused points

MAME PATH

CLKON_ slot/Drivers/BacnetOws Network/DS_SupN&_AHU/points/AHUL/CLKS 3a0MN,

COO-CP_ALM-FLC slot/Drivers/BacnetOws Network/DS_SupN4_AHU/points/AHU1/CO0$3aCP_S3aALMS3aFLC

COO-CPoALM-MAN skot/Drivers/BacnetOws Network/DS_SupN4_AHU/paints/AHUL/CO0$3aCP S 3aALMS 3aMAN
COO-CPoALM-MOT slot/Drivers/BacnetOws Network/D5S_SupN4_AHU/points/AHUL/CO0$3aCP_S3aALMS 3aMOT
COO:CPoALM-MSW slot/Drivers/BacnetOwsNetwork/DS_SupN4_AHU/points/AHUL/CO0%$3aCP_S3aALMS 3aMSW

COO:CP_CNTHRS slot/Drivers/BacnetOws Network/DS_SupN&_AHU/points/AHUL/CO0%$3aCP_$3aCNT$3aHRS

COO:CPLMNT slot/ Drivers/BacnetOws Network/DS_SupNa_AHU/points/AHULCO0S3aCP_S3aMNT
COORID slot/ Drivers/BacnetOws Network/DS_SupNéa_AHU/points/AHUL/CO0S3aPID
COOPIDY_ slot/Drivers/BacnetOws Network/DS_SupN4_AHU/points/AHUL/CO0S3aPIDS 3aY_

COON_ALMFEO slot/Drivers/BacnetOws Network/DS_SupN4_AHU/peints/AHUL/CO0S 3a¥_$3aAL MS3aFBO

COON_ALMMAN skot/Drivers/BacnetOws Network/DS_SupNa_AHU/points/AHUL/CO0$ 3a¥_$3aAL M$3aMAN

{1 pointsami

m points.aml

ivers/BacnetOwshietwork,/DS_Suph
="glot:/Drivers/BacnetOn twork/DS_Suphd_AHU/ p
:/Drivers/BacnetOwsNetwork,/DS_Suphd_AHU/ pi
:/Drivers/BacnetOusMetwork/DS_Suphd_AHU/poi

/DS _Suph
sNetwork/D5_S

AHU/points FAHUL/CLKE3a0N_* handle="h
ints/AHUL/CO0S3aCP_S3adLME3aFL
1/C0083aCP_S3aALME3aMAN" T
s/ARUL/CO053aCP_S3aAL
HU1/C00538CP_S3aAL) ¥
/ 1/C0053aCP_$3aCNTS3aHRS
s/AHUL/CO083aCP_$3aMNT" handles"
AHUL1/CO053aPID" handle="h:175b65" di

3aMOT™
3aMSh

e i
" delete="1"

8-34 Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22



Saia-Burgess Controls AG

Saia PCD® Supervisor - Point View Widget

8.5
8.5.1

Point View Widget Description

Advanced Documentation/Information Section

Inline Command Configuration adding new Drivers and Point Types

In case if further drivers or data point types are needed for Inline Command Configura-
tion, definitions of further Point Types can be added via editing the configurations file.

Procedure
Under Station — Files — config double click on configurations.xml.

See right pane to edit the configuration text.

FRrpoe

global.ds.honeywelleom (HXSupervisor

EREERcmumwm

BREECELSERRER

e

To apply the changes the file has to be saved and explicit be loaded to the station.

To load the configuration file, go to the PointListViewService hierarchy element use
right click Actions menu and select Load Configuration.

79 {Poi
SearchService
© . g0
© Tagbictiongysen 81

A 82

TemplateS Views .

© webservic Actions

¥ signalse . Load Configurations
L g

E peintui Change Mode

Access Point
"Access Rights”
ype Name="Access User™ Con
ype Name="Access Zone™ Conditi
Credential Data Inpu
letwork Security” Cc
Bitstring Value® Con
Character String Val

Add Configuration

Make Template

T Platforms ik

ex"Date Pattern Value"
"Date Value™ Conditic
="Date Time Pattern Ve
="Date Time Value™ Cor

Mama—"Tatamar Walua® Candi
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Icons | Related documents | Software-Versions

A Annex

A1 Ilcons

In manuals, this symbol refers the reader to further information in this man-
ual or other manuals or technical information documents. As a rule there is
no direct link to such documents.

This sign accompanies instructions that must always be followed.

A.2 Related documents

Document number | Document type | Document name

26-062 ENGxx Leaflet Release Notes

26-658 GERxx Quick Start FindSymbolsAndMacros

27-668 ENGxx User Guide Point List Widget

27-669 ENGxx Manual Easy Templating for Saia PCD® Supervisor

31-061 ENGxx Flyer Saia PCD® Supervisor

31-703 ENGxx Brochure Saia PCD® Supervisor

34-001 ENGxx Data Sheet Saia PCD® Supervisor

31-702 ENGxx Brochure Saia PCD® Supervisor EM

34-002 ENGxx Data Sheet Saia PCD® Supervisor EM

41-0001 User Guide Easy Templating - Installation and Operations Guide

41-0002 User Guide Easy Binding - Installation and Operations Guide

41-0003 User Guide Easy Database Manager - Installation and Operations Guide

41-0004 User Guide Point List View - Installation and Operations Guide

41-0005 User Guide Easy Alarm Management - Installation and Operations Guide
A3 Software-Versions

Book-Version Saia PCD® Supervisor Niagara

27-651 ENGO1 Version V1.1 Based on Niagara V4.3

27-651 ENG02 Version V1.2 Based on Niagara V4.7

27-651 ENGO03 Version V2.0 Based on Niagara V4.7U1

27-651 ENG04 Version V2.0 Based on Niagara V4.7U1

27-651 ENGO05 Version V2.0 Based on Niagara V4.7U1

27-651 ENG06 Version V2.1 Based on Niagara V4.8 n

27-651 ENGO7 Version V2.1 Patch release Based on Niagara V4.9

27-651 ENGO08 Version V3.0 Based on Niagara V4.9

Manual Saia PCD® Supervisor V3.0 | Document 27-651 ENGO08 | 2021-02-22 A-1



Annex A

What's new?

Saia-Burgess Controls AG

A4 What is new in V1.2

Name Description See section
Enhanced PG5 Import Wizard Including filtering based on tags from PG5 6.3.8
Point-List-View For straightforward display and management of see document
filtered data points 27-668
Delete Points View Enables simple deletion of all unused data see document
points 27-668
Bulk deploy Mass provisioning of data points in Excel 7.6
(export/import)
Cloud Connector Action management, performance analytics 7.5
Cyber Security In-depth cyber security measures see document
(especially for connecting to the cloud) 26-624
Energy Monitoring Add-on (including 1-hour demo runtime)
Alarm Consolen Improvments Trend charts and role manager are fully inte-
grated in HTML5
HTMLS extensions Including new Px elements 7.4
Px Editor tools For example for ensuring a responsive design
Improved BACnet Alarming
SMA Reminder Software maintenance reminder
New reporting functions 7.4.1
Multilanguage EN/GE/FR at Niagara level
Profinet driver 3rd-party module — licence can be acquired
from Tridium
What is new in V2.0
Name Description See section
Point List View Allows to build a basic Supervisor in few minutes See manual:
27-668 ENGxx
Easy Templating To automate recurrent tasks and maximise reuse Ch. 6.6.5
for Simple Objects SBC Application templates for HVAC to match PG5
symbols (DDC Suite)
Easy Binding Allows the creation basic schematics with lower engi- Ch.6.6.5.2
neering effort
YvkonPro modules The vykonPro modules are an comprehensive collec- Ch7.7
tion of components and px widgets
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Annex A

What's new?

A.6 What is new in V2.1
Name Description See section
Latest Niagara release Niagara 4.8
Easy templating Tool for complex objects See new manual 27-669_ENGxx
Template Library Single Objects
Mapping table for S-Bus import
Aliasing table for BACNet import
3rd Party Module Signing Requiring all third party modules
to be signed increases security
posture of a Niagara installation
Analytics 7 existing standard reports for
meaningful output
E-Signature Supports site procedures typically
when controlling the manufactur-
ing of food or pharmaceuticals
JSON Toolkit Enables the connection to loT
Software and 3rd Party applica-
tions, cloud services and data-
bases
Milestone Camera Driver Milestone Systems is a leading
provider of open platform video
management software
Point Database Manager Saves overall license costs
(PDM)
Easy Binding Own graphics (design agency) can
be quickly integrated
Predefined application and | Decreases the engineering time
project templates
Multilanguage EN/GE/FR At Niagara level.
Guest access / Kiosk mode Available from Core Niagara but is
IEEE 802.1x Registration in computer networks | Not usable by SBC
- (Usable for Niagara based control-
Security Dashboard lers).
A.7 What is new in V3.0

Name

Description

See section

Next Niagara release

Niagara 4.9

Easy Templating tool

Tool for complex objects

See new manual 41-00001

Easy Binding tool

Own graphics (design agency) can be

quickly integrated

See new manual 41-00002

Easy Database Manager

Remove unused data points to reduce
license costs. Saves overall license cost.
Enables optimal station performance for
critical infrastructure projects (data centre)

See new manual 41-00003

Point List View

Tool for complex objects

See new manual 41-00004

Easy Alarm Management

Tool for complex objects

See new manual 41-00005

User login preferences

Option to define & save customized login

parameters as per user reference

See section 7.8

Enhanced BACnet support

Added BACnet driver with server and client

support.
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List of known issues with the version V3.0

A-4

every headstation

tion help to enhance the communication
speed and performance.

Name Description See section
Assignhed memory to the Memory space assigned to the Workbench | 6.1.5
Workbench and station. and station can be increased to enhance

the performance
Improved read timeout Introduced new Headstation & Substation | 7.9

Ping Read Timeout property slots with

increased read timeout
New UDP config slot for Use of UDP config slot in every headsta- 7.10

DDC-Suite 2.7 Templates

Comprehensive application library suitable
for DDC-Suite 2.7 (S-Bus and BACnet)

Cyber Security Dashboard

Systemwide view of your current security
layer

Built in recommendation for action to be
taken to improve security for supervisor

Station Template

Predefined HTML5 web browser view
Station Template for Supervisor to provide
clear arranged menu.

Video & Camera Integration

Open video framework solution designed to
integrate diverse manufacturer devices and
protocols into a unified video management

Energy Monitoring

Easy understanding to handle the tool /
Customer friendly Energy monitoring chart
or views
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A.8

List of known issues with the version V3.0

List of known issues with the Version V3.0

Key Description of the issue Planned correction
Saia PCD® Supervisor

GALEO-37152 SBC: BACnet : Relinquish default for BO & BV objects 4.10
are shown with four options “ ON,OFF,On,Off “

GALEO-37149 SBC : BACnet : When user enters some value to the 4.10
writable BACnet object , for brief amount of time previous
present value is shown

GALEO-37039 SBC: Alarms : In one of the machine (with Production 4.10
License) Substation point Alarms are not coming up in
supervisor

GALEO-36390 SBC : Max and Min option done for Third column of the 4.10
import wizard that is “Selected Point “ , making the sec-
ond column not to work properly

GALEO-36389 SBC : While Doing Data point import using import wizard, 410
some times station hangs or Data point loading takes
times in second column

GALEO-19881 SBC offline Engineering Wizard popup Implementation 4.10
for head station - Did not work couple of times.

GALEO-19857 SBC: “Device Name Conflict” pop up page will appear 4.10
even the substation folder is empty

GALEO-19421 SBC: Normal Alarm are getting generated for Controller 410
at regular interval on Alarm Console

GALEO-19386 SBC: In History Folder click on any of the history logs and 4.10
click on Web collection tab - “Error is thrown”

GALEO-18925 SBC: Inconsistency found in “ Last Fail Cause” message 4.10
, Program CRC shown in AX Property Sheet and Status
value in AX property Sheet .

GALEO-18924 SBC: Second Time import of Substation ,Substation 410
names are not being shown correctly after cut/paste
within the SBC driver

GALEO-18922 SBC: Headstation and Substation Display names are not 4.10
being shown correctly after import of PG5 file

GALEO-18501 SBC:Priority number changes update is required manual 4.10
intervention between notification class and Niagara Alarm
class

GALEO-18500 SBC-Alarm count functionality is not working in Niagara 4.10
alarm class and corresponding alarm class count is up-
dating in default alarm class

GALEO-18420 SBC:Bacnet: Recipient List is not added while discover- 4.10
ing the notification class from the Device .

GALEO-14925 SBC - Threshold notification alarm of trend log object is 4.10
not reporting as alert alarm instead of is reporting normal/
unack alarm in supervisor

GALEO-14465 SBC 2.0-BACnet: The Al, Bl & MSI point write operation ( 410
Out of service) is not working through set operation mode

GALEO-12703 SBC:Error "null::Property:Write Access Denied" is thrown 4.10
when user modifies the existing schedule

GALEO-12702 SBC:Bacnet:Schedule Deletion from database will not 4.10
delete entry from Schedule Tree .

GALEO-12173 SBC - User specified name is not applying for special 4.10
events (schedule)

GALEO-12157 SBC - AV, BV & MSV objects has captured random value 410

in priority- 16
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List of known issues with the version V3.0

Key

Description of the issue

Planned correction
Saia PCD® Supervisor

GALEO-12155 SBC - Non commendable objects are allowing to perform 410
all the override function (Override & Emergency override)
via action call

GALEO-12146 SBC - Override status and manual flag set is not working 410
while doing override operation in commandable objects

GALEO-12137 SBC: Point View Widget is not there as a default view in 4.10
the browser at ""SBCIpNetwork" level ,SBC deveice level
and POINTS level

GALEO-11943 SBC:- Calendar and Schedule feature are not working in 4.10
4.7.109.20 .

GALEO-8650 SBC supervisor N4.4_U1 not able to write any values for 410
animated images in any browser

GALEO-7648 Bacnet Objects like Binary ,Analog,Multistate schedules 4.10
are not working in SBC supervisor

GALEO-5300 Alarm Functions are not working in latest PG5_2.3 ver- 4.10
sion

GALEO-4546 SBC Supervisor PSIRT Patch - Selected Datapoints are 4.10
not importing while performing the import from Chrome

GALEO-3507 SBC Station template does not have the heap max of 1 410
GB by default

GALEO-3488 SBC Import Wizard - Alarm Lists were failed to import but 4.10
detailed report displays wrong informations

GALEO-3093 SBC Import Wizard - Print button is not enabled in All 4.10
Detailed Report Page

GALEO-2886 SBC Bacnet Alarms - Alarm time stamp is displayed 410
wrong when PCD and PC are in different time zone

GALEO-2710 SBC Import Wizard - Dynamic refreshing is not working 4.10
as expected in Datapoints screen

GALEO-39950 SBC:EDM : Select Items to Delete Page in EDM (40f 6 4.10
page ) is taking 10 to 15 Seconds to load .

GALEO-39946 EB: Point chooser is not listing Niagara network 4.10

GALEO-39942 ET: Display name relativization is not working at node 410
level

GALEO-39935 ET: Unable to create template for history pop up with kit 4.10
px pop up

GALEO-39571 PointListViewService - Add Configuration Load - Configu- 410
ration Button Issue

GALEO-39560 E-Signature - Protected alarm database maintenance 4.10
view does not display the old alarms

GALEO-39558 SBC : Image are not loading properly with easy binding 410
view

GALEO-39541 PLV - When click Load Configuration button in Add 410
configuration dialog box, the list is keep on repeating the
same

GALEO-39342 EDM - licensed points and remaining points counts 4.10
should be /can be limited to actual real license counts

GALEO-39289 EB - EB widgets are randomly disappearing when user 4.10
refresh the px page

GALEO-39288 ET: Resolve binding button gets enabled even though we 410

have last search remember criteria not found match
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List of known issues with the version V3.0

Key

Description of the issue

Planned correction
Saia PCD® Supervisor

GALEO-39286 ET: when we create template with px page comprise of 410
multiple popup getting an error

GALEO-39285 ET:Galileo pop are not removed when we create easy 410
template with no pop option.

GALEO-39281 EB- EB widgets stretched and used in px view does not 4.10
display the modified size in eb view. Always shows the
original size

GALEO-39189 EB - Remember last choice is not consistence 4.10

GALEO-39089 EB - EB widgets stretched and used in px page are 4.10
overlapped one image on another in EB view , difficult in
viewing

GALEO-39020 Incorrect unlicensed error 4.10

GALEO-38922 NCCB-48392 Disabling auto logoff for a user does not 410
work.

GALEO-38613 PROSVC-9084 E Signature in Spanish 4.10

GALEO-38480 E-Signature does not support Hon BACnet Utilities data 410
points

GALEO-38311 NCCB-50438 Cannot set null value on composite slot of 410
template

GALEO-37542 ET: Creation of template for existing library with multiple 410
folder at specific level not possible

GALEO-37541 EB: Preview state fails to load the image for widget not 410
enclosed in on folder

GALEO-37540 EB: BMP image fails to load as we create module out of it 410

GALEO-37496 EDM - Global Capacity available also should display the 4.10
count when points are exceeded than the license.

GALEO-37480 EDM - When user place a cursor on top of searched 4.10
points, the tooltip is displayed on East Database Manager
Text at the Top of the screen

GALEO-37479 EDM Licensed Points text should be updated appropri- 4.10
ately

GALEO-37469 NCCB-50228 - Web chart history extra lines drawn when 4.10
time is changed on a Jace

GALEO-37447 SBC:EDM : Add Network more than 17 under the driver 4.10
and try to open EDM view , Blank screen will be shown in
WB as shown

GALEO-37433 HonAlarmConsole is not translated similar to other alarm 4.10
console

GALEO-37389 EB - Easy Binding widgets in a px page is failed to dis- 4.10
play under virtuals

GALEO-37280 SBC : ActionManagement:Model Sync Service failed to 410
get added up in the services during easy onboard .

GALEO-37187 EDM - Current license status showing wrong as unlimited 4.10
for global capacity lic model and cumulative lic count also
wrong while entering target lic count for multiple network
which are using global capacity lic

GALEO-37178 EB - Restart workstation in the last step of easy palette 410
creation may be a confusing term for user, can be cor-
rected as Workbench and Station

GALEO-37133 ET - When user clicks Document link from New Easy 4.10

Template step 1 takes to About ET help doc, but from that
page user unable to navigate to any other link
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List of known issues with the version V3.0

Key

Description of the issue

Planned correction
Saia PCD® Supervisor

GALEO-37097

EDM: Delete Symbols Step 4 shows amount of selected
items from previous scan

4.10

GALEO-37093

EDM: Station gets killed by scanning big amount of data
points

4.10

GALEO-37042

SBC : EDM : Calculation shown on remaining and
licensed points should not there.

4.10

GALEO-36982

SBC :PLV : Default view at different levels of NAV is not
as expected .

4.10

GALEO-36970

Printout: NX4.9 color of module label for panel bus can-
not be changed

4.10

GALEO-36956

SBC: PLV : Browser : "Easy Data Base Manager Ser-
vice Unavailable " message is shown in the browser and
view drop list also has entry of "Easy Database Manger
Widget "

4.10

GALEO-36801

honBACnetUtilities: honBACnetExportManagerView
doesn't present reliable 3rd Party Devices

4.10

GALEO-36421

Unable to perform write operation from web client for the
Secured point linked with EB widget

4.10

GALEO-36301

NCCB-13399 AX property sheet in px page has refresh
issue

4.10

GALEO-36099

EB: Numeric supported image becomes oversized in
easy binding view and overlaps with other image.

4.10

GALEO-36096

EB: Point chooser view for selecting point for binding is
not proper

4.10

GALEO-35033

NCCB-44173 Ux Alarm Console gives erroneous access
to Force Clear command

4.10

GALEO-34733

IQVISION - Duplicate PX page is created when creating
PX page using template

4.10

GALEO-33926

Easy binding; Image gets disappeared when linking MSV
with fault value to animated and static image

4.10

GALEO-33781

17864185 - BACnet Subscribe COV and "cancellation
request" doesn’t always work

4.10

GALEO-33667

NCCB-47727, NCCB-38160 In IQVISION2.4 AX alarm
console the 'show recurring' button does not function
correctly and in the UX view historic alarms do not appear
unless logged in as a super user

4.10

GALEO-33434

IQVISION - When loading alarms from 500+ sources

in HonAlarmConsole/AlarmConsole, warning message
displayed to user for displaying only first 500 source.
However the console is still displaying as the alarms are
from 500+ sources

4.10

GALEO-33431

IQVISION - http error 500 while accessing honalarmcon-
sole/alarm console appears randomly in workbench

4.10

GALEO-33394

IQVISION - HonAlarmConsole view does not ask user
credentials when it is switched from protected alarm
console view

4.10

GALEO-26050

IQVISION - Observations found during the testing of
GALEO-19861 Alarms not appearing in Browser Alarm
Console (NCCB-46699)

4.10

GALEO-26049

IQVISION - Observations found during the testing of
GALEO-22926 NCCB-41222: Workbench Alarm Portal
may close unexpectedly

4.10
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Key

Description of the issue

Planned correction
Saia PCD® Supervisor

GALEO-24613

NCCB-21715::18331495 easy Templating, Import, Point-
definition, History, name, length [ref:_00D00hZKZ._5002
E1cDtC1:ref]

4.10

GALEO-23761

Tridium alarm console defect and improvement

4.10

GALEO-23289

EDE Import stops import at first point which does not
have a delimiter and ignores every following points

4.10

GALEO-22708

E-Signature - Unable to perform run maintenance for
clearing the alarm record in protected alarm database
maintenance view

4.10

GALEO-22707

E-Signature - Protected alarm console view (i.e. HTML
view) is not loading in workbench and web client

4.10

GALEO-22411

IQVISION - Points are not displayed in "Point View
Widget" which are dragged to Easy Binding without map-
ping to Graphics image

4.10

GALEO-22161

E-Signature - Secured point is able to duplicate again
using the same point reference number in another folder
and user is allowed to write without authentication

4.10

GALEO-22108

E-Signature - If user deletes any folder/directory then
underneath secured point also gets deleted without
authentication

4.10

GALEO-21149

Global Setting Support in PLV

4.10

GALEO-20769

SBC v2.1 - "Complex Easy Template" - "no Points found"
message is displayed when selecting Point View Widget
option in right side view

4.10

GALEO-20371

PDM - Unable to delete the points in larger station

4.10

GALEO-17727

SBC: Not possible to have a relative text label , to show
the name of the current component

4.10

GALEO-17230

IQVISION Analytics - In the Analytics alert, Point label
does not display for trend points. It display only Trend
item reference.

4.10

GALEO-17042

E-Signature - Alarm records are able to delete if second-
ary level user does not have operator level permission as
rwi.

4.10

GALEO-17041

E-Signature - Protected alarm acknowledgement authori-
zation window shows java logo instead of brand logo

4.10

GALEO-17040

E-Signature - Level-1 /Level-2 user has secured point
read and write permission but while try to write secured
points, we are getting error and it is not meaning full for
end user.

4.10

GALEO-17039

E-Signature - For a secured points, Write operation can
be performed with value above facet range from web
client but controller will not accept those value due to that
“out” value is not changing in the secured point though
audit log record the same

4.10

GALEO-17035

E-Signature - Unable to delete history record from pro-
tected history database maintenance view.

4.10

GALEO-16742

PDM - Point Database Manager does not show the
correct license count for Trend network in TONN with
production license

4.10

GALEO-16548

E-Signature - Able to manipulate trend driver specific
properties of secured points without authentication (Ex.
Trend item reference & linked trend plots reference)

4.10

GALEO-16174

PLV - Unable to perform enum point R/W operation from
PLV without range facet information

4.10
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List of known issues with the version V3.0

Key

Description of the issue

Planned correction
Saia PCD® Supervisor

GALEO-15714 PDM - Two scroll bar is appearing while minimizing work- 410
bench

GALEO-15697 Easy Binding - Point label is overlapping in Tool Bar of 4.10
Easy Binding View

GALEO-15672 Easy Binding - Easy Palette Builder allows user to create 410
jar with wrong folder structure

GALEO-15667 Easy Binding - Revert option is not working properly in 4.10
Easy Binding view

GALEO-15579 PDM - Linked histories does not get deleted for User 4.10
defined points

GALEO-15170 IQVISION v2.30- Point value able to write beyond facet 4.10
min -max limit from PLV in -line edit and actions menu
operations

GALEO-15032 IQVISION - Workbench not responds properly after 4.10
sometime

GALEO-14923 SBC - Web Field editor binding is not supported by easy 410
templating

GALEO-14910 IQVISION - Observations from Niagara Analytics Test 4.10

GALEO-13501 SBC : PLV Filter list is not updating automatically based 410
on the filter

GALEO-13500 E-Signature - Level 2 remote requests are not displayed 410
properly in workbench

GALEO-13468 E-Signature - Audit history fails to log the records for 410
alarm ack in protected alarm console

GALEO-13450 E-Signature - - Point write is not working in web client PX 4.10
page

GALEO-13448 E-Signature - Authentication window is not identical in PX 4.10
page of workbench and web client

GALEO-13308 E-Signature - Enum range is not shown for override op- 410
eration which is configured in IQVISION

GALEO-13300 E-Signature - Status and values are not updating properly 4.10
in secured point history logs

GALEO-13295 E-Signature - IQVISION allow user to delete the secured 4.10
points without authentication from database while delet-
ing using delete key from keyboard

GALEO-13278 E-Signature - Unable to select multiple points from single/ 410
dual signature points

GALEO-13100 E-Signature - Options displayed during point write is dif- 410
fers when e-sign is configured and e-sign is not config-
ured

GALEO-13097 E-Signature - Points filtered from previous selection is still 4.10
maintained in Points Selection Dialog

GALEO-4230 Even with auto alarm refresh is disabled in web client, 4.10

while performing any action like adding notes, show
recurring all, show all alarms etc, the alarm console gets
refreshed
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A.9 Using the Extended Support Options

Saia PCD® Supervisor is now provisioned with multiple extended support options that
can be purchased:

Refer to the Saia-PCD-Supervisor Data Sheet (34-001) to know more about available
extended support options.

In order to use these options it is necessary to license Saia PCD® Supervisor with the
appropriate license.
See chapter 5 Licensing Saia PCD® Supervisor

For details of configuring and using these option refer to the Saia Burgess Controls
documentation.
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A.10 Contact

Saia-Burgess Controls AG
Bahnhofstrasse 18

3280 Murten

Switzerland

Phone.......ccceeeiiieeeee +41 265803000

Phone support.................o.... +41 265803100

FaX ..o +41 265803499

Email support: ..........ccocunnnen. support@saia-pcd.com
Supportsite: .......ccoceeeeeiiiiiinns WWWw.sbc-support.com
SBC site: ..oviiiiieeiieeeeeeeee WWW.Saia-pcd.com

International Represetatives &
SBC Sales Companies: ......... wWww.Ssaia-pcd.com/contact

Saia PCD® Supervisor and the Saia Burgess Controls driver features described in this
manual. They are unable to provide support for 3rd party drivers and undocumented
aspects of Saia PCD® Supervisor’s operation.

n Saia Burgess Controls Technical Support are only able to provide support for
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